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Getting Started with DME Designer
Thank you for purchasing the DME64N/24N. 
Your DME64N/24N mixing engine, together the DME Designer software, lets you build a custom audio 
system installation that can support an incredible variety of conditions. You can build an entire system 
from input to output with the DME Designer software, then send the data from that system to the 
DME64N/24N, which becomes an independent processor. 
An amazing variety of applications are possible, including audio installations, sub-mixing, speaker 
system control, matrix/routing, and multi-effect processing. 
In this manual the abbreviation “DME” refers to the DME64N/24N. 

SPECIAL NOTICES
• The software and this Owner’s Manual are the exclusive copyrights of Yamaha Corporation.

• Use of the software and this manual is governed by the license agreement which the purchaser fully 
agrees to upon breaking the seal of the software packaging. (Please read carefully the Software 
Licensing Agreement at the end of “DME Designer Installation Guide” before installing the 
application.)

• Copying of the software or reproduction of this manual in whole or in part by any means is expressly 
forbidden without the written consent of the manufacturer.

• Yamaha makes no representations or warranties with regard to the use of the software and 
documentation and cannot be held responsible for the results of the use of this manual and the 
software.

• This disc is a CD-ROM. Do not attempt to play the disc on an audio CD player. Doing so may result 
in irreparable damage to your audio CD player.

• The company names and product names in this Owner’s Manual are the trademarks or registered 
trademarks of their respective companies.

• The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may 
appear somewhat different from the screens which appear on your computer. 

• Future upgrades of application and system software and any changes in specifications and 
functions will be announced separately. 

• Windows® is the registered trademark of Microsoft® Corporation.

NOTE

Here the abbreviation “DME” does not include the “DME32.”

NOTE

This manual is based on the English version of the software. Illustrations, command names, window names, and similar 
information are from that version. Some items may differ from what you see on the computer screen, depending on which 
operating system you are using. 
DME Designer Owner’s Manual
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About DME Designer
DME Designer is software that provides an integrated environment where you can build and control 
systems that use DME.
Audio systems with DME are built on the computer screen in block diagram format using the DME 
Designer software. Information about the inputs/outputs along with the arrangement of components 
and their connections is called the “configuration.” 
The software sends DME settings, along with configuration and parameter data, to the DME unit 
through a USB or Ethernet connection. Once the data is transferred, the DME unit can be 
disconnected from the computer and used as an independent processor. The DME can also be kept 
connected to the computer and controlled in realtime from DME Designer software. 
If multiple DME units are connected to the computer, you can use the DME Designer software to build 
a configuration that includes those multiple units.

For a DME overview and glossary, see the “DME64N/24N Owner’s Manual.” 
Systems built with DME Designer can have multiple zones within an area and multiple configurations 
and scenes within a zone. However, only one area, zone, or configuration can be made active and 
edited at a time. When active these are called the “Current Zone,” “Current Scene,” and “Current 
Configuration.”

■ One DME unit/Zone

Area This means the entire site, and is therefore the uppermost level for a system built using 
DME Designer. At least one zone must be located within the area.

Zone Specifies a space that has individual sound effects within the area, and creates DME 
connection conditions. You can create and switch between multiple configurations.

Configuration Information related to the layout and connection of components in a zone.

Scene Information related to configuration assigned to a zone and the settings of the 
components included in the configuration.

Component An object that is arranged within the Configuration window.

No.

001

002

003

004

005

006

....

Confuguration

Output Processor for Dome

Output Processor for Dome

Output Processor for Dome

Output Processor for Dome

Output Processor for Dome

...

Scene Name

All On

Opening

Band Set 1

Band Set 2

Band Set 3

...

Preset

All On

BGM & MC

Band 1

Band 2

Band 3

Microphone
Mixer
External Head Amp
etc...

Power Amp
Processor
etc...

Input

External Device (MIDI, GPI, DAW, AMX/Crestron)

Audio signal

NotesZone
Output

Control signal

Data explanation

Setting preset data

LCD Display

Dome Low

Dome Mid

Dome Hi

....

Assigned Parameter

Crossover: Output Low: Level

Crossover: Output Mid: Level

Crossover: Output Hight: Level

(No Assign)

(No Assign)

(No Assign)

User Defined Button Scene Manager

Specifies the parameter to be changed.
Specifies the configuration 
and preset data combination.

Configuration

Output Processor for Dome

Local parameter link settings

External device settings

MY8-AE
(Input)

MY8-AE
(Output)

Cross-
Over

EQ

Delay EQ Dyn

Delay

All On   Component value

BGM & MC

Band 1

Band 2

Band 3

Preset data for output processor

Set the value
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■ Two DME units/Zone
When one DME unit doesn’t provide sufficient processing power, up to 16 DME units can be used

DME#2
Configuration

Output Processor 
for Hall

Local parameter link settings

External device settings

All On

BGM & MC

Band

Zone

LCD Display

Dome Low

Dome Mid

Dome Hi

Hall Low

Hall Mid

Hall Hi

....

Assigned Parameter

#1: Crossover: Output Low: Level

#1: Crossover: Output Mid: Level

#1: Crossover: Output Hight: Level

#2: Crossover: Output Low: Level

#2: Crossover: Output Mid: Level

#2: Crossover: Output Hight: Level

No.

001

002

003

004

005

006

....

Configuration

Output Processor for Dome

Output Processor for Dome

Output Processor for Dome

Output Processor for Dome

Output Processor for Dome

...

Scene Name

All On

Opening

Band Set 1

Band Set 2

Band Set 3

...

Preset

All On

BGM & MC

Band 1

Band 2

Band 3

Configuration

Output Processor for Hall

Output Processor for Hall

Output Processor for Hall

Output Processor for Hall

Output Processor for Hall

...

Preset

All On

BGM & MC

Band

Band

Band

User Defined Button
Scene Manager

DME#1
Configuration

Output Processor 
for Dome

Local parameter link settings

External device settings

All On

BGM & MC

Band 1

Band 2

Band 3

Preset data Preset data

External Device (MIDI, GPI, DAW, AMX/Crestron)

Microphone
Mixer
External Head Amp
etc...

Power Amp
Processor
etc...

Input Output

Input Output

DME#1

DME#2

For DME#2

For DME#1

Specifies the parameter to be linked between DME units.

Grobal Parameter Link

For DME#1 For DME#2

Audio signal

Notes

Control signal

Data explanation

Setting preset data

Selects the parameter to be 
edited from two DME units.

Specifies the configuration and preset 
data combination in each DME
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System Requirement

Common data for DME units in the same zone

Scene Manager A “scene” is information that is used to change the audio processing content.
A combination of a configuration and preset data is specified for each scene.
A  Scene Manager is function used to memorize and manage scenes. Up to 999 
scenes can be memorized, and each scene is managed by number.

MIDI Program Change 
settings

This setting is necessary to switch scenes using MIDI messages.

User Defined Button setting This information is necessary to control component parameters from the unit’s 
panel. Up to 24 parameters can be memorized.

Global parameter link settings This information is necessary to allow operation of similar parameters to be 
linked between multiple DME units.

Separate data for individual DME units

Configuration This information defines the configuration of audio processing, audio input/
output, and external device components and the connections between 
components required to achieve the desired audio processing.

Local parameter link 
settings

This information is necessary to allow linked operation between similar 
parameters within a single DME unit.

External device settings This information is necessary to allow control of component parameters from 
external devices.
Independent settings are required for each external device.
The following external devices can be used:
• MIDI controller( MIDI Control Change, Paramter Change)
• GPI controller
• DAW controller
• AMX, Crestron, and similar remote controllers.

Preset data These are the parameter values for the components included in a configuration.
Audio processing details can be changed by changing the preset data.
The following component types include preset data:
• GEQ, Matrix Mixer, and other audio processing components.
• Internal AD/DA (DME24N), Cascade (DME64N), and MY Card I/O 

components.
• External device components for external head amps (AD8HR, AD824).

Operating System Windows® XP Professional/XP Home Edition/2000 Professional

CPU 1 GHz or better Intel® Pentium®/Celeron® family processor

Memory At least 256 MB

Hard Disk Capacity At least 300 MB

Display 1,280 x 1,024 pixels or better/High Color 16 bit or better

Other Mouse, CD-ROM drive, 100Base-TX/10Base-T Ethernet or USB connection 
environment.
DME Designer Owner’s Manual 5
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Main Changes from V1.0 to V1.1
■ Main Panel Window

• Instead of the former Parameter Link function, there are now two functions: a Global Link function 
that links parameters within all DMEs in a zone and a Local Link function that links parameters 
within a single DME unit. (→ page 73)

• The Synchronization function can now not only send data from DME Designer to the DME unit, 
but can also synchronize by reading data from the DME unit. (→ page 75)

• Scene Increment/Decrement and Time Adjustment can now be assigned in the GPI input 
function. (→ page 80)

• DME unit events can now be recorded by the Event Logger function and displayed in the Event 
Logger window. (→ page 111)

• The time for executing an event can now be set by using the Event Scheduler function. 
(→ page 116)

• Parameters in the current configuration can now be listed on the display and printed out by using 
the Parameter List function. (→ page 124)

• The Wav File Manager can manage Wave files played by the Wav File Player. (→ page 128)

• Settings can be made by the DAW Control function that are used for controlling DMEs from a 
DAW controller. (→ page 132)

• DME unit data can now be saved as a backup file by using the Backup function. (→ page 135)

■ Designer Window
• The port name display can now be switched between long name display and short name display. 

(→ page 148)

• DME64N cascade connections can now be set. (→ page 165)

• Priority items can now be set when compiling configurations by using the [Compile Priority] 
function in the “Preferences” dialog box. (→ page 209)

• Delay time can now be displayed for each component by using the Show Signal Delay function. 
(→ page 246)

• Monitoring points can now be edited by using the “Monitoring Point List” dialog box. (→ page 247)

• The status of connections in a configuration can now be analyzed in advance by using the 
Analyze function, without connecting the DME unit. (→ page 249)

• You can now set the action that occurs when you double-click a user module object. You can also 
turn user module security ON or OFF, and set a password. (→ page 254)

• Libraries with component parameters saved in them can now be recalled from the context menu 
for a component object. (→ page 277)

• A new rule for wiring prohibits connections to terminals that would short the terminator. 

■ Component Editor/Component
• A status bar has been added to the component editor. It displays the component name, 

component ID, and parameter IDs for parameters that are being edited. (→ page 265)

• A Snap function has been added that records parameters in the editor temporarily. Parameter 
sets can then be switched by using the Snap buttons. (→ page 273)

• The meter's peak hold function can now be turned ON or OFF. (→ page 291)

• A Wav File Player component has been added for playing Wave files. (→ page 359)

• An effect component called SPX has been added that supports many different effect 
applications, such as reverb, delay, and modulation effects, along with complex combinations of 
multiple effects. (→ page 397)

• A Slot Out component editor has been added. (→ page 409)

• An Undo/Redo function is now available when using the design mode. It can undo the most 
recent operation (control movement/resize/deletion). 
DME Designer Owner’s Manual
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Changes from V1.1 to V1.2
■ Main Panel Window

• The synchronization algorithm has been refined for faster synchronization.

• Synchronization now can be executed from DME to DME Designer without any break in the 
sound.

• In the following cases, synchronization can be executed from DME Designer to DME without any 
break in the sound:
The second or later synchronization after starting DME Designer* and when differences in data 
between the DME and DME Designer are limited to parameters within components, AD824/
AD8HR/DME24N AD/DA setting data, or MY card setting parameters.
* If the file was saved when DME Designer was closed, there will be no break in sound even in the first 
synchronization after saving.

• Compile speed has been increased.
Up to three times faster when AutoDelayCompensation is turned On.
Up to two times faster when AutoDelayCompensation is turned Off.

• Synchronization is possible when no MY card or a different MY card is installed in the DME unit 
(a confirmation dialog will appear).

• An option to automatically close the dialog after synchronization has been added. (→ page 37)

• A progress bar has been added to the Synchronization dialog. (→ page 36)

• A message appears to warn when synchronization will cause muting.

• The following operations can be performed while on line:
- Scene storage.
- Scene name changes.
- Fade ON/OFF and Fade Mode changes.
- Fade time changes.
- Parameter link setting changes.

• When a scene store is executed, that scene becomes the current scene.

• Wave files can be saved as DME data files, and are included in import/export operations. 
(→ page 32)

• Wave files can be saved in the Wav file library.

• Event Log events can be output via GPI. (→ page 115)

• The on-line indicator appears as a button which can be used to switch between on-line and 
off-line. (→ page 43)

• Scene edits cause the EDIT indicator to appear. (→ page 42)

• An auto file save function (Auto Save, post synchronization) has been added. (→ page 53)

• Different zones can be specified for use by different users. (→ page 56)

• Scene parameters related to User Defined Button, Program Change, GPI In and GPI Out can be 
set via the Scene Manager. (→ page 63)

• [Select All] and [Clear All] buttons have been added to the Scene Manager Recall Safe dialog. 
(→ page 67)

• User Control can be created for individual users as well as security levels. (→ page 70)

• A Remote Control Setup List has been added. (→ page 123)
This list can be used to make detailed settings for a new software protocol that allow the DME to 
be controlled from AMX, Crestron, and similar devices.
Refer to the “DME-N Remote Control Protocol Specifications” document for details about the 
communication protocol. Information about the “DME-N Remote Control Protocol Specifications” 
document can be found at the Yamaha pro Audio website (URL below).
http://www.yamahaproaudio.com/

• It is possible to specify whether listed events will be executed by the Event Scheduler. 
(→ page 116)
DME Designer Owner’s Manual 7

http://www.yamahaproaudio.com/


Getting Started

8

• The order of same-time events can be changed in the Event Scheduler. (→ page 116)

• Exceptions can be specified for Event Scheduler execution day/time. (→ page 122)

• Event Scheduler execution times can be specified in 1-second increments. (→ page 121)

• Head amp gain and MY-Card can be set via GPI, MIDI, User defined Button, DAW Control.

• Parameter values, scene recall, GPI output, Wave file playback, and head amp gain can be set 
via the User Defined Buttons. (→ page 98)

• The Component Lock function dialog is separate from the Parameter List dialog. (→ page 127)

• Shortcuts can be freely set as required. (→ page 134)

• Files can be saved in the DME unit. (→ page 52)

• A [Close All Editor Windows] button has been added to the Window menu. (→ page 51)

• External head amp parameters will be recognized by the DME unit when either the DME or the 
external head amp (AD824, AD8HR) are turned on. Execute a scene recall to send DME settings 
an external head amp.

• This manual is now separate from the DME Designer installer, and can not be accessed from the 
DME Designer menus.

■ Designer Window
• The following operations can be carried out via the shortcut keys.

- Navigator
- Activate Navigator
- Activate Toolkit
- Activate Design Window
- Select Left Port and Start Wiring
- Select Right Port and Start Wiring
- Wire Auto Single to Right
- Wire Auto Multi to Right
- Wire Auto Single to Left
- Wire Auto Multi to Left
- Delete Wire

• It is now possible to simultaneously edit multiple objects of the same type.
Example: Change the thickness or color of multiple wires at once.

• Files related to user modules (user module files, library files, user module editor files) can be 
combined and exported/imported as a single file. 

• Port colors can be independently specified for each port type. (→ page 156)

• Default wire thicknesses and types can be independently specified for each port type.

• An automatic hot-spot connection function has been added. (→ page 225)

• Port display has been added to External Device, Picture, DME, and ICP1 objects.

• When drawing wires the keyboard cursor keys can be used to move the mouse cursor, and the 
<Enter> key can be used to create nodes.

• When drawing wires <Shift> key plus <→> key and <Shift> key plus <←> key combinations can 
be used to automatically connect horizontally-aligned hot spots.

• DME object ports can be freely specified.

• Compilation of configurations with loop connections is possible when Auto Delay Compensation 
is On.

• The name has been changed from “Foot Monitor” external device to “Floor Monitor.”

• Addition External Device types have been provided.

• External Devices can be double-clicked to open a file saved by other applications. (→ page 172)

• Picture objects can be double-clicked to open a specified editor. (→ page 187)

• Text objects can be double-clicked to open a specified editor. (→ page 190)
DME Designer Owner’s Manual



Getting Started
• User module port labels can be edited. (→ page 183)

• Graphics can be placed to represent user modules. (→ page 183)

• The Legend field automatically resizes to accommodate project names and titles of different 
lengths. 

• A Generic “MY-Others” setting has been provided to accommodate third-party MY cards.

■ Component Editor Window
• Undo and Redo are now shortcut compatible.

• A scroll bar appears when the size of the component editor window is reduced.

• The size and position of the component editor window are memorized.

• An option to allow mouse-over zooming of the edit box has been added. (→ page 266)

• A [Back] button that allows switching between related parent and child windows has been 
added. (→ page 265)

• A [Close All Editor Windows] button has been added to the contextual menu.

• Source Selector, Speaker Processor, Limiter, Slot In, Cascade In, and Cascade Out components 
have been added.

• The Delay algorithm has been revised.  (→ page 332)
- LEVEL and MUTE are effective when Delay is Off for each channel.
- The name of the overall Delay [On] parameter has been changed to [All Bypass].

• The bus send level range for Delay, Matrix, and Matrix Mixer components has been changed to 
-∞ through 0.0 dB.

• Snap copy is possible. (→ page 274)

• Snap can be retained until the application is quit or another file is opened.

• Security status is displayed in the user module editor status bar.

• Multiple controllers can be selected by clicking while holding the <Ctrl> key when the editor is in 
the design mode. (→ page 286)

• [Picture], [Text], [Box], [Ellipse], and [Frame] have been added to the tool palette of the user 
module editor and user control editor design mode. (→ page 279)

• Controller properties can be accessed by double-clicking controllers in the user module editor or 
user control editor design mode. (→ page 303)

• Picture and Text objects can be clicked to open a specified editor in the user module editor or 
user control editor.

• The User Module Editor and User Control Editor offer a greater range of customization options for 
color, size. etc., of the placed controls.

■ MIDI Setup
• A MIDI Setup minimize function has been added.

■ V1.2 Precautions
• When using project files (*.daf) created by version 1.1.5 or earlier, synchronize from the DME 

Designer to the DME unit for the first synchronization.

• Project files (*.daf) created using version 1.2 will not open properly on version 1.1.

IN

Input
Mute

Input
Level

Input
Mute

Input
LevelOn

Delay On Delay All Bypass

OUT OUT

Mute Level On Mute Level
INDelay Delay
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Chapter 1  Before Using

Installing DME Designer
To use DME Designer, you must first install the software on the computer. Before you can connect the 
DME Designer software to the DME unit, send and receive configurations, or perform control, you must 
first install the USB MIDI Driver or the DME-N Network Driver, according to how you will be connecting, 
and then make the appropriate settings. 
For instructions about how to install DME Designer and about the installation and setup method for the 
MIDI driver and DME-N Network Driver, see the “DME Designer Installation Guide.” 

Starting DME Designer
The DME Designer software is started from the [Start] menu. DME Designer is used with one user 
logged on. The user logs on when the software is started.

■ DME Designer Start Up and Logon (When Auto-Logon Is Not Set)

1 Click [Start] ➞  [All Programs] ➞  [YAMAHA OPT Tools] ➞  [DME Designer] ➞  [DME 
Designer].

The “Log On” dialog box will be displayed.

2 Click the [▼] at the right of the [User] box, and select the user. 
If no user has been created, only [Administrator] will appear in the list. When starting DME 
Designer for the first time after installing, select [Administrator]. 

NOTE

In Windows2000, click [Start] → [Programs] → [YAMAHA OPT Tools] → [DME Designer] → [DME Designer].

NOTE

Automatic log-on is the default setting. If the automatic logon feature is enabled, the “Log On” dialog box will not be 
displayed when the application is started. Instead, the auto-logon user will be logged on automatically. See page 21 
for information about auto-logon.
DME Designer Owner’s Manual 11
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3 Enter the password into the [Password] box.
Enter the password set for the user. 
If no password has been set, leave the password box blank when you log on. 

4 Click the [OK] button.
DME Designer starts up.

■ When Automatic Logon Has Been Set (page 21)
If automatic logon has been set, the “Log On” dialog box will not be displayed. The user set for 
automatic logon will be logged on. 
With automatic log on, even if a password is set for a user, it will not be requested during log on. 
This is useful when logging on a specific user. 

■ Starting by Opening a Project File
DME Designer starts when a project file with a saved configuration is opened. When the project file 
is opened, DME Designer is started with the window configuration that was in place when the file 
was last saved. 
DME Designer Owner’s Manual
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Closing DME Designer
To close DME Designer, click [Exit] on the [File] menu of the Main Panel window. It can also be closed 
by clicking the [Close] button on the Main Panel window. 

1 Click [Exit] on the Main Panel window [File] menu.
When you try to close DME Designer, “Project File has been modified. Save?” will be displayed in a 
dialog box. 

2 To save the file, click [Yes]. To close without saving, click [No]. 
If you click [Yes], the file currently saved with the same name will be overwritten. If the file has not 
been saved, the File Save dialog box will always be displayed.

NOTE

Sometimes the “Project File has been modified. Save?” dialog box will not be displayed.
DME Designer Owner’s Manual 13
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Chapter 2  DME Designer Overview

Names and Functions of the Windows
The DME Designer software has several windows, including the Main Panel window, Designer window, 
Component Editor window, Resource Meter window, and others. 

Main Panel Window
Menus and buttons are available in the Main Panel window. The current DME Designer environment, 
including the active scene and zone, the currently logged on user name, and the connection status to 
the DME unit are displayed on the right side of the Main Panel window.

Main Panel Window

Designer Window

Component Editor Window

Resource Meter Window
DME Designer Owner’s Manual
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Designer Window
The Designer window displays several different windows. First among them is the Area window, where 
you can manage the entire system. The Area window includes one or more Zone windows, which in 
turn include one or more DME units that are used to build a zones within the area. Next is the 
Configuration window, where you create the internal configuration of each DME unit. Within the 
Configuration window are the User Module windows, where you can assemble often-used 
components into presets; the Toolkit window, which displays objects used in the other windows as the 
basic building blocks for sound designs; and the Navigator window, which lets you grasp the overall 
status of the system at a glance.
 

■ Area Window
The Area window is used for designing areas, which manage the entire system. While at least one 
zone is included within an area, multiple zones can be arranged there.

Toolkit Window

Configuration Window

User Module Window

Navigator WindowZone Window

Zones
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■ Zone Window
The Zone window is used to design zones within the area. A zone is a more concrete blueprint that 
includes at least one DME. It shows the DME’s connections with other devices and the wiring 
between them. You can create multiple zones.
The DME units and connected devices are arranged in each Zone window, creating configurations. 

 

■ Configuration Window
The Configuration window is used to design the internal configuration of each DME unit contained 
in the Zone window. By arranging and connecting components (audio processors like mixers, 
compressors, effects, and crossovers, along with parts like faders and meters) in the Configuration 
window, you can create things like complex processors or matrix mixers, that determine the actual 
internal structure that operates each DME unit. 

■ User Module Window
The User Module window is used for designing user modules that can be arranged in the 
Configuration window. You can create original modules by combining multiple examples of often-
used components. When you save these modules as presets, you can recall them easily whenever 
you want. 

Configurations

Components
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■ Toolkit Window
The Toolkit window displays the objects that you can use in each window that can be displayed in 
the Designer window. Those windows are the Area, Zone, Configuration, and User Module 
windows. The Toolkit displays different objects, according to the currently active window. To place 
an object in a window, double-click it in the Toolkit window where it is displayed or drag it to the 
currently active window. 

■ Navigator Window
The Navigator window displays the area, zones, configurations, and components in a hierarchal 
fashion that lets you check their status as a whole. When editing offline, you can click an area 
name, zone name, or configuration name to make that window active. Clicking a component name 
will open the component editor window for that component. 

■ Objects and Components
“Object” is the name for the parts that are arranged in the various design windows, such as the 
Area, Zone, Configuration, and User Module windows. Objects are always laid out in the Toolkit 
window. Only the appropriate objects for each window are displayed. The blocks displayed at the 
higher level of the Toolkit window in particular are called “components.” This refers to each type of 
processor that operates the DME. “Object” normally refers to Picture, Text, Ellipse and other items 
that are used after connecting them by wire to the various components. 

Component Editor
The blocks that are arranged in the configuration window are called “components.” Audio processors 
like mixers, compressors, effects, and crossovers, along with parts like faders and meters, are used 
for this purpose in the Configuration window. 
When you double-click on a component block arranged in the Configuration window, the Component 
Editor window will open. There you can edit the parameters for that component. The types of 
parameters displayed will differ, depending on the component. 

Component Editor
(Stereo Compressor)

Component
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Resource Meter
This window provides an indication of the usage of the components in the configuration window. The 
usage percentage increases as the number of components increases, and is shown in graph form in 
this window.
This window is shown at the same time as the designer window, and provides a guide when creating 
configurations.
The usage percentage also depends on the sampling frequency at which the DME unit is set to 
operate. Make sure that the usage percentage is kept below 100%.

Window Operations
Operations in all windows are the same as for normal Windows applications. The windows are 
controlled with the [Minimize], [Maximize/Restore], and [Close] buttons at the upper right of the title 
bar. DME Designer is closed by clicking the [Close] button on the Main Panel window. 
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Users and Security
You can create multiple users in DME Designer and set the functions that are available to each user. 
Although users who will design and put together installations must be able to use all the functions of 
DME Designer, users who will only operate the system can be restricted to functions that will not allow 
them to accidentally change the settings. 
DME Designer is used with one user at a time logged on. To change the user, click the [File] menu → 
[Log Off] command on the Main Panel window.

About Users
To use DME Designer, you must logon when you start the software. Except for the first time the 
software is started or when separate settings are made for the first time, you can logon by specifying 
the name and password for a user that has been set as the administrator. The administrator can build 
the system as a whole, or apply function limitations that let other people edit. Administrators or other 
people that can use DME Designer are called “users.” The user name for the currently logged on user 
appears below [User] on the Main Panel window.

The default user, named [Administrator], is set to use all of the functions. Immediately after DME 
Designer is installed, [Administrator] is the only user, and there is no password set. 
Multiple users can be created. When the system administrator creates multiple users, restrictions can 
be applied separately for each one of them. A user with restrictions applied can edit using only the 
functions the administrator enables for him. 
The place to create, setup, and delete users is the “Security” dialog box. See “Security (Creating 
Users and Making User Settings)” on page 55.

Currently Logged On User Name
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Logging On
The “Log On” dialog box is displayed whenever the application is started or a user is logged off. 
Whenever one user is already logged on, another user cannot be logged on. To log on as another 
user, first log off the currently logged on user. 

■ The “Log On” dialog box

1 [User]
From the list, select the user you want to log on as. 

2 [Password] Box
Enter the password. 

3 [OK] Button
Log on as the selected user.

4 [Exit] Button
When the application is started, and the “Log On” dialog box is displayed, there is an [Exit] 
button. This closes the application without logging on a user.

5 [Cancel] Button
When the “Log On” dialog box is displayed after a user is logged off, there is a [Cancel] button 
instead of an [Exit] button. This cancels the logoff. The original user will continue to be logged 
on. 

■ Logon Procedure

1 Click [▼] at the right of the [User].
A drop-down list of user names will be displayed. 

2 Click the user you want to log on. 

3 Enter the password into the [Password] box. 
When you type in the password box, the characters you enter will display as asterisks (*).

4 Click the [OK] button. 

NOTE

If the automatic logon feature is enabled, the “Log On” dialog box will not be displayed when the application is started. 
Instead, the auto-logon user will be logged on automatically.

1

2

3 5
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Logging Off
Logoff is used when changing users. When you log off, the document currently being edited is closed, 
and the “Log On” dialog box is displayed so you can log on the next user. Log off with the [Log Off] 
command on the [File] menu in the Main Panel window. 

1 Click the [File] menu ➞  [Log Off] command on the Main Panel window.

Log on the next user in the “Log On” dialog box.

Automatic Logging On
With the auto-logon function, you can have a specified user automatically logged on when the 
application is started. If you enable the auto-logon feature, the specified user will be logged on when 
the application is started, without displaying the “Log On” dialog box. 
Auto-logon is set from the “Security” dialog box. See “Security (Creating Users and Making User 
Settings)” on page 55.
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Project Files
Project Files
Systems built with DME Designer are saved as project files. Project files have “.daf” as the extension 
for their filenames. 
These files include settings for the area, zones, configurations, and each parameter. 

Since only one project file can be open at a time, before you can open a second file, the first one must 
be closed. 
The commands for opening project files, creating new ones, and saving them, are found in the [File] 
menu of the Main Panel window.

Creating New Project Files
Project files are created using the [File] menu → [New] command in the Main Panel window.

1 Click [File] menu ➞  [New] in the Main Panel window.
Since the currently open project file must be closed before a new one can be created, a “Project 
file has been modified. Save?” dialog box will be displayed. 

2 To save the file, click [Yes]. To close without saving, click [No].
If you click [Yes], the file currently saved with the same name will be overwritten. If the file has not 
been saved, the File Save dialog box will be displayed.

A new project file will be created.
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Saving Project Files
Project files are saved using the [File] menu → [Save] and [Save As] commands in the Main Panel 
window. The [Save] command overwrites the previously saved version of the file. The [Save As] 
command lets you give a new name to the file before saving it. When you save the file with a new 
name, you can protect it with a password.

■ The “Save As” Dialog Box
When you click the [File] menu → [Save As] command in the Main Panel window, the “Save As” 
dialog box is displayed. Except for some [Security] options, this dialog box is the same as the 
normal Windows dialog box for saving files. 

1 [Save In]
Specify the folder for saving the file. The folder name is displayed in this box. Click the [▼] on 
the right to move to another folder.
The large box below displays the contents of the folder in this box.

2 [Up One Level] Button
Moves to the folder one level higher in the hierarchy. 

3 [Create New Folder] Button
Creates a new folder in the folder currently being displayed. 

4 [Views] Button
Changes the way the folder content list is displayed. If you click this button, a menu appears 
that lets you change the arrangement and display format of the files in the list. 

5 List
This box displays the contents of the folder shown in the [Save In] box. Only files belonging to 
the type selected in the [Save As Type] box will be displayed. 

6 [File Name] Box
Enter the filename. If the currently open file has already been saved, its name will be already 
entered in this box. To save using a different filename, change the name here.

2

3

4

1

@

#

5

6

7

8
9
)

!

[Up One Level] Button

[Create New Folder] Button

[Views] Button
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7 [Save as type]
Selects the format for the file you are saving. When saving project files including Wave files set 
for Wav File Player, select “Project File with wave (*.daf)”. Otherwise, select “Project File (*.daf)”. 

8 [Security]
Protects files with a password. If you check here, you will be able to enter settings in the [ID], 
[Password], and [Confirm Password] boxes.

9 [ID] Box
Enter the ID that has been set for the file. The currently logged on user name will be pre-
entered, but you can change it. This need not be the same as a user name.

) [Password] Box
Enter the password that has been set for the file. You can enter up to 256 alphanumeric 
characters. The characters you enter will be displayed as asterisks (*) in the [Password] box.

! [Confirm Password] Box
Enter the password once again to confirm it. Enter the same password as was entered into the 
[Password] box. The characters you enter will be displayed as asterisks (*), the same as in the 
[Password] box. 

@ [Save] Button
Saves the project file. 
If the characters entered into the [Password] and [Confirm Password] boxes were not the same, 
a “Password is different” dialog box will be displayed. Click the [OK] button and reenter the 
correct password in the [Password] and [Confirm Password] boxes.

# [Cancel] Button
Cancel the file save process.

NOTE

When someone attempts to open a password-protected project file, the application will request an ID and password. 
If they are not entered correctly, the file cannot be opened. Be careful to avoid mistakes when entering the ID and 
password. The password cannot be reissued and the ID and password cannot be changed. Be careful not to forget 
them. 
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■ Saving Project Files 

1 Click [File] menu ➞  [Save] in the Main Panel window.

If there is a file already saved with the same name, it will be overwritten.
When saving a project file for the first time, you must name the file before saving it. The “Save 
As” dialog box will open, the same as when clicking the [File] menu [Save As] command. Enter 
a filename and specify the folder where the file will be saved. 

■ Saving a File with a New Name
With the [File] menu [Save As] command in the Main Panel window, you can save the currently 
open file with a new filename. When saving for the first time, this creates a new file. A file that has 
already been saved with a name will be saved as a separate file.

1 Click [File] menu ➞  [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

2 Enter a filename into the [File name] box.

3 Specify the folder where the file will be saved.

4 Click the [Save] button.
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■ Protecting a Project File with a Password
When you save a project file with a new name, you can set a password and protect the file. If a 
password is set, an ID and password will be requested when the file is opened. 
The security settings for a file cannot be changed by resaving the file with the same name. They 
can only be changed when saving the file with a new name using the [Save As] command. Once 
set, the ID and password cannot be changed. To change the ID and password for password-
protected project files, use the [Save As] command to save the file as a new one with a different 
name.

1 Click [File] menu ➞  [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

2 Place a checkmark for [Security] in the file save dialog box.

3 Enter an ID into the [ID] box.
The name of the currently logged on user will be automatically entered into the [ID] box. To 
change it, enter another ID into the box. 
When using [Save As] to save a password-protected file, the dialog box will be displayed with 
the ID and password boxes automatically filled in with the ID and password that were assigned 
to the original file. To change the ID and password, enter new ones into the boxes. 

4 Enter the desired password into the [Password] box.
You can enter up to 256 alphanumeric characters for the password. The characters you enter 
will be displayed as asterisks (*) in the [Password] box. 

5 Enter the same characters into the [Confirm Password] box as were entered into the 
[Password] box.
The characters you enter will be displayed as asterisks (*) in the [Password] box.

6 Click the [Save] button.

When saving a password-protected file without changing the name, the same ID and password 
will be set (the ID and password cannot be changed).
Using the [Save] command, you cannot password protect an already saved project file that was 
not already password protected. To set a password for a file that is not already password 
protected, save it as a separate file using the [Save As] command.
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Opening Project Files
Project files are opened using the [File] menu → [Open] command in the Main Panel window. Since 
the currently opened project file must be closed before another one can be opened, a “Project file has 
been modified. Save?” dialog box may be displayed. 

■ [Open] Command
Project files are opened using the [File] menu → [Open] command in the Main Panel window.

1 Click [File] menu ➞  [Open] in the Main Panel window.
A “Project file has been modified. Save?” dialog box may be displayed.

2 Click the [Yes] or [No] button.
The “Open” dialog box will be displayed.

3 Selects the file to be opened.

4 Click the [Open] button.
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■ Opening a Project File That Has Security Set
If security is set for a project, the “Enter ID & Password” dialog box will be displayed when you 
click the [Open] button in the “Open” dialog box.

Enter the ID and password for the file into the [ID] and [Password] boxes, and click the [OK] 
button.
If you enter an incorrect ID or password and click the [OK] button on the “Enter ID & Password” 
dialog box, the “Wrong ID or password!” dialog box will be displayed.

Click the [OK] button and enter the correct ID and password the “Enter ID & Password” dialog 
box.

■ Opening a Project File from the “Recently Used Files” List
Recently used project files are displayed on the [File] menu in the Main Panel window. If you click 
one of the filenames, you can open that project file.

If security is set for a project file, the “Enter ID & Password” dialog box will be displayed if that file is 
selected from the recently used files list. Enter the ID and password to open the file.

Recently Used Files
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■ Double-Click the Icon for the Project File
When you double-click the icon for the project file, the file will open. If DME Designer is not started, 
it will start. After logon, the project file will open. 
Just as when you use the [Open] command, if DME Designer is already started, the currently open 
project file must be closed before another one can be opened. Therefore, a “Project file has been 
modified. Save?” dialog box will be displayed. 

If security is set for the project file, the “Enter ID & Password” dialog box will be displayed. Enter 
the ID and password to open the file. 

Closing Project Files
You cannot have multiple project files open simultaneously in DME Designer. To close the currently 
open project file, you can create a new project file or open another project file.

NOTE

Sometimes the “Project file has been modified. Save?” dialog box will not be displayed.
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DME Data File
You can import or export parameters for a DME that is arranged in a configuration file. Parameters for 
a single DME unit in the current configuration (the one being edited) are saved as a file. Saved 
parameters can be imported into another project file. 
Files with parameters saved in them are called “DME Data Files.” These files have “.ddf” as the 
extension for their filenames. 

DME Data Import
This imports DME data file settings into a DME included in the current configuration. 

1 Make active the configuration that arranged the DME into which you are going to import. 
If there are multiple configurations, display the window in front for the configuration that arranged 
the DME to which you are going to import. 

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Import 
DME Configuration].
A submenu will be displayed. The DMEs included in the current configuration will be displayed on 
a submenu. 
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3 On the submenu, click on the DME into which you will import settings. 
The “Open” dialog box will be displayed.

4 Select the DME data file and click the [Open] button. 

■ [Import DME Configuration] Submenu
The DMEs included in the current configuration will be displayed on the [Import DME 
Configuration] submenu.

[Create New DME] creates a new DME and imports settings.

NOTE

Only users for whom the [Operation Security] → [Edit] checkbox in the “Security” dialog box has been checked can 
import DME data. For information about user security levels, see “Security (Creating Users and Making User Settings)” 
on page 55.

NOTE

If DME data file import was not possible, a “DME file import failed.” message will be displayed.
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DME Export
This exports parameters from a DME included in the current configuration and saves them as a file. 

1 Make active the configuration that includes the DME from which you will export. 
If there are multiple configurations, display the window in front for the configuration that arranged 
the DME from which you are going to export. 

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Export 
DME Configuration].
A submenu will be displayed.

3 On the submenu, click on the DME from which you will export settings. 
The “Save As” dialog box will be displayed.

4 Enter the filename.
Determines whether a selected file type will be exported along with a wave file.

5 Specify the folder where the file will be saved, then click the [Save] button.
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■ [Export DME Configuration] Submenu
The DMEs included in the current configuration will be displayed on the [Export DME 
Configuration] submenu. 
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Configuration Creation Procedure
The configuration is a design diagram that determines the DME configuration. Transferring this data 
causes the DME to operate. Follow the procedure below to create a DME Designer configuration. 

1 Creating a New Project. 
When you start DME Designer, a new project is created. If another project file is already open, use 
the [File] menu → [New] command in the Main Panel window to create a new file. 
“Main Panel Window Menu” → [File] menu → [New] (page 44)

2 Zone Settings.
Zone names are set, and zones are added and deleted using the “Zone” dialog box. 
See “Adding, Deleting, and Renaming a Zone” on page 231.

3 Configuration Settings.
Zone names are set, and zones are added and deleted using the “Zone” dialog box. 
See “Adding, Deleting, and Renaming a Configuration” on page 233.

4 DME, ICP, External Device Layout.
Arrange DMEs, ICPs, and external devices in the Zone window.
See “Zone Window” on page 237,
“Objects” on page 156,
“Design Window Shared Settings and Operations” on page 207.

5 Placing Components.
Place components and user modules in the Configuration window. 
See “Configuration Window” on page 242,
“User Module” on page 250,
“Types of Components” on page 259.

6 Component Logical Connections.
Use wires to connect the components and user modules you placed in the Configuration window. 
See “Drawing and Editing Wires” on page 219.

7 Setting Parameters.
Edit the component parameters in the component editor.
See “Component Editor Window” on page 264.

8 Setting User Defined Parameters. 
Parameters can be assigned to function keys F1 through F6 in the DME unit. 
See “User Defined Button (User Defined Parameters)” on page 98.

9 Storing Scenes.
Store the scene using the [Tools] menu → [Scene Manager] command in the Main Panel window. 
See “Scene Manager” on page 63.

NOTE

Configurations can be created only when the DME unit is offline. To transfer the data, you must first go into online status. The 
procedure for going online is given later in this document. 
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Online
You can connect the DME unit to your computer and transfer configurations, scenes and parameters 
created in DME Designer into the DME unit. You can also read data from the DME unit into DME 
Designer, synchronizing it with the status of the DME unit. 
Because Synchronization presupposes that the DME unit can communicate with the computer where 
DME Designer is installed, the necessary drivers (USB-MIDI or DME-N Network Driver) must be 
installed, and appropriate settings must be made for each driver and for DME Designer MIDI port. 

1 DME Unit and Computer Connection.
Connect the DME unit and computer using a USB cable or an Ethernet cable. 
See separate “DME64N/24N Owner’s Manual” for details.

2 MIDI Driver Installation.
Install the USB-MIDI driver or DME-N Network driver in the computer. 
See separate “DME Designer Installation Guide” for details.

3 MIDI Driver Setup.
Make the necessary settings for the MIDI driver installed in the computer. If the driver is set up 
already, check the settings before going online. 
See separate “DME Designer Installation Guide” for details.

4 MIDI Driver Port Setup.
The MIDI Setup dialog will be displayed if you press the MIDI Setup button on the MIDI Setup 
toolbar that is displayed when you start DME Designer Set up the In/Out/Thru ports connected to 
the DME. 

5 Making MIDI IN/OUT Settings in DME Designer.
On the [Port] tab of the “MIDI” dialog box, select the MIDI driver used for sending and receiving 
MIDI messages. If the driver is set up already, check the settings before going online. 
“MIDI” → [Port] tab (page 97)

NOTE

Because there are no scene settings when the DME unit is purchased, the configuration and scene information created in 
DME Designer must first be transferred. 
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6 Storing and Checking Scenes.
When moving online, the lowest scene must be stored. You can check if a scene is stored using the 
“Scene Manager” dialog box. 
See “Scene Manager” on page 63.

7 Recalling Scenes.
When going online, the scene will be recalled. Its scene number must be displayed in [Scene 
Number], and its scene name will be displayed in Scene Name. If [--------] is displayed of [Scene 
Name], the scene will be recalled. 
Main Panel Window → “Current Scene” (page 42)
See “Scene Manager” on page 63.

8 Display the “Synchronization” dialog box.
Click [Synchronization] in the [Tools] menu or the large [Synchronization] button on the toolbar. 
When the dialog box opens, a list of connected DME units will be obtained.   
DMEs connected to the computer are displayed in the [Network] list. 

NOTE

When requesting the “Synchronization” dialog box, a one-time alert will be displayed if no scene has been recalled, or 
the MIDI Port settings have not been made. After clicking the [OK] button on the alert, each dialog will open. At this time, 
you can make the needed settings in the displayed dialog box, and then again display the “Synchronization” dialog box. 
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9 IP Address Selection
The DMEs included in the current zone are displayed in the [Designer] list in the 
“Synchronization” dialog box. Click the [IP Address] box, then select the DME unit IP address 
that matches the DME currently in the DME Designer. 

10 Going Online.
Clicking the [Go On-Line] button displays a dialog box where you can decide the synchronization 
method. 

Click the [Designer→DME] direction button. 
Transfer of the configuration will begin, and DME Designer will be synchronized with the unit. 
If there are many zones, this process may take time. 

NOTE

IP addresses are displayed for devices of the same type in the area.
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When going online is finished, the [Go On-line] button will be grayed out, and the Main Panel 
window [On-Line] button will light up. The dialog box will close automatically if [Close this window 
after synchronization] is checked.

To go off line, click either the [ON-Line] button in the main panel window, or the [Go Off-line] 
button in the “Synchronization” dialog box.

NOTE

It may not be possible to go online if a scene has not been stored when [Recall Safe] is selected.
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Main Panel Window
The Main Panel window is the main window of DME Designer. 

Title Bar
“DME Designer” is displayed on the title bar.

Menu Bar
Commands that can be executed in the application are collected into categories on the menu bar. 
When you click one of the categories, a list of commands is displayed. 
Also, the name of the currently open project file is displayed at the right. When a new project file has 
been opened, or has not yet been saved, “Untitled” will be displayed for the file name.

Tool Buttons (Small)
Frequently used commands are arranged here as buttons. When a command cannot be used, its 
button will be grayed out. 
 

Log On User

Title Bar

Menu Bar

Tool Buttons (Small)

Tool Buttons (Large)

[Mute] Button Current Scene Current Zone Communication 
Status

[Open File] Button

[Save File] Button
[Undo] Button

[Undo History] Button
[Redo] Button

[User Defined] Button
[Word Clock] Button

[GPI] Button

[MIDI] Button
[Parameter Link] Button

[Clock] Button

[User Control Manager] Button
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■ [Open File] Button
Opens project files. 
→ [Open] on the [File] menu (page 45)

■ [Save File] Button
Saves the project file currently being edited. 
→ [Save] on the [File] menu (page 45) 

■ [Undo] Button
Undoes the most recent edit operation.
→ [Undo] on the [Edit] menu (page 47)

■ [Undo History] Button
Opens the “Undo History” dialog box. Undoes multiple operations. 
→ [Undo History] on the [Edit] menu (page 47)

■ [Redo] Button
Restores operations undone with the [Undo] button back to their original condition.
→ [Redo] on the [Edit] menu (page 47)

■ [User Defined] Button
Opens the “User Defined Button” dialog box.
→  See “[User Defined Button]” on page 49.

■ [Word Clock] Button
Opens the “Word Clock” dialog box.
→ See “[Word Clock]” on page 49.

■ [GPI] Button
Opens the “GPI” dialog box.
→ See “[GPI]” on page 49.

■ [MIDI] Button
Opens the “MIDI” dialog box.
→ See “[MIDI]” on page 49.

■ [Parameter Link] Button
Opens the “Parameter Link” dialog box.
→ See “[Parameter Link]” on page 49.

■ [Clock] Button
Opens the “Clock” dialog box.
→ See “[Clock]” on page 50.

■ [User Control Manager] Button
Opens the “User Control Manager” dialog box.
→ See “[User Control]” on page 48.
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Tool Button (Large)

■ [Show/Hide Designer] Button
Displays or hides the Designer window.

■ [User Control] Button
Works the same as the [User Control] command on the [View] menu. Clicking this button displays a 
menu. 

User Control will be displayed on the menu. If you click there, the user control window will be 
displayed. 
If you click [New User Control], the “New User Control” dialog box opens.

■ [Synchronization] Button
Opens the “Synchronization” dialog box.
→ See “Synchronization” Dialog Box on page 76.

■ [Event Logger] Button
Opens the Event Logger window. 
→ See “Event Logger” Window on page 111. 

■ [Event Scheduler] Button
Opens the “Event Scheduler” dialog box. 
→ See “Event Scheduler” Dialog Box on page 116. 

[Show/Hide Designer] Button

[User Control] Button

[Synchronization] Button

[Event Logger] Button

[Event Scheduler] Button
DME Designer Owner’s Manual 41



Chapter 3  Main Panel Window

42
[Mute] Button

Turns ON and OFF the DME mute button for the current zone.
To turn it ON, press the <Shift> key while clicking. If you click the button while it is OFF without 
pressing the <Shift> key, the following message will be displayed: “Click the Mute Button with the Shift 
Key.”
To turn it OFF, click on the button. There is no need to press the <Shift> key. 

Current Scene
Displays the number and name of the current scene. You can switch between scenes.

■ [Scene Number]
Displays the number of the current scene. A list where you can select a scene is displayed when 
you press the [▼]. The EDIT indicator will light when a parameter has been edited after recalling or 
storing a scene. 

■ [Scene Name]
Displays the name of the current scene.

■ [Scene Manager] Button
Opens the “Scene Manager” dialog box.

NOTE

Press <Ctrl> key and <+> key simultaneously recall the next scene and press <Ctrl> key and <-> key simultaneously 
recall the previous scene. These settings can be changed via the Shortcut keys dialog box (page 134).

Mute OFF Mute ON

[Scene Number] [Scene Name] [Scene Manager] Button
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[User] (Logged On User)

■ Currently Logged On User Name
Displays the currently logged on user name.

■ [Security] Button
Opens the “Security” dialog box.

Current Zone

Displays the name of the active zone. A list where you can select a zone is displayed when you press 
the [▼]. 

Communication Status
Displays the communication status between the DME unit and the computer. 

■ [On-line] Button
When the DME unit is connected to a computer, clicking this button alternately switches the unit's 
on-line/off-line status. The indicator will light when the DME unit is on-line.

■ Message Transmit/Receive Indicators

[Rx]
Lights when MIDI messages from the DME unit are received by DME Designer.

[Tx]
Lights when MIDI messages are transmitted from DME Designer to the DME unit.

Currently Logged On
User Name

[Security] Button

ON-line Button

Message Transmit/Receive Indicator
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Main Panel Window Menu

[File] Menu

■ [New]
Creates a new project. When a new project is created, the current project will be closed. 
A confirmation message asking “Project file has been modified. Save?” will be displayed. 

[Yes] Button
Saves the currently open project. 
If the currently open file was already given a name and saved, that saved file will be overwritten. 
The “Save As” dialog box will be displayed for files that have not yet been saved. In this dialog box, 
you can name the file when you save it.

[No] Button
Closes the project without saving it. If the file has already been given a name and saved, the most 
recently saved version will remain as is. If the project has not been given a name and saved, it will 
be lost.

[Cancel] Button
Cancels creation of a new project.
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■ [Open] 
Opens saved project files. Because the currently open project will be closed, a confirmation dialog 
box asking “Project file has been modified. Save?” will be displayed. 

When you select this command, the “Open” dialog box will be displayed. Select the project file you 
want to open and click the [Open] button.

If security is enabled for the project file, the “Enter ID & Password” dialog box will be displayed. 
Enter the ID and password to open the file and click the [OK] button. The project file will open. 

■ [Save] 
Overwrites an already saved project file with the current changes. If the file is being saved for the 
first time, the “Save As” dialog box will be displayed.
→ See “Project Files” on page 22.

■ [Save as] 
Saves the current project file as another file with a new name or in a new location. When you select 
this command, the “Save as” dialog box will be displayed.
→ See “Project Files” on page 22.

■ [Import DME Configuration]
Imports parameters for a DME that is arranged in a configuration file. 
→ See “DME Data File” on page 30.

■ [Export DME Configuration]
Exports parameters of a DME that is arranged in a configuration file. 
→ See “DME Data File” on page 30.

■ DME File Storage
Opens the “DME File Storage” dialog box.
→ See “DME File Storage” on page 52.
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■ Recently Used Files
Displays recently saved files. If you click one of the file names, you can open that file. 

■ [Preference]
Opens the “Preference” dialog box.
→ See “Preferences” on page 53.

■ [Log Off]
Logs off the currently logged on user. Because the currently logged on user must be logged off 
before a new one can be logged on, the “Log On” dialog box will be displayed so you can log on 
the next user. 
→ See “Users and Security” on page 19.

■ [Exit]
Closes “DME Designer.” A confirmation dialog box asking “Project file has been modified. Save?” 
will be displayed. To save, click [Yes]. To close without saving, click [No.] 
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[Edit] Menu

■ [Undo]
Undoes a single operation. The name of the operation that will be undone by [Undo] is displayed in 
the command name. You can also select the commands that come after that. 
When [Undo] is not possible, the command will be grayed out.

■ [Redo]
Returns to the status before the [Undo] command was executed. The name of the operation that 
will be restored by [Redo] is displayed. You can [Redo] only as many operations as were undone 
with the [Undo] command. When [Redo] is not possible, the command will be grayed out.

■ [Undo History]
Opens the “Undo History” dialog box. Undoes multiple operations. Also deletes the history of 
operations.

1 List
Displays all operations performed so far, in order starting with the oldest. You can select an 
operation by clicking on it.

2 [OK] Button
Undoes all operations below the one selected on the list. The operation selected on the list does 
not get undone.

3 [Close] Button
Closes the dialog box.

4 [Delete All] Button
Deletes the entire history of operations displayed on the list. When an operation is deleted from 
the list, it cannot be undone.

Operations undone from the [Undo History] can be re-executed one-by-one using [Redo].

1 2

3

4
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[View] Menu

■ [Designer]
Displays or hides the Designer window.

■ [Event Logger]
Displays the network event log. 
Not displayed if selected while the network event log is showing. 
→ See “Event Logger” on page 111.

■ [User Control]
This opens User Control.
The user controls that can be opened by the currently logged on user are displayed on a submenu.
If you click [New User Control] on the submenu, the “New User Control” dialog box opens.
→ See “User Control/User Module Editor” on page 279.

[Tools] Menu

■ [Scene Manager]
Opens the “Scene Manager” dialog box.
→ See “Scene Manager” on page 63.

NOTE

Controls that are not available to the currently logged-on user are not shown in the menu.
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■ [User Control Manager]
Opens the “User Control Manager” dialog box.
→ See “User Control” on page 70, page 279

■ [Parameter Link]
Opens the “Parameter Link” dialog box.
→ See “Parameter Link” on page 73.

■ [Synchronization]
Opens the “Synchronization” dialog box.
→ See “Synchronization (DME Designer and DME Unit Synchronization)” on page 75.

■ [Event Scheduler]
Opens the “Event Scheduler” dialog box. 
→ See “Event Scheduler” on page 116. 

■ [Wav File Manager]
Opens the “Wav File Manager” dialog box. 
→ See “Wav File Manager” on page 128. 

■ [GPI]
Opens the “GPI” dialog box.
→ See “GPI” on page 79.

■ [MIDI]
Opens the “MIDI” dialog box.
→ See “MIDI” on page 90.

■ [User Defined Button]
Opens the “User Defined Button” dialog box.
→ See “User Defined Button (User Defined Parameters)” on page 98.

■ [DAW Control]
Opens the “DAW Control” dialog box. 
→ See “DAW Control” on page 132. 

■ [Remote Control Setup List]
Opens the “Remote Control Setup List” Dialog box.
→ See “Remote Control Setup List” on page 123.

■ [Word Clock]
Opens the “Word Clock” dialog box.
→ See “Word Clock” on page 102.

■ [Monitor]
Opens the “Monitor Out” dialog box.
→ See “Monitor” on page 104.
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■ [Clock]
Opens the “Clock” dialog box.
→ See “Clock” on page 105.

■ [Language]
Opens the “Language” dialog box.
→ See “Language Settings” on page 106.

■ [Parameter List]
Opens the “Parameter List” dialog box. 
→ See “Parameter List” on page 124. 

■ [Component Lock]
Opens the “Component Lock” dialog box.
→ See “Component Lock” on page 127.

■ [Security]
Opens the “Security” dialog box.
→ See “Security (Creating Users and Making User Settings)” on page 55.

■ [Shortcut Keys]
Opens the “Shortcut Keys” dialog box.
→ See “Shortcut Keys” on page 134.

■ [Backup]
Opens the “Backup” dialog box. 
→ See “Backup” on page 135. 

■ [Firmware Update]
Updates the DME unit firmware. 
→ See “DME Firmware Update” on page 107.
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[Window] Menu

Displays the open windows. Click a window name to bring that window to the front. 

■ [Close All Editor Windows]
Closes all editor windows.

[About] Menu

■ [About DME Designer]
Displays information about this application.

NOTE

Each design windows within the Designer window can be switched using the [Window] menu in the Designer window. 
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DME File Storage
Allows management of DME files. Project files can be managed on the DME, eliminating the need to 
manage them on the computer.
Click [DME File Storage] in the [File] menu to display the “DME File Storage” dialog.

■ Zone List
Select the desired zone and DME from the list.

■ File List
A list of the files stored on the selected DME.

[Send] Button
Transfers selected files from the computer to the DME.

[Receive] Button
Transfers selected files from the DME to the computer.

[Delete] Button
Deletes selected files from the DME.

NOTE

Synchronization may become impossible if the [Remaining Memory] value (the amount of remaining DME memory) 
becomes too small. If this occurs, delete unwanted files to increase the amount of available memory.
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Preferences
When you click the [Preference] command on the [File] menu in the Main Panel window, the 
“Preferences” dialog box is displayed. Here you can make environmental settings for using DME 
Designer. 

■ [Application] Tab
Here you can set the general usage environment. 

On Startup
Selects the action when the application starts up.

• [Load the last file opened]
Opens the last opened file. If the file cannot be found because it was moved, deleted, or its 
name was changed, a new project will be opened.

• [Create an empty file]
Opens a new project. 

• [Load File & Synchronization]
Opens the last opened file and synchronizes with the DME unit. 

Contents Folder
Specifies the folder where the images used by the Design windows and user controls are stored. 
Click the [Browse] button and specify the folder.

Auto Save
Set up the automatic file save feature.

• [Enable]
Auto save of project files being worked on will occur when checked. The file will be 
overwritten, but the Undo history will not be cleared. This setting has no effect when the file 
being worked on has not previously been saved, or the computer is online.

• [Interval in minutes]
Specifies the auto-save interval in minutes.
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[Confirm Scene Store]
Place a checkmark here to have a confirmation dialog box displayed when storing a scene. 

[Save after synchronization]
If a save is performed after the DME Designer is synchronized to the DME unit, the next 
synchronization will be significantly faster because one the difference needs to be synchronized. 
Check this checkbox to specify auto-save after the DME Designer is synchronized to the DME unit. 

■ [Component Editor] Tab
Sets up operation of the Component Editor knobs, sliders, and edit boxes. Refer to “Changing 
Parameters” on page 266.
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Security (Creating Users and Making User Settings)
When you click the [Security] command on the [Tools] menu, the “Security” dialog box is displayed. 
Here you can create and delete users. You can also set the security level for each user. Users are 
saved as DME Designer settings. You don’t need to create users for each file. 

■ User Setting Restrictions
Various restrictions apply, depending on the security level of the user that is currently logged on.
• The currently logged on user can edit only users at a security level lower than his or her own. 
• The currently logged on user cannot raise his or her own security level. 

■ [Administrator] User
The [Administrator] user is registered by default, and can use all functions. Immediately after DME 
Designer is installed, there is no password set for the [Administrator] user. 

Auto-Logon User
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■ Security Level
User security levels are set with the [Operation Security] item at the right of the “Security” dialog 
box.

You can allow or disallow editing and the ability to open windows or set controls. 
Ten levels, 1 through 10, are set for scene storage/recall and user controls. Level 1 is the highest 
level and 10 is the lowest. By default, level 1 is set for the [Administrator] user. Level 1 can be set 
for the [Administrator] only. Users created by the [Administrator] directly below itself can be set at 
levels 2 through 10. New users created subordinate to users at level 2 can be set at levels 3 
through 10. New users can be created no higher than one level below the user that created them. 
Scene sets the level for storing and recalling scenes. The logged on user can store or recall scenes 
at levels equal to or lower than his or her own level. For example, a user at level 3 can recall scenes 
set for scene recall at levels 3 through 10. 
Levels are also set for user control. The logged on user can display or edit user controls at levels 
equal to or lower than his or her own level.
The log-on user can use zones that are checked in the [View Zone] field.

Level 1 User

Level 2 User

Level 3 User

Level 4 User

Security Level Settings

User Level

High

Low
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[Enable Auto-Log On]
Enables auto-logon. If this checkbox is selected, the user displayed in the box to the right will be 
logged on automatically when DME Designer is started. Auto-logon logs on the user without any 
password entry.
Click the [▼] at the right of the box, and select the user for auto-logon from the displayed user list. 
If auto-logon is turned OFF, the “Log On” dialog box will be displayed whenever the DME Designer is 
started. Each time a user must be selected and a password entered in order to log on. 
If auto-logon is changed from ON to OFF when a password is set for the currently logged on user, a 
“Confirmation of Current User” dialog box will be displayed.

Enter the user’s password into the [Password] box, and click the [OK] button. 
If you click the [Cancel] button, auto-logon will remain ON.

■ Auto-Logon User
Selects the user for auto-logon when [Enable Auto Log On] is checked.

The currently logged on user can set this command for users at a security level equal to or lower 
than his or her own. If a user at a higher level is selected, a message that warns “Cannot access 
higher user level.” will be displayed. Click the [OK] button. 

 

To set auto-logon for a user at a security level higher than the currently logged on user, first log off 
as the current user, then logon as a user at a higher security level. 
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User List
The registered users are displayed here. The currently logged on user is displayed in bold text. Click 
the name of the user whose settings you want to edit.

The [Administrator] is the user set by default, and it is used for administering the system. The 
[Administrator] user has the highest level and can use all functions. 
All new users are created at a level lower that the [Administrator] user, and are displayed below the 
[Administrator]. 
If a user at level 2 and below has other users subordinate to him or her, a [+] or [-] button will be 
displayed to the left of higher level user’s name on the list. Clicking the [+] or [-] buttons displays or 
hides the users subordinate to that higher user. 
The currently logged on user can create multiple users at lower levels. 

1 Name
Displays the user names. The currently logged on user is displayed in bold text.

2 Startup User Control
Displays “ON” to automatically open the user control and make settings when the user is logged 
on. 

3 [Add User] Button
Adds a user subordinate to the user selected on the list. Clicking here displays the “Add User” 
dialog box. Select the user that will be superior to the new user, then click this button.
If a user higher than the currently logged on user is selected, the button will be grayed out and 
no user can be added. 

4 [Remove User] Button
Deletes the user selected on the list. Only users at levels lower than the currently logged on user 
can be deleted. 
Furthermore, the currently logged on user cannot delete himself.

5 [Change] Button
Changes settings for the user selected on the list. Opens the “Change User Information” dialog 
box. The contents of the dialog box are the same as the “Add User” dialog box.

6

21

3 4 5
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6 Operation Security
Sets the functions that can be used by the user selected on the [User List] to the left. Selecting 
a checkbox enables use of the corresponding function. 

• [Edit]
You can change the following settings: editing in the Designer window, user control edit, user 
defined parameter edit, word clock, scene edit, GPI and MIDI. 

• [View DME Design Window]
Allows display of the Designer configuration window. 

• [Control Component Editor]
Allows parameter editing in the component editor. 

• [View Component Editor]
Allows display of the component editor.

• [Change Configuration]
Allows switching between configurations.

• [Synchronization] 
Allows synchronizing with the DME unit.

• [View Log Window]
Displays the Event Logger window.

• [Scene Store/Recall Level]
Sets the level at which scenes can be stored and recalled. Click the [▲] and [▼] buttons or 
enter a number into the box to set the level. While levels 1 through 10 are available, the range 
of levels that can be actually set varies according to the level of the user doing the setting. 
When a user is created, automatically this is set to “One level lower than the user above.” The 
initially set level is the highest level that can be set for that user. 

• [User Control Level]
Sets the user control level. Click the [▲] and [▼] buttons or enter a number into the box to set 
a level from 1 through 10. While levels 1 through 10 are available, the range of levels that can 
be actually set varies according to the level of the user doing the setting. 
When a user is created, automatically this is set to “One level lower than the user above.” The 
initially set level is the highest level that can be set for that user. 
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“Add User” Dialog Box/“Change User Information” Dialog Box
When you click the [Add User] button in the “Security” dialog box, the “Add User” dialog box is 
displayed. If you click the [Change] button in the “Security” dialog box, the “Change User Information” 
dialog box is displayed. 
The “Add User” dialog box is for setting a user name and password when adding a new user. You can 
change user settings in the “Change User Information” dialog box. The contents of the dialog boxes 
are the same.

■ [Name] Box
Enter the user name. Enter a name different than other existing user names. 

■ [Password] Box
Enter the password. When you type in the password box, asterisks (*) will be displayed instead of 
the characters you enter. If you do not want to set a password the user, leave the box blank.

■ [Confirm Password] Box
Enter the password once again to confirm it. When you type in the password box, asterisks (*) will 
be displayed instead of the characters you enter. If you do not want to set a password the user, 
leave the box blank.

■ [Startup User Control]
When a user logs on, user controls and settings which are specified or below that user’s security 
level are automatically opened.
In the “Security” dialog box [User List], [User Control] will be “ON” for users for whom this option 
has been turned on.

■ [OK] Button
In the “Add User” dialog box, this creates new users according to the settings made there. In the 
“Change User Information” dialog box, this applies the dialog box settings and changes the user 
settings.

■ [Cancel] Button
Cancels user creation or setting changes, and closes the dialog box.

“Add User” dialog box “Change User Information” dialog box
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Creating Users
Users are created as follows: 

1 Click [Security] on the Main Panel window [Tools] menu. 
The “Security” dialog box will be displayed.
You can open the “Security” dialog box by clicking the [Security] button in the Main Panel window. 

2 Select a user from the [User List] in the “Security” dialog box. 
A user will be created subordinate to the selected user. [Administrator] can be selected only if the 
logged on user is the [Administrator]. If there are multiple users, select the user that will be above 
the new user. 
Multiple users can be created subordinate to a single user. 

3 Click the [Add User] button. 
The “Add User” dialog box will be displayed.

4 Enter the user name into the [Name] box. 

5 Enter the password into the [Password] box. 
You can also create users with no password. If you do not want to set a password for the user, 
leave the [Password] box blank.

6 Enter the password into the [Confirm Password] box also. 
If you do not want to set a password for the user, leave the [Confirm Password] box blank also.
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7 Set the [Startup User Control].

8 Click the [OK] button. 
This closes the “Add User” dialog box. The new user will be added to the “Security” dialog box list.

9 Set the security level for the user, using [Operation Security] in the “Security” dialog box. 
When creating a new user, all the checkboxes in [Operation Security] will be turned OFF. Click and 
turn ON the functions you want to permit the new user to use. [Scene Store/Recall Level] and [User 
Control Level] will be set to one level lower than the user above the newly created user. The initially 
set level will automatically be the highest level that can be set for that user. To lower the level, enter 
a larger number in the box. 

Click the [OK] button and the dialog will close. You can continue creating new users without 
closing the dialog box. 

NOTE

If the text entered into the [Password] and [Confirm Password] boxes is not the same, a “Different password!” message 
will be displayed. Click the [OK] button and reenter the correct password in the [Password] and [Confirm Password] 
boxes in the “Add User” dialog box.
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Scene Manager

Scenes
Configuration contents can be given a name and saved as “Scenes.” Saving scenes is called “Scene 
Store.” Parameter settings in the configuration for each site used can be stored multiple times and 
recalled and used when needed. There are 999 scene memories available. When a scene is stored, 
DME parameters are saved as “preset parameters.” Presets are automatically created when a scene 
is stored. 
Bringing back a scene (making a scene the current scene) is called “scene recall.” Scenes are 
recalled using the [▼] button next to the current scene on the Main Panel window or by using the 
“Scene Manager” dialog box. 

■ Security for the Logged On User
The currently logged on user can store, recall, or edit scenes that have a security level equal to or 
lower than his or her own. User security levels are set with the [Edit] → [Store/Recall/Edit] item in 
the “Security” dialog box. 

“Scene Manager” Dialog Box
When you click [Scene Manager] in the [Tools] menu, the “Scene Manager” dialog box is displayed. 
 

[Cut] Button

[Copy] Button [Insert] Button

[Paste] Button [Clear] Button [Recall Safe] Button

List

[Store] Button

[Recall] Button

[Detail] Button
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■ List
Displays the contents of the scene.

Scene No.
Displays the scene number. There are 999 scene memories available. Click here to select a scene. 

Name
Displays the name of the scene. Click the [Name] box to enter a scene name. Up to 18 characters 
can be entered. 
If the scene has not been stored, “[No Data]” will be displayed. A name can be entered when a 
scene is stored. The default names are “Scene001,” “Scene002,” etc. The three-digit number is the 
same as the scene number (displayed in [Scene Number]) for the stored scene. 

Configuration
Displays the configuration name. If the scene has not been stored, a hyphen (-) will be displayed.

Edit Security
Displays the scene edit security levels. Clicking here will display a list where you can change these 
security levels. Only levels at or below the security level of the currently logged on user are 
displayed in the list. When a user is created, these settings are the same as the new user's security 
level, but scene store and edit settings can be set lower. 

Recall Security
Displays the scene recall security level. Clicking here will display a list where you can change the 
security level. Only levels at or below the security level of the currently logged on user are 
displayed in the list. When a user is created, these settings are the same as the new user's security 
level, but the scene recall setting can be set lower. 

Fade
Fade is used when Fader components are used in a configuration. It sets whether fade is applied 
(ON) or not (OFF) when a scene is recalled. 

NOTE

The fade function cannot be simulated in DME Designer.
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Fade Mode
Sets the fade mode. You can select “All” or “Selected.”
If you select “All,” all channels using Fader components in their configuration will be affected. Even 
when multiple components are used, all channels are targeted. If you select “Selected,” the only 
channels affected will be those for which the Fade switch in the component editor has been set to 
ON.

Fade Time
Sets the fade time: i.e. the time it will take fader and pan parameters to reach their new settings 
when a scene is recalled. The changes are smooth and continuous. If only the presets in the 
recalled scene are set when that scene is recalled, the volume will be adjusted while the sound 
from the previous scene is playing, until the new level is reached If the configuration also changes, 
the volume will rise from silence until it reaches the new value. This can be set from zero to 60 
seconds, in 0.1 second increments.

■ [Cut] Button
Cuts the scene selected on the list.

■ [Copy] Button
Copies the scene selected on the list.

■ [Paste] Button
Pastes the contents of the cut or copied scene into the scene selected on the list. The selected 
scene will be overwritten. If no scene has been cut or copied, the button will be grayed out and 
cannot be used.

NOTE

The Fade switch for each channel is set to OFF by default. The fade effect will not be applied, even if Fade=ON and 
Fade Mode=Selected is selected. To apply the effect, you must set the Fade switch to ON for the channels where you 
need it.

NOTE

Right-click in the list and use the contextual menu that appears to set User Defined Button, Program Change, GPI In, or GPI 
Out for the scene.
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■ [Insert] Button
Inserts the contents of the cut or copied scene into the location of the scene selected on the list. 
The selected scene and those below are moved down by one. For example, if “Door_Open” was 
stored as scene number “005,” and selected when the [Insert] button was clicked, the inserted 
scene would become scene number “005,” and “Door_Open” would be moved to scene number 
“006.”

If no scene has been cut or copied, the button will be grayed out and cannot be used.
If a scene is stored in the lowest scene on the scene memory list (with the scene number [999]), the 
button will be grayed out and the insert function will not be available. Delete the contents of scene 
number 999 before attempting to use the insert function. 

■ [Clear] Button
Deletes the contents of the scene selected on the list. 
If the presets included in a scene are not used in another scene, a “Delete preset?” message will 
be displayed. 

If the presets are not needed, click the [OK] button. If you click the [Cancel] button, the presets will 
not be deleted. Whichever you click, the scene itself will be deleted. 

NOTE

Move the scene data to a different scene memory when you don’t want to erase the contents of Scene No. 999.

NOTE

The [Cancel] button on the “Delete Preset?” message does not cancel the [Clear] for the scene. It merely cancels 
deletion of the presets. 

Click the 
[Insert] button
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■ [Recall Safe] Button
Before performing a recall, you can check the contents of the scene selected on the list, and set 
components that will not be read. This is used when there are components you do not want 
changed by the scene recall. 
When you click this button, the “Recall Safe” dialog box will be displayed.

All components included in the scene will be displayed. There is a checkbox to the left of each 
component. Place a check next to the components you do not wish to have read by scene recall 
(those you do not wish changed from their current status). 
Press the [Select All] button to check all components, or the [Clear All] button to clear the checks 
from all components.
Click the [OK] button. The dialog box will close and when the scene is recalled, all components, 
except those checked, will be read. 

■ [Store] Button
Stores the contents of the current configuration into the scene selected in the list. If an empty scene 
is selected and the contents stored there, a new scene is created. If a scene is already stored in 
the selected scene number, it will be overwritten. If [Confirm Scene Store] is checked on the 
[Application] tab of the “Preferences” dialog box, a confirmation dialog box will be displayed 
before the scene is stored. 

When a scene is stored, the configuration parameters at that time are saved as “preset 
parameters.” Presets are created automatically.

NOTE

The components checked in the “Recall Safe” dialog box are the components that will not be read (that will be ignored). 
If you want to read all components, there is no need to make settings in the “Recall Safe” dialog box. 
“Recall Safe” is used when you want to keep some components with their current settings, while there are other 
components you want to change according to the scene. 

NOTE

The currently logged on user can store scenes at a security level equal to or lower than his or her own only. 

NOTE

When the computer and DME unit are online, a scene stored in the DME Designer will also be stored on the DME unit, 
regardless of the DME settings.
The DME utility display Misc. page [Scene Store] setting only affects store operation from the DME panel controls.

Component NameCheckbox
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■ [Recall] Button
Recalls the scene selected in the list and makes it the current scene. 

■ [Detail] Button
Expands the dialog box and displays a preset list. If you click the preset list while it is displayed, 
the preset list will be hidden. When the dialog box is opened, its status will be the same as the last 
time it was closed. 

■ Preset List
Displays the presets for each DME unit in the scene selected in the list. When another scene is 
selected on the list, the contents of the preset list will be changed. 
You can change the presets used in the scene by clicking the radio buttons to the left of the preset 
names. You can also create, delete, and store presets or change their names.

DME
Displays the DME. Below the DME are [Slot], [Component], and [AD]. If there are presets below 
them, a [+] button will be displayed. When you click the [+] it becomes a [-] and the presets are 
displayed. 

Preset
Displays DME presets.
If you click the preset name, selecting the text that is there, you can change the preset name. When 
presets are automatically created when a scene is stored, they are named “Preset001,” 
“Preset002,” and so on. Presets created with the [New] button are named “New Preset.”
You can select the presets used in a scene by clicking the radio buttons to the left of the preset 
names. 

NOTE

The currently logged on user can recall scenes at a security level equal to or lower than his or her own only. 

Preset List

[Del] Button
[Store] Button

[New] Button

[Del Unused] Button

[Detail] Button

DME

Preset

DME

Preset
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■ [Del] Button
Deletes the preset selected on the preset list. 

■ [Store] Button
Stores the current parameter status in the preset selected in the preset list. The contents of the 
selected preset will be overwritten.

■ [New] Button
Stores the current status and creates a new preset. The newly created preset is named “New 
Preset.”

■ [Del Unused] Button
Deletes presets that are not used by DMEs included in the current zone. 

NOTE

Presets used in a scene cannot be deleted.

NOTE

There is no [OK] button or [Cancel] button in the “Scene Manager” dialog box. To close the dialog box, click the [Close] 
button at the upper-right of the dialog box. 
Changes from storing/recalling scenes or editing, such as changing names or contents, will be applied immediately. 
With the dialog box open, you can make the Designer window active and add components or change parameters.
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User Control

User Controls
You can create an original control by arranging knobs and sliders in the component editor. Controls 
you create are called “user controls.”
Those created user controls are displayed in the [View] → [User Control] submenu in the Main Panel 
window 

■ Security for the Logged On User
The currently logged-on user can create and edit the user controls of all users at lower security 
levels as well as the controls specified for that user. Available user controls are displayed in the 
User Control manager dialog box that can be accessed through the [User Control] sub-menu of the 
main panel window [View] menu.
The user control security level for each user is set with [Operation Security] → [User Control Level] 
in the “Security” dialog box. For information about user security, see “Security (Creating Users and 
Making User Settings)” on page 55.

“User Control Manager” Dialog Box
When you click [User Control Manager] on the [Tools] menu, the “User Control Manager” dialog box is 
displayed. This dialog box displays a list of user controls included in the configuration of the current 
zone. There they can be created or deleted. You can also edit the name and security level of user 
controls here. 

NOTE

Only controls available to the currently logged on user are shown in the list.
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■ User Control
Displays the names of the user controls. Clicking here will select the characters in the name, 
allowing you to change it. 

■ Security Level
Displays the security level set for each user control. 
Clicking here will display a list where you can change the security level. 

■ User
Displays the name of the user specified in User Control.
Clicking here will display a list of the available users.

NOTE

Levels at or below the security level of the currently logged on user are displayed in the list.
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■ [New] Button
Creates new user controls. Clicking here displays the “New User Control” dialog box.

Enter the User Control name in the [Name] box.

■ [User Level]/[User Name]
Use the radio buttons to the left to select security-level or user dependent control.

[User Level]
Select a security level from the drop-down list.

[User Name]
Check a checkbox.
Click [OK] to create the specified User Control setup.

■ [Delete] Button
Deletes the user control selected on the list.

■ [OK] Button
Accepts the changed settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without changing the settings.
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Parameter Link

About Parameter Links
You can group parameters of the same type and link them. These groups are called “Parameter 
Links.” When one parameter in a group is changed, all parameters in the group will change in the 
same way. 
There are two parameter link types: global links and local links. Global links link parameters for DMEs 
within a zone. Local links link parameters that are included for a single DME.

Groups can be created and parameters added to groups in the user control/user module control 
editor and component editor. For information about creating parameter links, see “Creating Parameter 
Links” on page 314. 
You can check the status of parameter links and edit them in the Parameter Link window. 

Parameter Link Window
When you click [Parameter Link] in the [Tools] menu, the “Parameter Link” window is displayed. You 
can also display the window by selecting [Open Parameter Link] from the context menu displayed in 
the user control/user module editor and component editor. 

1 [Global Link] button/[Local Link] button
Switches the window display. 

• Global Link
Links to the parameters of multiple DME units in the zone. 

• Local Link
Links to the parameters of one DME unit.

NOTE

Parameters can not apply to multiple groups.

NOTE

Because there is a large load on the network, the maximum number of Global Links will be limited to eight. 

[Global Link] button/[Local Link] button

Parameter Link Mode
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2 Parameter Link Mode
Parameter linking is active when checked. Uncheck to temporarily disable parameter linking. 
Uncheck when you want to adjust the parameters individually.
You can also turn parameter link mode ON or OFF using the context menu in the user control/
user module editor or component editor. 

• Group List
Displays a hierarchical list of groups and the parameters that belong to them. 
When a group name is selected, the controls that belong to that group are selected. 

• Keep Offset (Group icon)
Turns ON or OFF whether the offset value set for each parameter is retained as it is. When ON 
is set for a group, the Keep Offset icon is displayed in orange. When OFF is set for a group, it 
is displayed in green. 
When Keep Offset is set to ON and any parameter within the group goes to the minimum or 
maximum value, the parameters cannot be further changed. 
Keep Offset can be set to ON or OFF using the “Keep Offset” item on the context menu that is 
displayed when you right click the name of a group. 

• Group Name
You can select a group name by clicking on it. Clicking the selected group name again will 
select the characters in the name, allowing you to change it. 
Clicking the plus (+) or minus (-) sign to the left of the group name displays or hides items that 
belong to that group. 
You can delete a group by selecting it and pressing the <Delete> key. You can also delete a 
group by right-clicking on the group name and selecting [Delete] in the context menu that is 
displayed. 

• DME Icon
Displays the DME that includes the parameters that belong to a group. The components can 
be displayed or hidden by clicking the plus (+) or minus (-) signs for the DME icon. The 
parameters, Min, and Max can be displayed or hidden by clicking the plus (+) or minus (-) 
signs for the component. 

• Parameter
 Displays the parameters that belong to a group. You can display or hide minimum and 
maximum values for a parameter by clicking the plus (+) or minus (-) signs. 
You can delete a parameter from a group by selecting the parameter name and pressing the 
<Delete> key.
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Synchronization 
(DME Designer and DME Unit Synchronization)

The DME unit and DME Designer are synchronized by Synchronization. The DME operates according 
to the configuration and scene information transferred during this process. 
This Synchronization is used when transferring the configuration in DME Designer and when 
controlling the DME unit in real time. 

Online and Offline
When a DME unit is connected to the computer and synchronized with DME Designer, its status is 
called “Online.” When a DME unit is not physically connected to the computer or is not synchronized 
even when it is connected, its status is called “Offline.” You can check the online/offline status and 
message transmission in [Communication Status] in the Main Panel window.

■ Online
Sends configurations created in DME Designer to the DME unit and reads data from the DME unit, 
so that the DME unit configuration is reflected in the DME Designer configuration. You can also 
control the DME in real time from DME Designer. Operations performed in the DME Designer 
control editor are reflected in the DME unit, and operations on the DME side are reflected in DME 
Designer.
You can not perform configuration editing using the Designer while online. 

■ Offline
The communication status becomes offline when editing configurations.

■ Switching Between Online and Offline
You can switch between online and offline in the “Synchronization” dialog box. 

NOTE

Because Synchronization presupposes that the DME unit can communicate with the computer where DME Designer is 
installed, the necessary drivers (USB-MIDI or DME-N Network Driver) must be installed, and appropriate settings must be 
made for the driver and for DME Designer MIDI IN/OUT (page 90). 
For information about driver installation and settings, see the installation guide. For DME Designer communications settings, 
see “Online” (page 35).

NOTE

Because there are no scene settings when the DME unit is purchased, the configuration and scene information in DME 
Designer must first be transferred. 

NOTE

For information about the online procedure, see “Online” (page 35).

NOTE

For information about the online procedure, see “Online” (page 35).
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“Synchronization” Dialog Box
When you click the [Synchronization] command on the [Tools] menu, the “Synchronization” dialog box 
is displayed. The data from the current zone in the Designer is synchronized with the DME unit. 
Here you can make settings for synchronizing the unit in DME Designer one-on-one with the DME that 
actually exists on the network. 

[Go On-line] Button

[Go Off-line] Button

[Designer] [Network]

Message Area

[Close this window after synchronization] checkbox
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■ [Go On-line] Button
This button will be grayed out when the software is online. 
Clicking the button displays a dialog box where you can decide the synchronization method. 

[Designer→DME] button 
A consistency check is performed between the data in the current zone and the DME data, then 
the communication status changes to online. Transmits data from the DME Designer to the DME 
unit and synchronizes the two. 

[Designer←DME] button 
Data from the DME unit is read into DME Designer. Current data stored in the DME unit, such as 
scenes, are read into DME Designer. This assumes that the configurations in the DME unit and the 
DME Designer agree. 

■ [Go Off-line] Button
Clicking this button changes from online to offline. While offline, this button will be grayed out. 

■ [Close this window after synchronization] Checkbox
When this checkbox is checked the dialog window will close automatically after synchronization.

■ Designer
The Designer list displays DME units arranged in the currently valid zone in the DME Designer.
The unit in the DME Designer is matched with a recognized IP address, and they are compared 
one-to-one. 

DME Name
Displays the names of DME units included in the project. 
When multiple DMEs of the same type are arranged in a zone window, it is a good idea to change 
the name of each one. 

IP Address Select Box
Matches the units in the Designer with recognized IP addresses. Click the [▼] to display the IP 
addresses of same type of devices in the area. If the unit is a DME24N, IP addresses for all 
DME24N devices in the area will be displayed on the list. 
If you click the title bar with “IP Address” written on it (pale ▲ mark appears), you can line them up 
vertically. 

IP Address Select BoxDME Name
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■ Network
The devices currently connected to the network are displayed in the Network list. To keep 
consistency with the Designer list on the left side, the status of DMEs on the network is displayed. 

IP Address

• DME Icon
Displays DME and ICP1 devices connected to the network. The zone master DME icon is red. 
Icons for slave DMEs are blue. DMEs and ICP1 devices with no relation to DMEs in Designer 
have gray icons. 

• IP Address
Displays the DME IP address.

■ Message Area
Displays a message that synchronization is in progress. 

Reading from the DME Unit
When you are offline in a condition where it is possible to go online, you can read data. 
Before this can be done, configurations, such as cards inserted in the slots and any connected serial 
devices, must agree for the DME unit and DME Designer. 

Preset data overwritten in the DME unit is read, along with every type of parameter setting managed in 
DME Designer. 

NOTE

The event log is read in the Event Logger.

DME Icon
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GPI
About GPI
GPI is an abbreviation for General Purpose Interface. Using GPI input and output, DMEs can be 
remotely controlled from custom-made controllers or external equipment. For both input and output, 
the DME64N provides 16 GPI channels and the DME24N provides eight. Sets GPI input/output for 
each DME. 
Using GPI input data, you can switch DME scenes and change component change component 
parameters.

For hardware-related information such as the connection method for GPI, see the “DME64N/24N 
Owner’s Manual.” 

“GPI” Dialog Box
When you click the [GPI] command on the [Tools] menu, the “GPI” dialog box is displayed. Sets GPI 
input/output for the DME.

■ [DME]
From the list, select the DME where you will be making settings.

■ Configuration
The current configuration name will be displayed.

NOTE

Only users for whom the [Operation Security] → [Edit] checkbox has been checked can make GPI settings.

[DME]

GPI IN

GPI OUT

[Apply] Button

[OK] Button

[Cancel] Button
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■ GPI IN
The DME64N has 16 GPI IN channels, and the DME24N has 8 GPI IN channels.
These settings determine which DME parameters will be controlled by input received at each 
individual GPI IN channel. The channel numbers are shown in the leftmost column.

[Function]
Specifies the function to be controlled by GPI input. Click to see a list from which you can choose 
the function to be assigned to the corresponding GPI IN channel.
The nine available functions are: [No Assign], [Parameter Value Edit], [Scene Change], [Scene 
Increment], [Scene Decrement], [Mute], [GPI Lock], [Time Adjustment], [Play Wav File].
The [Parameter], [Min], [Max], and [Terminal] items will change according to the selected function.

• [No Assign]
No function assigned. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Min], [Max], and [Terminal] items are not available.
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• [Parameter Value Edit]
Allows component parameters to be changed via GPI input.
In this case [Parameter] is used to select the parameter to be controlled.
[Min] and [Max] specify the range over which the parameter can be changed.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

 and  specify continuous control of continuously-variable parameters from an external 
fader, knob, or similar device.

 and  specify on/off control of 2-state parameters via an external switching device.

The parameter value changes in proportion to the voltage applied to the GPI input.
The minimum voltage applied to GPI IN will produce the specified [Min] parameter value, and the 
maximum voltage applied to GPI IN will produce the specified [Max] parameter value, with 
intermediate voltages produced the corresponding intermediate parameter values.

The parameter value changes in inverse proportion to the voltage applied to the GPI input.
The minimum voltage applied to GPI IN will produce the specified [Max] parameter value, and the 
maximum voltage applied to GPI IN will produce the specified [Min] parameter value, with 
intermediate voltages produced the corresponding intermediate parameter values.

The specified [Min] and [Max] parameter values are alternately selected each time the voltage 
applied to GPI IN rises from below to above the median voltage.*

The specified [Min] and [Max] parameter values are alternately selected each time the voltage 
applied to GPI IN drops from above to below the median voltage.*

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level] 
is set in the [Parameter] box.

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

[Max] parameter value

[Min] parameter value

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

[Max] parameter value

[Min] parameter value

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level] 
is set in the [Parameter] box.

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

[Max] parameter value [Max] parameter value[Min] parameter value

Median voltage

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level] 
is set in the [Parameter] box.

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

[Max] parameter value [Max] parameter value[Min] parameter value

Median voltage

Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level] 
is set in the [Parameter] box.
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• [Scene Change]
GPI input can be used to recall a specified scene.
[Parameter] specifies the number of the scene to be recalled.
[Min] and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN rises 
from below to above the median voltage.*

The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN drops 
from above to below the median voltage.*

Same as .

Same as .

• [Scene Increment]
GPI input can be used to increment the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

The scene number will be incremented each time the voltage applied to GPI IN rises from below to 
above the median voltage.*

The scene number will be incremented each time the voltage applied to GPI IN drops from above to 
below the median voltage.*

Same as .

Same as .

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger
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• [Scene Decrement]
GPI input can be used to decrement the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

The scene number will be decremented each time the voltage applied to GPI IN rises from below to 
above the median voltage.*

The scene number will be decremented each time the voltage applied to GPI IN drops from above to 
below the median voltage.*

Same as .

Same as .

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger
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• [Mute]
GPI input can be used to engage or disengage the DME mute function.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

Mute will be ON when the voltage applied to GPI IN is above the median voltage*, and OFF when the 
voltage is below the median.

Mute will be OFF when the voltage applied to GPI IN is above the median voltage*, and ON when the 
voltage is below the median.

Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN drops from 
below to above the median voltage.*

Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN rises from above 
to below the median voltage.*

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage
MUTE ON

MUTE OFF MUTE OFF

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage
MUTE OFF

MUTE ON MUTE ON

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

ON ONOFF

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

ON ONOFF
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• [GPI Lock]
GPI Lock can be turned on or off via GPI input. When GPI Lock is ON, all GPI inputs other than 
the one being used for GPI Lock control are locked and input will be ignored.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

GPI lock will be ON when the voltage applied to GPI IN is above the median voltage*, and 
OFF when the voltage is below the median.

GPI Lock will be OFF when the voltage applied to GPI IN is above the median voltage*, and 
ON when the voltage is below the median.

GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN drops 
from below to above the median voltage.*

GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN rises 
from above to below the median voltage.*

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage
MUTE ON

MUTE OFF MUTE OFF

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage
MUTE OFF

MUTE ON MUTE ON

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage
MUTE ON

MUTE OFF MUTE OFF

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage
MUTE OFF

MUTE ON MUTE ON
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• [Time Adjustment]
GPI input can be used to adjust the DME internal clock as follows:

[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

 and  specify continuous control of continuously-variable parameters from an external 
fader, knob, or similar device.

 and  specify on/off control of 2-state parameters via an external switching device.

The internal clock time will be adjusted each time the voltage applied to GPI IN rises from below to 
above the median voltage.*

The internal clock time will be adjusted each time the voltage applied to GPI IN drops from above to 
below the median voltage.*

Same as .

Same as .

Internal clock time Time after adjustment

0~14 seconds Returned to 0 seconds

15~29 seconds Advanced to 30 seconds

30~44 seconds Returned to 30 seconds

45~59 seconds Advanced to 0 seconds

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger
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• [Play Wav File]
GPI input can be used to initiate playback of the specified Wave file.
[Parameter] specifies the Wave file to be played. Files specified by the Wav File Manager can 
be selected. Wave files can only be selected if a Wav Player is included in the DME 
configuration.
[Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter. 

 and  specify continuous control of continuously-variable parameters from an external 
fader, knob, or similar device.

 and  specify on/off control of 2-state parameters via an external switching device.

The specified Wave file will be played each time the voltage applied to GPI IN rises from below to 
above the median voltage.*

The specified Wave file will be played each time the voltage applied to GPI IN drops from above to 
below the median voltage.*

Same as .

Same as .

* “Median voltage” refers to the voltage halfway between the maximum and minimum voltages detectable by the GPI 
input terminals. Refer to the “GPI Page” section of the “Utility Screens” chapter of the DME64N/24N Owner’s manual 
for details on GPI voltages.

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger

Max. voltage applied to GPI IN

Min. voltage applied to GPI IN

Median voltage

Trigger
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■ GPI OUT
The DME64N has 16 GPI OUT channels, and the DME24N has 8 GPI OUT channels.
These settings determine which DME parameter values will be output via each individual GPI IN 
channel. The channel numbers are shown in the leftmost column.

[Function]
Specifies the function to be transmitted via a GPI output.
The four available functions are: [No Assign], [Parameter Value Edit], [Scene Change], and [GPI 
Lock].
The [Parameter], [Threshold], [Terminal], and [Polarity] items will change according to the selected 
function.

• [No Assign]
No function assigned, and no GPI output will occur. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Threshold], [Terminal], and [Polarity] items are not available.

• [Parameter Value Edit]
Allows component parameter values to be output via GPI.
In this case [Parameter] is used to select the parameter to be output.
[Threshold] specifies the parameter threshold value.
[Terminal] and [Polarity] determine how the GPI voltage will be output in response to 
parameter changes.

Terminal Polarity GPI Output

Ignored When value of the specified parameter is above the threshold level the 
output will be high, and when below the threshold level the output will be 
low.

Ignored When value of the specified parameter is below the threshold level the 
output will be high, and when above the threshold level the output will be 
low.

A pulse*1 will be output when the value of the parameter changes from 
below to above the threshold.

A pulse*1 will be output when the value of the parameter changes from 
above to below the threshold.

A pulse*2 will be output when the value of the parameter changes from 
below to above the threshold.

A pulse*2 will be output when the value of the parameter changes from 
above to below the threshold.
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• [Scene Change]
The recall status of the specified scene is transmitted via GPI output.
[Parameter] specifies the scene for which the recall status is to be output.
[Threshold] and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.

• [GPI Lock]
The GPI Lock status is transmitted via GPI output.
[Parameter], [Threshold], and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.

Event Schedule
Event Schedule is shown when [GPI OUT] is set in “Event Scheduler.”
See “Event Scheduler” on page 116.

User Defined Button
User Defined Button is shown when [GPI OUT] is set in “User Defined Button.”
See “User Defined Button (User Defined Parameters)” on page 98.

Event Log
Event Log is shown when [GPI OUT] is set in “Event Logger.”
See “Event Logger” on page 111.

Terminal GPI Output

When the current scene is the same as the scene specified by [Parameter] the output will 
be high, and when different the output will be low.

When the current scene is the same as the scene specified by [Parameter] the output will 
be low, and when different the output will be high.

A pulse*1 will be output when the current scene is the same as the scene specified by 
[Parameter].

A pulse*2 will be output when the current scene is the same as the scene specified by 
[Parameter].

Terminal GPI Output

When GPI Lock is ON the output will be high, and when OFF the output will be low.

When GPI Lock is ON the output will be high, and when OFF the output will be low.

250 msec

HI

LO
250 msec

HI

LO

*1 Pulse waveform 1 *2 Pulse waveform 2
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MIDI
When you click the [MIDI] command on the [Tools] menu, the “MIDI” dialog box is displayed. Here you 
can make MIDI input/output port, remote control, and other settings.

[Setup] Tab
Sets the DME MIDI channels along with program change, control change, and parameter change. 

■ [DME]
From the list, select the DME where you will be making settings. 

■ MIDI CH
Sets the MIDI channel. This number is also used as the Parameter Change Device ID.

[Tx]
Select the MIDI transmit channel from the list. 

[Rx]
Select the MIDI receive channel from the list. 

■ Program Change/Control Change/Parameter Change
Sets transmit (Tx), receive (Rx), OMNI, and Echo for program change/control change/parameter 
change. When ON, clicking turns this OFF. When OFF, clicking turns this ON. When OMNI is [ON] 
channel messages are received regardless of the receive channel setting. When ECHO is [ON] the 
input data is “echoed” (re-transmitted) via the output port that corresponds to the input port via 
which it was received.
Detailed settings for program change, control change, and parameter change are made on the 
[Program Change] tab, the [Control Change] tab, and the [Parameter Change] tab. 
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[Control Change] Tab
Assigns components to control change for each DME. You can change DME parameters by sending 
control change messages from external equipment. 
You can assign to control change numbers 1-31, 33-95, and 102-119. 

■ [DME]
From the list, select the DME where you will be making settings. 

■ Control Change List
The control change numbers and current settings are displayed in the list in the center. 

No.
Displays the control change numbers.

Component
Displays the assigned components. Control changes that have no component assigned to them 
are blank. If you click here, a list will be displayed. Usable components are on the list. Click the 
component name to select it.

NOTE

Because control change numbers 0 and 32 are used for bank select MSB, numbers 96-101 are RPN/NRPN related, and 
120-127 are used for mode messages, they cannot be used for component assignment.
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Parameter
Set the assigned component link parameter. 
When you click here, a list of parameters included in the component is displayed. Select the 
parameter you want to assign.

Min/Max
Sets the range of operation for the parameter. The current values for the [Min] (lower limit) and 
[Max] (upper limit) are displayed. If you click here, a slider will be displayed. The range and 
parameter units that can be set will vary, depending on the parameter selected in the [Parameter] 
box.
You can change the parameter by dragging the slider. To make a finer setting, press the <Shift> 
key while dragging the slider. The value for the parameter will be shown while you are dragging the 
slider. When you finish dragging and release the mouse button, the slider will disappear. 
The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the 
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag 
the right edge, the [Max] will change. 

 

■ [Clear] Button
Clears assignments for the selected control change numbers. 

■ [All Clear] Button
Clears assignments for all control change numbers. 
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[Program Change] Tab
Assigns scenes to program control change numbers 1 through 128. Switches scenes when program 
changes are received. These settings are shared by all DMEs in the zone. Up to 999 assignments can 
be made. Scenes above number 128 are assigned by changing banks.

■ Program Change Event
Program numbers and the scenes assigned to them are displayed in a list. 

No.
This displays program numbers from 1 to 128. 

Scene
Displays the scene number and name of the assigned scene. Program changes that have no 
scene assigned to them are blank. 
When you click here, a list of scenes is displayed. Select the scene you want to assign.

■ [All Clear] Button
Clears all scene assignments. 

■ [Clear] Button
Clears the scene assignment for the program number selected in the list, so that no scene is 
assigned to that number.
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■ [All Assign] Button
Assigns all scenes in order starting from program number 1. 

■ Bank Select LSB
The bank is changed when assigning scenes numbered 129 and higher. Eight banks can be used, 
numbered from zero to seven. Click the [▼] and select the bank where you will make settings. 

[Parameter Change] Tab
Specifies the parameter to be controlled by parameter change commands for each address. Up to 
128 can be set.

■ [DME]
From the list, select the DME where you will be making settings. 
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■ Parameter Change List
The current settings are displayed in the list in the center. 

No.
This displays the parameter change numbers.

Component
Assigns components. If you click here, a list will be displayed. Assignable components are on the 
list. Click the component name to select it.

Parameter
Set the assigned component link parameter. 
When you click here, a list is displayed of parameters included in the component selected in the 
[Component] box. 
Select the parameter you want to assign.
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Min/Max
This sets the parameter range. The current values for the [Min] (lower limit) and [Max] (upper limit) 
are displayed. The range and units that can be set will vary, depending on the parameter selected. 
If you click here, a slider will be displayed.
You can change the parameter by dragging the slider. To make a finer setting, press the <Shift> 
key while dragging the slider. The value for the parameter will be shown while you are dragging the 
slider. When you finish dragging and release the mouse button, the slider will disappear. 
The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the 
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag 
the right edge, the [Max] will change. 

 

■ [Clear] Button
Clears the assignment for the parameter change selected in the list, so that nothing will be 
assigned to it.

■ [All Clear] Button
Clears all parameter change assignments. 
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[Port] Tab
Sets the MIDI port for the current zone used by DME Designer.

■ MIDI PORT
Selects the MIDI driver used for transmitting and receiving MIDI messages.

[Tx]
Selects, from a list, the MIDI driver used for transmitting MIDI messages.

[Rx]
Selects, from a list, the MIDI driver used for receiving MIDI messages.
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User Defined Button (User Defined Parameters)

User Defined Parameters
Parameters that the user can operate using function keys <F1> through <F6> in the DME unit or ICP1 
are called “User Defined Parameters.” Frequently changed parameters can be assigned in advance 
to any of 24 (four pages times six) presets, and operated on the DME unit or ICP1 even if DME 
Designer is not being used. 

This function sets parameters in DME Designer that can be called by these function keys <F1> 
through <F6>.
In DME Designer, user defined parameter settings are made using the “User Defined Button” dialog 
box. The user defined parameter settings are shared between zone configurations. 

“User Defined Button” Dialog Box
When you click [User Defined Button] in the [Tools] menu, the “User Defined Button” dialog box is 
displayed. 

■ [1]/[2]/[3]/[4] Tabs
Switches the set to which settings will apply. You can set up to six function keys in each set. The 
user defined parameters set on a single tab are displayed on one page in the DME unit main 
screen. 

Function Keys
The function keys are displayed in the leftmost column of the table. When you enter text for [LCD 
Display], a short name with up to eight characters will be created and displayed to the right of the 
function key. 
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Function
Specifies the function to be assigned to the function keys.

• [No Assign]
No assignment. Select this option to clear an assigned function.

• [Parameter Value Edit]
Allows the parameter specified in the [Parameter] field to be changed.

• [Direct Parameter Value]
Allows the value of a parameter to be set directly. The target parameter is specified in the 
[Parameter] field, and the value to be set is specified in the [Max] field.

• [Scene Change]
Allows scene recall. The scene to be recalled is specified in the [Parameter] field.

• [GPI OUT]
Allows GPI output. The GPI setting is made in the [Parameter] field.

• [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a 
Wav Player is included in the DME configuration.
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Parameter
Sets the parameter assigned to each function key. If you click here, a list will be displayed. This list 
displays the parameters that are included in the current configuration. Select the parameter you 
want called by the function key. 

LCD Display
Sets the text displayed on the DME unit. Click the [LCD Display] box and enter text. Up to 23 
characters can be entered into the [LCD Display] box.   
After you confirm the name by pressing the <Enter> key, a short name will be created and 
displayed in the function key area as follows: “F1 [shortnam].” The short name will also be 
displayed in the DME unit main display. A short name is automatically created with up to eight 
characters for display as the user defined parameter name on the DME unit main screen

Min, Max
Sets the lower and upper limits for a parameter.

■ [Clear] Button
Clears assignments for the selected function keys. This is the same as “No Assign.”

■ [OK] Button
Accepts the changed settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without changing the settings.
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Setting User Defined Parameters 
After creating a parameter link group to assign, set the user defined parameter. 

1 Create a configuration. 

2 Click [User Defined Button] in the [Tools] menu. 
The “User Defined Button” dialog box will be displayed.

3 Click one of the tabs numbered [1] through [4] to select the set of user defined parameters 
you will assign your parameters to. 
The four tabs correspond to the pages on the DME unit main screen. 

4 Click the [Parameter] box for the function key to which you will assign the parameter. 
A list of parameters included in the current configuration will be displayed. 

5 Select the parameter to assign to the function key. 

6 Click the [LCD Display] box and enter text for the user defined parameter name. 
The [LCD Display] box can accept up to 23 characters, but only eight characters can be displayed 
in the DME unit main screen. When making a user defined parameter name, the first eight 
characters should be understandable. 

Note

When making multiple registrations, you can save time by first setting just the [Parameter] box for all keys, then setting 
the [LCD Display] box names. When you enter a user defined parameter name into an [LCD Display] box and press the 
<Enter> key to confirm it, the next [LCD Display] box down will be selected, and you can enter text there immediately. 
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Word Clock
The signal that synchronizes all devices connected to the DME is called the “Word Clock.” It uses the 
same frequency as the sampling frequency. The word clock is set for each DME in the “Word Clock” 
dialog box.
When you click [Word Clock] on the [Tools] menu, the “Work Clock” dialog box is displayed. 

■ DME
From the list, select the DME where you will be making settings.

■ Clock Information
Displays the word clock frequency for the DME selected in [DME].

Clock Information

Slot Information

Clock Status

• The DME24N has only one SLOT, and [Cascade] is not available.
• The number of channels varies according to the card inserted into the slot. 
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■ Card (Slot Information)
Displays the name of the card inserted into the slot. 

■ Clock Status
The clock status is displayed using a color code:

■ Internal/Word Clock/Cascade
You can select one of the following for the word clock: [Slot] (64N: 1-4, 24N: 1 only), [Internal] 
(44.1kHz/48kHz/88.2kHz/96kHz), [Word Clock] (WCK IN), [Cascade] (IN/OUT, 64N only). Clock 
buttons that are grayed out cannot be selected.

■ [Close] Button
Closes the dialog box.

Status Meaning

Indicates that there is no input signal.

Indicates there is an input signal and sync is possible with the current 
word clock.

Indicates there is an input signal but cannot sync with word clock (clocks 
are different).

Indicates that there is no DME unit information.

NOTE

You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>. 

Slot Number

Card Name
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Monitor
When you click the [Monitor] command on the [Tools] menu, the “Monitor” dialog box is displayed. 
Sets the monitor output destination. 

■ [DME]
From the list, select the DME where you will be making settings. 

■ Drop down list
From the list, select the card that will be the destination for the monitor output. 

■ [OK] Button
Accepts the changed settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without changing the settings.
DME Designer Owner’s Manual



Chapter 3  Main Panel Window
Clock
When you click the [Clock] command on the [Tools] menu, the “Clock” dialog box is displayed. Here 
you can set the DME internal clock. This can be set only when online. The default is the computer date 
and time.
Set the date in the left box and the time in the right box. You can change the numbers using the [▲] 
and [▼] at the right of the boxes. 

NOTE

You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>. 
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Language Settings
When you click the [Language] command on the [Tools] menu, the “Language” dialog box is 
displayed. This sets the DME unit language. 

■ [Language]
Select the language. [English/German/French/Spanish] and [Japanese] are in the list.

■ [OK] Button
Accepts the changed settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without changing the settings.

NOTE

You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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DME Firmware Update
You can update the DME unit firmware using the [Firmware Update] command on the [Tools] menu. 
When you move the mouse cursor over the [Firmware] command on the [Tools] menu, a submenu is 
displayed. 

When you select [Program] or [Component] on the submenu, the “Open” dialog box will be displayed. 
You can perform a firmware update by specifying a firmware update file.

When performing a firmware update, connect the DME unit and the computer.

When the DME update is finished, the DME unit will be automatically restarted. You also need to restart 
DME Designer.

NOTE

If the firmware has been updated from V1.07 or lower to V1.10 or upper, perform the update twice. Because the text display 
data in the DME unit is changed, text display for Japanese is not possible with one update only.
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■ [Program]
Updates the DME/CP1 unit program area firmware. Opens update files with the extension “.DPB”.

1 Select [Firmware Update] ➞  [Program] in the [Tools] menu.
The “Open” dialog box will be displayed.

2 Select an update program with the extension “.DPB” and click the [Open] button.
The “Firm Update” dialog box will be displayed. The DMEs in the current zone will be displayed 
in a list. 

3 Check the DME you wish to update. 
You can click on a checkmark to turn it ON/OFF. The [Select All] button places a checkmark 
next to all the DMEs. The [Clear All] button turns OFF all the DME checkmarks. 
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4 Check the DME you wish to update, then click the [Update] button.
The firmware update will begin. 

When the DME update is finished, the DME unit will be automatically restarted. You also need to 
restart DME Designer. 

■ [Component]
Updates the DME unit component firmware. When you select this command, the “Open” dialog 
box will be displayed. Opens update files with the extension “.DCB” (for DME) or “.CCB” (for ICP1). 
You can select multiple update files for components. 

■ DME Unit
When performing the firmware update, connect the DME unit and the computer by USB or 
Ethernet. The USB-MIDI or DME-N Network Driver must be installed in the computer. 

■ ICP1
To perform the firmware update, the ICP1 and the zone master DME unit must be connected by 
Ethernet. In addition, the zone master DME unit must be connected to the computer as described 
above. 

1 Select [Firmware Update] ➞  [Component] in the [Tools] menu. 
The “Open” dialog box will be displayed.

NOTE

While updating, be very careful not to disconnect the USB or Ethernet cable or turn off the power to the DME. The 
DME Designer MIDI setting information will be lost. 
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2 Select an update program with the extension “.DCB” (for DME) or “.CCB” (for ICP1) and 
click the [Open] button.
The “Firmware Update” dialog box will be displayed. The DMEs or ICPs in the current zone will 
be displayed in a list. The component names and versions will be displayed hierarchically for 
each DME.

3 Check the component you wish to update. 
You can click on the checkmark to turn it ON/OFF. The [Select All] button places a checkmark 
next to all the DMEs. The [Clear All] button turns OFF all the DME checkmarks. 

4 Check the component you wish to update, then click the [Update] button.
The component update will begin. 

When the DME update is finished, the DME unit will be automatically restarted. You also need to 
restart DME Designer. 

NOTE

While updating, be very careful not to disconnect the USB or Ethernet cable or turn off the power to the DME. 
The DME Designer MIDI setting information will be lost.
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Event Logger
When you click [Event Logger] in the [View] menu while online, the “Event Logger” window is 
displayed. This records and displays DME unit events. 
When the dialog box is opened while online, the event log is automatically obtained and displayed as 
a list in the Event Logger window. 
Events are displayed in realtime as long as the dialog box stays open while online. The information is 
also simultaneously recorded in a file if the log function is enabled. 

■ DME List

• [Date]
Displays the date the event occurred. (Example Display: 2004-08-24)

• [Time]
Displays the time the event occurred. 

• [Type]
Displays the event type and icon. 

There are three event types:

 (Warning): Warning event

 (Error): Error event

 (Information): Other events

• [Zone]
Displays the name of the zone in which the event occurred. 

• [DME]
Displays the name of the DME in which the event occurred. 

• [Event]
Displays the content of the event. 

NOTE

Only users for whom the [View Log Window] checkbox in the “Security” dialog box has been turned ON can display the 
Event Logger window. The default setting for this parameter is OFF.

NOTE

The events you wish to display in the Event Logger window must be set in advance in the “Event Log List” dialog box. 
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[Log Setup] Button
Displays the “Log Setup” dialog box. Here you can make Event Log settings. 

[Get Log] Button
When you are offline, this selects the DME from which the log will be taken. During online status, 
this button is grayed out and cannot be used. 
Clicking here displays the “Get Log” dialog box. 

[Zone]
Selects the zone for which events will be displayed. Only events from the selected zone will be 
displayed in the window. If [All Zones] is selected, events will be displayed for all DMEs arranged 
in the zone. 

Display button (Information/Warning/Error)

•  [Display Information] Button
Switches between displaying and hiding Information events. 
When turned ON, Information events are displayed in the Event Logger window. 

•  [Display Warning] Button
Switches between displaying and hiding Warning events. 
When turned ON, Warning events are displayed in the Event Logger window. 

•  [Display Error] Button
Switches between displaying and hiding Error events. 
When turned ON, Error events are displayed in the Event Logger window. 

[Clear Screen] Button
Clears (erases) events. 
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“Log Setup” dialog box 
Click the [Log Setup] button in the Event Logger window to display the “Log Setup” dialog box. Here 
you can make Event Log settings. These settings apply to the system as a whole. 

■ [Enable Logging]
Turns ON or OFF the function that writes the obtained event log data to a file. When a check is 
placed here, the event log is written to a file. 
When checked, it is set in the [Enable Logging] frame. 

Record __ days per log file 
Sets the number of days recorded into a single log file. When the specified number of days is 
exceeded, a new log file is created, and future log events are recorded there. 
When “1” is set for the number of days at 10:00 AM, information will be recorded in the same file 
until the next day at 9:59 AM. The number of days counted are cleared when the “Log Setup” 
dialog box is closed by clicking the [OK] button, or when the system goes online. 

Automatically delete log files after __ days 
When a check is placed here, log files exceeding the specified number of days are automatically 
deleted. Specifies the number of days after which log files are automatically deleted. 

Log file folder
Specify the folder for saving log files. Clicking the [Browse] button opens the standard operating 
system dialog box for specifying folders. Here you can select a folder. 
Log files are saved with the following file name: “LOG + Start_Date.txt”. 
If there is a file with the same name already in the specified folder, a number will be affixed to the 
end of the file name, and it will be saved as a separate file. (Example: LOG20040824-2.txt)

■ [Display Event]
Displays events with checks next to them. This operates together with the [Display Information], 
[Display Warning], and [Display Error] buttons in the Event Logger window. You can place checks 
next to multiple events. 

■ [Display Log Buffer Full Message]
When a check is placed here, “Log Buffer Full” messages will be displayed on the displays of all 
DME units in the zone. 

■ [Log List Setup] Button
Sets events sent from the DME units. Clicking here displays the “Event Log List” dialog box. 
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“Get Log” dialog box
Click the [Get Log] button in the Event Logger window to display the “Get Log” dialog box. 

■ DME List
Displays the IP addresses and types of DME units included in the zone. Click the DME from which 
to obtain events by placing a check next to it. 

■ [Output File Name]
Sets the file name and save location for the log file. Clicking the [Browse] button opens the file 
select dialog box, where you can select a file. 

■ [DME Log Clear]
Clears (erases) logs in the DME checked. When you click this button, a confirmation dialog is 
displayed.
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“Event Log List” Dialog Box
Sets events sent from the DME units. Sends events with checks next to them. 

■ [Zone]
If you click here, a list will be displayed. Specifies a zone. 

■ [DME]
If you click here, a list will be displayed. Specifies DMEs. 

■ [Event]
You can turn sending of logs for each event ON or OFF. 

■ [Type]
If you click here, a list will be displayed. Select type of event. 
[Information], [Warning], and [Error] are displayed in a list. 

■ [GPI OUT]
Sends GPI output for each event.
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Event Scheduler

“Event Scheduler” Dialog Box
When you click [Event Scheduler] in the [Tools] menu, the “Event Scheduler” dialog box is displayed. 
This sets the scheduling for events. You can schedule events by specifying the date, time, and the 
action to execute. You can set up schedules for events to be executed at a specified time, and events 
that are to be repeated periodically. Periodic events are those that repeat each year, month, week, or 
day. Up to 50 events can be scheduled. Scheduling can be set separately for each zone. Settings and 
changes are sent to the DME unit during online status. 
Scene changes, parameter changes, and GPI output can all be scheduled. 

■ Event View
Displays registered scheduling events. When periodic events (cyclical events) are first displayed 
together, they are displayed in order of date. 
The order of same-time events can be changed by dragging and dropping.
Click to select an event. 

■ [No.]
Displays the event number. Numbers are added from the top in order. 
This function will not be executed if the checkbox is not checked.

■ [Name]
Displays the event names. Clicking an event will select it, allowing you to change its name. There is 
no limit to the number of characters. 

■ [Operation] 
Displays the function that will be executed when the event starts. 

NOTE

Only users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON can edit scheduling settings.
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■ [Date]
Displays the event start date. 
Periodic events are displayed as shown below, with an icon and text that indicate a periodic event. 

• [January 1 every year]
Each New Year's Day

• [First Monday of January every year]
First Monday in January each year

• [Day 1 every month]
First day of each month

• [Second Monday of every month]
The second Monday of each month. 

• [Monday every week]
Each week on Monday

• [Every day]
Every day

■ [Time]
Displays the time for starting the event. 

■ [Enable Event Schedule]
Enables the scheduled events.

■ [Add] Button
Adds an event. Clicking here displays the “Add Event” dialog box. If the maximum of 50 events has 
already been registered, this button is grayed out. 

■ [Remove] Button
Deletes the event selected on the list. This button is grayed out when no event is selected. 

■ [Edit] Button
Lets you edit the selected event. Displays the “Edit Event” dialog box. This button is grayed out 
when no event is selected. 

■ [Copy] Button
Copies the selected event. This button is grayed out when no event is selected. 

■ [Paste] Button
Pastes the copied event. The event is added. This button is grayed out when no event has been 
copied. 
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[Add Event (Edit Event)] Dialog Box
The dialog box is displayed when you click on the [Add] or [Edit] button in the “Event Scheduler” 
dialog box. Here you can add or edit a scheduling event. 

■ [Event Name] Box
Enter the event name. There is no limit to the number of characters. 

■ [Event Operation]
Set the operation that is executed when the event starts. 

[Operation] 
When you click this button, a list of events is displayed. Specify the operation that is executed 
when the event starts. 
The following three items are on the list:

• [Scene Change]
Changes the scene.

• [Parameter Value Edit]
Changes a parameter. 

• [GPI Out]
Sends GPI output. 

• [Play Wav File]
Allows initiation of Wave file playback. 
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[Operation Setting]
The content changes according to the event selected for [Operation]. 

• When [Scene Change] is selected:

Select the scene to be recalled from the [Scene] list. Stored scenes are displayed in the list. 

• When [Parameter Value Edit] is selected:

[Scene]
Select a scene from the list. 
If the DME unit's current scene differs from the scene specified in event scheduling, the scheduled 
scene will be recalled. If the DME unit's current scene is the same as the scene specified in event 
scheduling, the scheduled scene will not be recalled. 

[DME Unit]
From the list, select the DME unit to which this scheduled event will apply. The DMEs included in the 
zone are displayed in the list. 

[Component]
Select the component that has the parameter to be changed. The list displays the components 
arranged for the DME that is selected in the [DME Unit] box. 

[Parameter]
Select the parameter that will change. Parameters for the component that is selected in the 
[Component] box are displayed in a list. 

[Value]
Set a value for the parameter. Change the parameter using the spin buttons or the slider on the right. 
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• When [GPI Out] is selected:

[DME]
From the list, select the DME that will produce the GPI output. 

[Ch1]/[Ch2]/[Ch3] ...
Set [ON], [OFF], or [---] for each channel. If it is set to [OFF], the [LOW→HIGH] channel outputs 
[HIGH→LOW] signal, the [HIGH→LOW] channel outputs [LOW→HIGH] signal. 

• When [Play Wav File] is selected:

[Scene]
Select a scene from the list.

[Wave]
Select a Wave file from the list.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a Wav 
Player is included in the DME configuration.
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■ [Event Schedule]
Set the year/month/date to start the event. 

Calendar
Sets the date the event will start. 
Change the year and month using the [<] and [>] buttons. Click on a day to set that date. February 
29 can be set on the calendar, where it appears every four years (each leap year). 

[Time]
Sets the time the event will start. 
Click the hour and minute, then set numerical values using the spin boxes. 
Only the time is set for periodic events. 

[Repeating Event]
When a check is placed here, the event becomes a periodic event, and the calendar is ignored. 

• [Year]/[Month]/[Week]/[Day]/[Hour]
Set the period for the event, using the radio buttons to the left. 

• [Day]/[Day of the week]
Set the conditions on the right side. Select [Day]/[Day of the week], and set the date and other 
information. The items that can be set vary according to the selected period. 

When the event period is [Year]
All settings can be made. 

When the event period is [Month]
If [Day] is selected, only the date can be set. 
If [Day Of The Week] is selected, the week of the month and day of the week is set. 

When the event period is [Week]
Only [Day Of The Week] can be selected. Set the day of the week. 

When the event period is [Day]/[Hour]
Condition settings on the area on the right are not needed. 

[Exception] Button
Opens the “Event Exceptions” dialog.
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■ [Event Exceptions]
Specifies “exception” year/month/day and time settings at which events will not be executed.

The available settings will depend on the event cycle.

• When the event cycle is [Year]
Only the [Year] setting is available.

• When the event cycle is [Month]
Only the [Month] and [Week] setting is available.

• When the event cycle is [Week]
Only the [Month], [Week] and [Day] settings are available.

• When the event cycle is [Day]
Only the [Month], [Week], [Day], and [Day of the week] settings are available.

• When the event cycle is [Hour]
Only the [Month], [Week], [Day], [Day of the week], and [Hour] settings are available.
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Remote Control Setup List
Registers the parameters to be controlled from an external controller. Refer to the “DME-N Remote 
Control Protocol Specifications” document for details about the communication protocol. Information 
about the “DME-N Remote Control Protocol Specifications” document can be found at the Yamaha pro 
Audio website (URL below).
http://www.yamahaproaudio.com/

[DME]
Click to see a list and select a DME.

[Function]
Select [No Assign], [Parameter Value Edit] or [Level Meter].

[Parameter]
Specifies the parameter to be controlled. A list of parameters will be displayed according to the 
selection of [Function].

[Min]/[Max]
Displays the minimum and maximum values for the parameter.

[Type]
Selects a fader curve when level, etc., is select for [Parameter].
Select [dB] to directly control the level in dB, or [Curve Table] to use one of the DME fader curves 
for level adjustment.
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Parameter List
When you click [Parameter List] in the [Tools] menu, the “Parameter List” dialog box is displayed. A list 
of parameters in the current configuration of the current zone are displayed. Here you can check 
things like the parameter IDs. You can also print the list of parameters. 
When the dialog box is opened or when a DME is selected from the [DME] list, the parameter values 
are displayed. 

■ [DME]
From the list, select the DME that will have its parameters displayed. The DMEs included in the 
current configuration are displayed in the list. Components in the selected DME are displayed in 
the component list. 

Component List
The components and user modules included in the DME, their IDs, and the component parameters
are displayed in hierarchal list. The AD and slot are also displayed.

[ID]
Displays the component or parameter ID. 
The following is displayed for the parameter ID: “Element No. : X : Y : Parameter No. : Index No.” 

[Value]
Displays the value for the parameter. 

NOTE

Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the 
components are not displayed. However, parameters displayed in the user module editor are displayed here.
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[Min]/[Max]
Displays the minimum and maximum values for the parameter. 

■ [Preview] Button
Prints a list of parameters. When you click this button a preview screen is displayed. 

■ [Save] Button
Saves the parameter list as a CSV file. When you click this button, the standard operating system 
save dialog box is displayed. 

■ [Cancel] Button
Closes the dialog box without changing the settings. 

Printing a List of Parameters
Prints all parameters for the component selected in the list, all parameters for the selected DME, or all 
parameters for all DMEs. 
When you click the [Preview] button, the dialog box display will change, and the print preview will be 
displayed in the center. Buttons will be added to the upper part of the dialog box. 

■ [Print] Button
Prints a list of parameters. Clicking here displays the “Print” dialog box. When you click the [Print] 
button, printing begins. 

NOTE

The displayed parameter values are those that were in effect when the dialog box was opened or when the displayed 
DME was selected from the [DME] list. They cannot be changed here.

NOTE

The CSV format is a comma delimited text file that can be read by many types of software, such as word processor, 
spreadsheet, or database programs.

NOTE

The displayed [Print] dialog box will vary according to the connected printer. 
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■ [Setup] Button
Clicking here displays the “Print Setup” dialog box. 
Here you can set the paper size, paper orientation, and font. 

[Paper Size]
Select the paper size from the list. 

[Orientation]
Set the orientation of the paper by clicking one of the radio buttons. 

• [Portrait]
Prints on the paper with it oriented vertically. 

• [Landscape]
Prints on the paper with it orientated horizontally. 

[Font]
Displays the set font. Clicking the [Font] button displays the “Font” dialog box, where you can 
change the font. 

[Target]
Set the parameters to be printed by clicking one of the radio buttons. 

• [Selected Component]
Prints all parameters for the component selected in the list. 

•  [Selected DME]
Prints all parameters for the selected DME. 

•  [All DME]
Prints all parameters for all DMEs. 

[Close] Button
Ends the preview and returns the screen to the original dialog box. 

[Prev] Button/[Next] Button
Switches the page being previewed when there are multiple pages. The [Prev] button goes to the 
previous page. The [Next] button goes to the next page. 
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Component Lock
Click [Component Lock] in the [Tools] menu to display the Component Lock dialog.

The component/user module names included in the DME will be displayed. AD and Slot will also be 
displayed.
Components can be locked so that parameter changes cannot be made from an external device by 
checking the checkbox to the left of the component name. The lock settings will be transferred to the 
DME when the unit is placed on-line. The settings can only be changed while off-line.

■ [Select All] Button
Checks all component checkboxes.

■ [Clear All] Button
Clears all component checkboxes.

■ [OK] Button
Enters the settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without entering the settings.

NOTE

The hierarchy of user components in user modules will be displayed, but if user module security is enabled the components 
will not be displayed. Components displayed by the User Module Editor will be displayed.

NOTE

Only users who's [Edit] box is checked can edit the lock status.
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Wav File Manager
When you click [Wav File Manager] on the [Tools] menu, the “Wav File Manager” dialog box is 
displayed. Here you can manage playback settings for Wave files played in the Wav File Player. This is 
set for each DME. The setting can be made only when in offline status. Up to 100 Wave files can be 
managed. 
Up to a maximum of 12 megabytes of Wave files can be registered for each DME unit. If a Wave file is 
added that will exceed this amount, a warning message will be displayed. 

■ [DME]
From the list, select the DME you want to set. The DMEs included in the current zone are displayed 
in the list. 

■ [Wave File]
Displays the Wave file information. Settings can be made here as well. 

[No.]
The Wave file number is displayed in the leftmost column. Numbers are added from the top in 
order. 

[List Name]
You can set up to 27 characters as a label separate from the Wave file name. The Wave file name is 
displayed here by default. 

[File Name]
Up to 31 characters are displayed as the wave file name. If you double-click the name, the file 
selection dialog is displayed, where you can select a file. 

NOTE

These settings can be edited only by users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON.

NOTE

Only Wave files with file names of 31 characters or less, (including the extension) can be registered. Check the Wave file 
name beforehand. Change the name if it has 32 or more characters, including the extension. 

NOTE

When saving project files including Wave files, select “Project File with wave (*.daf)” in the file save dialog box.
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[Size]
Displays Wave file size information. The units vary, depending on the file size. The size is displayed 
to the first decimal.

 

[Repeats]
Sets the number of repeats for playback. 
Clicking here will display a list where you can select the number of times. 
Select [0] to [98] or [INFINITY]. 
Since external input cannot be edited, [---] is displayed. 

[Interval]
Sets the time until the next playback when [Repeats] is one or more. If you click here, a list will be 
displayed. You can set [0] to [99]. 
Since external input cannot be edited, [---] is displayed. 

[Auto Start]
Turns automatic playback ON or OFF. If ON is set, playback happens automatically when the file is 
selected. 
If you click here, a list will be displayed. Select [ON] or [OFF]. 

[Next No.]
Specifies the number for the Wave file to be played next. 
If you click here, a list will be displayed. Select the number for the Wave file to be played next. 

• [Stop]
This stops playback after this Wave file is finished playing, without specifying the next wave 
file. 
Since external input cannot be edited, [---] is displayed. 

■ [Store] Button
Saves the current settings in the “Wav File Manager” dialog box in a file, as a library. Clicking here 
displays the file save dialog box. 

■ [Recall] Button
Reads a saved library. 
Clicking this button displays a menu. A menu displays library files saved in the folder that has been 
set as the Contents Folder. Click the library to be read. 

[Open File Dialog]
Displays the file select dialog box. You can select a library file that is saved in the folder set as the 
Contents Folder, and read it. 

Size Display

Up to 1023 bytes 0.X KB

1024 bytes to 1023.9 kilobytes XXX.X KB

1024 kilobytes or more X.X MB
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■ [Add] Button
When you click here, External Input and the file select list is displayed. 

[Wave File]
The file selection dialog box is displayed, where you can select a Wave file. 
If the selected table already has data, an overwrite confirmation dialog box is displayed. 

[External Input]
Sets [External Input]. 

You can select multiple Wave files. If multiple files are specified, they are added after the selected 
table. If a Wave file is registered to the number being added, it will be overwritten. 
The following Wave file formats are supported: 48, 44.1, 24, 22.05 kHz, 16bit/8bit, Mono/Stereo. If a 
file is selected with a format different than these, a message is displayed that says the file cannot 
be used. 

There is an upper limit to size beyond which a file cannot be used. This limit varies according to the 
format. If the size of the selected file is beyond the limit, a message is displayed that says the file 
cannot be used.

 

■ [Remove] Button
Deletes settings from the selected line. This button is grayed out when no Wave file is selected in 
the list. 

■ [Up] Button
Moves the selected line up one. It is switched with the line immediately above. 
The button will be grayed out if nothing is selected in the list, or if [No. 1] is selected in the list. 

■ [Down] Button
Moves the selected line down one. It is switched with the line immediately below. 
The button will be grayed out if nothing is selected in the list, or if [No. 100] is selected in the list. 

■ [Play] Button
Plays the selected Wave file on the computer. Allows monitoring and checking of the Wave file. 

■ [Stop] Button
Stops playback of the Wave file. 

■ [Remaining Memory]
Displays the remaining size that can be added. 

22.05 K Mono 8 bit 1.37 MB 44.1 K Mono 8 bit 2.75 MB

22.05 K Stereo 8 bit 2.75 MB 44.1 K Stereo 8 bit 5.5 MB

22.05 K Mono 16 bit 2.75 MB 44.1 K Mono 16 bit 5.5 MB

22.05 K Stereo 16 bit 5.5 MB 44.1 K Stereo 16 bit 5.9 MB

24.05 K Mono 8 bit 1.5 MB 48 K Mono 8 bit 3 MB

24 K Stereo 8 bit 3 MB 48 K Stereo 8 bit 5.9 MB

24 K Mono 16 bit 3 MB 48 K Mono 16 bit 5.9 MB

24 K Stereo 16 bit 5.9 MB 48 K Stereo 16 bit 5.9 MB
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■ [OK] Button
Updates the settings and closes the dialog box. 

■ [Cancel] Button
Closes the dialog box without changing the settings. 

Adding Wave Files
To add a Wave file, select the line where you want to add the file, then click the [Add] button. You can 
also add a Wave file by dragging and dropping it from the desktop to the “Wav File Manager” dialog 
box list. 
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DAW Control
When you click [DAW Control] on the [Tools] menu, the “DAW Control” dialog box is displayed. Here 
you can make settings for when the DME is controlled from a DAW controller. This is set for each zone 
configuration. The setting can be made only when in offline status. 

■ [DME]
From the list, select the DME you want to set. The DMEs included in the current zone are displayed in 
the list. 

■ [DAW Type]
Select the DAW type. The following choices are in the list: [Off], [Type1], and [Type2]. 

■ DAW Control Table
The following can be set for each channel from 1 to 64: [Function], [Controller], [Label], [Parameter]. 

[Function]
Selects the function that will be changed by the DAW controller. If you click here, a list will be 
displayed. 

NOTE

DAW control editing can be performed only by users for whom the [Edit] security checkbox has been checked.
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• [No Assign]
Makes no assignments. Select this when you are erasing an already set assignment. 

• [Parameter Value Edit]
Allows the parameter of the component specified in the [Parameter] field to be changed.

• [Scene Change]
Recalls a scene. The scene is recalled even if the current scene, and the one changed by the 
DAW controller, are the same. 
When a selection has been made, [SCENE] is displayed in the [Label] field. The last scene is 
set in the [Parameter] field. 

• [Scene Increment]
Sets the scene increment. Recalls the next valid scene after the current scene. 
When a selection has been made, [SINC] is displayed in the [Label] field. 

• [Scene Decrement]
Selects the scene decrement. Recalls the next valid scene before the current scene. 
When a selection has been made, [SDEC] is displayed in the [Label] field. 

• [Mute]
Sets all mute. Mute is set ON and OFF by the DAW controller. 
When a selection has been made, [MUTE] is displayed in the [Label] field. 

• [Component]
Changes the component parameters. Selectable component names that are arranged in the 
configuration are displayed in a list. 
When selected, the first parameter included in the component is set in the [Parameter] field. 

• [GPI Lock]
Assigns GPI Lock. GPI Lock is set ON and OFF by the DAW controller. 
When a selection has been made, [LOCK] is displayed in the [Label] field. 

• [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a 
Wav Player is included in the DME configuration.

[Controller]
Selects a controller from the list when [Parameter Value Edit] is set in [Function]. [Switch], 
[Fader], or [Knob] can be selected. 

[Label] 
Enter a label. Double-click to enter the text. You can enter up to 16 characters of text. Set the value 
with the <Enter> key, or cancel it with the <ESC> key. 

[Parameter]
If [Scene Change] , [Parameter Value Edit] or [Play Wav File], is set in [Function], set the 
parameters. 
If you click here, a list will be displayed. 

• When [Scene Change] is set in [Function] 
Displays scenes that can be selected. 

• When [Parameter Value Edit] is set in [Function] 
Selectable parameters are displayed. 

• When [Play Wav File] is set in [Function]
Selectable Wave files are displayed.

NOTE

If [Scene Change], [Scene Increment], [Scene Decrement], [Mute], or [GPI Lock] is selected for [Function], the label 
name is fixed.
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Shortcut Keys
Click [Shortcut Keys] in the [Tools] menu to display the “Shortcut Keys” dialog.

Click to select the desired shortcut item.

■ [Enter New Key]
If assigned, the current shortcut will be displayed.
A shortcut entered via the computer keyboard will be displayed.

■ [OK] Button
Enters the settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without entering the settings.
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Backup
When you click the [Backup] command on the [Tools] menu, the “Backup” dialog box is displayed. 
Data in the DME is gathered in the computer and saved as a file. Backup files are created for each 
DME. You can also send the information saved in a file to a DME. Backup can be performed only when 
in offline status. 

■ [Target DME]
Displays DME, IP addresses, and DME types for each zone. Check the DME from which you want 
to obtain data. You can place checks next to multiple DMEs. 

■ [Folder] Box
Specifies the folder that will be the destination for saving and reading operations. Clicking the 
[Browse] button opens the folder select dialog box, where you can specify a folder. 
The backup file name will be the DME’s IP address. If the folder is specified when sending DME 
data, the file sent to the DME will be the file in the folder whose file name that matches the DME’s IP 
address. 

■ [Load] Button
Sends the backed up file to the specified DME. 

■ [Save] Button
Obtains data from the specified DME, and saves it as a backup file. 

■ [Close] Button
Closes the dialog box. 

NOTE

Backup operations can be performed only by users for whom the [Edit] security checkbox has been checked.
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Editing Configurations

Configurations
Information about inputs/outputs, along with the arrangement of components and how they are 
connected, is called a “configuration.” Configurations are created in the Designer window and sent 
to the DME unit. 
In the Designer window, configurations are designed using various design windows, such as the Area, 
Zone, Configuration, and User Module windows. In each window a sheet is displayed, on which 
objects can be arranged. 

New Configurations
You can create multiple zones within an area, and multiple configurations within a zone. 
Zones are added using the “Zone” dialog box, while configurations are added using the 
“Configuration” dialog box. For information about the “Zone” dialog box, see “Adding, Deleting, and 
Renaming a Zone” on page 231. For information about the “Configuration” dialog box, see “Adding, 
Deleting, and Renaming a Configuration” on page 233.

Security 
Editing in the Designer window can be restricted based on the user security settings. Only users for 
whom the [Operation Security] → [Edit] checkbox in the “Security” dialog box has been checked can 
display the Designer window and edit configurations. 
For information about the “Security” dialog box, see “Security (Creating Users and Making User 
Settings)” on page 55.

Edit Mode
There is an “Edit Mode” in the Designer window. When the Edit Mode is ON, configurations can be 
edited. When it is turned OFF, the DME is controlled by DME Designer. 

■ Edit Mode=ON
When Edit Mode is ON, you can do configuration editing tasks such as arranging objects, making 
connections, and changing properties.

■ Edit Mode=OFF
When Edit Mode is OFF, you cannot arrange objects, make selections, or display “Properties” 
dialog boxes for objects. You can display the component editor.

■ Edit Mode ON/OFF
The edit mode can be turned on or off via the [Edit Mode] command in the [Tools] menu or in the 
contextual menu that appears when you right-click the sheet. To turn Edit Mode ON click the 
command, placing a checkmark to the left of the command name. When there is a checkmark next 
to the command (when Edit Mode is ON), clicking the command again removes the checkmark 
and turns OFF the Edit Mode. 

NOTE

Only users for whom the [Operation Security] → [Edit] checkbox in the “Security” dialog box has been checked can turn 
the Edit Mode ON.
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Designer Window
You can display or hide the Designer window using the [Designer] command on the [View] menu in 
the Main Panel window. 

Title Bar
“Designer” is displayed on the title bar. You can move the window by dragging the title bar. There are 
[Minimize], [Maximize]/[Restore], and [Close] buttons at the right edge of the title bar. 

Menu Bar
Commands that can be executed in the application are collected into categories on the menu bar. 
When you click one of the categories, a list of commands is displayed. 

Title Bar
Menu Bar

Toolbar

Toolkit Window

Design 
Window

Navigator Window

Resource Meter 
Window

Status Bar
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Toolbar
Frequently used commands are arranged here as buttons. 

■ [Print] Button
Prints the active design window.
→ “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 214)

■ [Undo] Button (page 145)
Undoes the most recent edit operation.

■ [Redo] Button (page 145)
Restores operations undone with the [Undo] button back to their original condition.

■ [Cut] Button (page 145)
Cuts the selected object from the screen and moves it to the clipboard.

■ [Copy] Button (page 145)
Copies the selected object to the clipboard.

■ [Paste] Button (page 145)
Pastes data from the clipboard.

■ [Navigator] Button (page 140)
Displays or hides the Navigator window.

■ [Resource Meter] Button (page 139)
Displays or hides the Resource Meter window.

■ [Analyze] Button
Displays the “Analyze” dialog box, and analyzes the configuration.
→ "Analyze (Configuration Analysis)" in "Configuration Window" (page 249) 

■ [Show Signal Delay] Button
The digital signal delay value is displayed in the Configuration window. 
→ "Show Signal Delay (Delay Display Value)" in "Configuration Window" (page 246) 

■ [Probe Monitor] Button
Turns the probe monitor ON or OFF. 
→ “Probe Monitor” in “Configuration Window” (page 244)

[Print] Button

[Undo] Button

[Redo] Button

[Cut] Button

[Copy] Button

[Paste] Button

[Navigator] Button

[Resource Meter] Button

[Zoom Out] Button

[Zoom In] Button

[Actual Size] Button

[Zoom To] Button

[Show Signal Delay] 
button

[Analyze] button

[Probe Monitor] Button
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■ [Zoom Out]/[Zoom In]/[Actual Size]/[Zoom To] Buttons
These buttons correspond to the commands on the [View] menu with the same names. Changes 
the magnification of the display on the screen. 
→ “[View] Menu” in “Designer Window Menus” (page 147)

Status Bar

■ DME ID/Component ID
When the mouse pointer is moved over a DME device in the Zone window, the ID for that DME 
device is displayed. When the mouse pointer is moved over a component in the Configuration 
window, the ID for the component is displayed. 

■ Sheet size
Displays the size of the sheet in the active design window. 

■ Coordinates
Displays the coordinates of the mouse pointer any time it is within the design window. When 
dragging an object, the coordinates displayed here refer to the upper left corner of the object 
being dragged. 

Resource Meter Window
The Resource Meter window is displayed only when the Configuration window and User Module 
window are active. Meters for the DSP memory usage percentage and the SPX resource usage 
percentage are in the Resource Meter window. 

■ DSP Memory Usage Percentage
When you are designing in the Configuration window, it gives you a yardstick for judging the total 
usage percentage for DSP memory in the DME unit. You cannot create a design that exceeds 100 
percent usage in a single configuration window. In addition, the usage percentage varies 
depending on the sampling frequency, even for the same component. 
When the configuration is synchronized with the DME unit during online status, checks of 
connections and component information begin automatically (this is called compiling). The actual 
total usage percentage is calculated after this compiling operation. The usage percentage will vary 
according to the number of connections and components. The Resource Meter window gives you 
a precompile guideline for use while designing your configuration. An error may occur even when 
the meter shows less than 100 percent, based on conditions such as the number of connections, 
and type and number of components used. 

NOTE

If a configuration is compiled at fs=44.1kHz or 48kHz, and the sampling frequency is then changed to 88.2kHz or 96kHz, it is 
necessary to recompile at 88.2kHz or 96kHz. If this is not done some configurations may produce no sound. In such cases a 
“DSP Power Shortage” message will be displayed on the DME unit.

Sheet Size CoordinatesDME ID/Component ID
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■ SPX Resource Usage Ratio
Displays the resource usage ratio for SPX components arranged in the configuration. 

Navigator Window
Gives a hierarchical display of the area, zones, and configurations, along with the DME devices, user 
modules and components arranged within the configurations. This allows you to check the overall 
status of your setup.
When doing offline editing, you can click the icon or name for an area, zone, configuration, DME 
device, user module, or component to make each design window active.

■ [+]/[-]
The subordinate items are displayed or hidden using the [+]/[-] buttons to the left of the area, 
zones, configurations, user modules, or DME devices. When the subordinate items are displayed, 
the button changes to [-]. If you click this button, the subordinate items will be hidden. When the 
subordinate items are hidden, the button changes to [+]. If you click this button, the subordinate 
items will be displayed. 
Subordinate items are also displayed and the button changes to [-] when you click on an area, 
zone, configuration, user module, or DME device.

NOTE

If the [Matrix Mixer 64 input 64 output] or the [Matrix Mixer 64 input 32 output] components are placed in the DME64N 
configuration window, you will not be able to use other components, even though the window does not reach 100 percent. 
The [Matrix Mixer 64 input 64 output] or [Matrix Mixer 64 input 32 output] components cannot be used in the DME24N. 

NOTE

For user modules with security enabled, a password is requested when displaying the hierarchical display shown below. 

Area
Zones

Configuration

DME Devices

User Module

Components included
in the User Module

Components
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■ Area
If you click the area while doing offline editing, the Area window becomes active.

■ Zone
If you click a zone while doing offline editing, the Zone window becomes active. If another Zone 
window is open, it will be closed.

■ Configuration
If you click a configuration while doing offline editing, the Zone window for the clicked configuration 
becomes active. If another Zone window is open, it will be closed.

■ DME Device
If you click a DME, a Configuration window will be opened for that unit. If that window is already 
open, it will be displayed on top of any other windows. 

■ Component
Click a component and the component editor will open. 

■ User Module
The window specified by “User Module Properties [Double Click Action]” will open when clicked.

■ Components Included in the User Module
Click a component in the user module and the component editor will be displayed.

NOTE

When there are multiple configurations in a zone, click a configuration to switch configurations, not the zone.
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Four Design Windows
The following design windows are available: the Area window, Zone window, Configuration window, 
and User Module window. In each window there is a single sheet on which objects can be arranged. 
Within the Designer window, you can simultaneously open and edit in the Area window, Zone Window, 
Configuration window, and User Module window. 

■ Area Window
Used to design areas. 
→ See “Area Window” on page 235.

■ Zone Window
Used to design zone configurations. 
→ See “Zone Window” on page 237.

■ Configuration Window
Used to design configurations for DME units arranged in a zone. 
→ See “Configuration Window” on page 242. 

■ User Module Window
Used to design user modules configurations. A module that combines a number of other 
components, yet is treated as a single component, is called a “user module.” It is arranged in the 
Configuration window.
→ See “User Module Window” on page 257.

Configuration Structure and Four Design Windows

Area Window

Zone Window

Configuration Window

User Module Window

Component Editor
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Toolkit Window
The Toolkit displays objects that can be arranged in each design window. The displayed contents vary 
according to which window is active. 
→ See “Toolkit Window” on page 152.

Displayed in the designer 
window

Floating-style
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Designer Window Menu

[Print] Menu
This menu provides commands for exporting configurations and printing windows.

■ [Export DXF]
Exports the information in the active window and saves it as a DXF file, which is compatible with 
CAD software sold by other companies. 
→ “Exporting the Design Window” in “Design Window Shared Settings and Operations” (page 211)

■ [Print Setup]
When you select this command, the “Print Setup” dialog box will be displayed. Sets the paper size 
and orientation. 
→ “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 214)

■ [Print Preview]
Displays a print preview of the active design window.
→ “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 214)

■ [Print]
Prints the active window. When you select this command, the “Print” dialog box will be displayed.
→ “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 214)

■ [Preferences]
Displays the “Preferences” dialog box. Sets the line thickness and the design window edit 
operations. 
→ “Preferences” in “Design Window Shared Settings and Operations” (page 207)
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[Edit] Menu
This menu provides edit commands.

■ [Undo]
Undoes the most recent edit operation. Repeatedly clicking this button will delete multiple 
operations. When [Undo] is not possible, the command will be grayed out.

■ [Redo]
Returns to the status before the [Undo] command was executed. If you repeatedly click this button, 
it will redo multiple operations. If redo is not possible, the command will be grayed out. 

■ [Cut] 
Cuts the selected object. Moves the selected object to the clipboard.

■ [Copy]
Copies the selected object to the clipboard. The selected object remains as is.

■ [Paste]
This command pastes the object on the clipboard into the active window. If there is no data on the 
clipboard or if the object on the clipboard is not a type that can be pasted into the active window, 
this command cannot be used. 

■ [Delete]
Deletes the selected object. The data on the clipboard does not change.

■ [Select All]
Selects all objects in the active design window.

■ [Duplicate]
Duplicates the selected object. The data on the clipboard does not change. 

NOTE

There are some objects that cannot be deleted with the [Delete] command.
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■ [Display Order]
Changes the display order (in front or behind) of the selected objects.
→ “Changing the Order” in “Design Window Shared Settings and Operations” (page 218)

■ [Edit Legend]
This command can be selected when an Area window, Zone window, or Configuration window is 
active. It lets you edit the descriptive text (legend) displayed on the sheet in the Area window, Zone 
window, or Configuration window. When this command is selected, the “Edit Legend” dialog box 
will be displayed.
→ “Legend (Descriptive Fields)” in “Objects” (page 198)

■ [Properties]
Opens the “Properties” dialog box for the selected objects.
→ See “Object Types” on page 156.
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[View] Menu
Displays or hides the windows.

■ [Toolbar]
Displays or hides the toolbar. A checkmark appears beside this menu item when the toolbar is 
displayed.

■ [Status Bar]
Displays or hides the status bar. A checkmark appears beside this menu item when the status bar 
is displayed.

■ [Area]/[Toolkit]/[Resource Meter]/[Navigator]
Displays or hides the Area window, Toolkit, Resource Meter, or Navigator window. A checkmark 
appears to the left of the command name when a window is displayed. 
The Resource Meter window is displayed only when the Configuration window and User Module 
window are active. 

■ [Full Screen]
Displays in full-screen mode. Displays the active design window (Area, Zone, Configuration, or 
User Module window) exclusively, with it covering the entire screen.

A context menu appears wherever you right-click on the screen, containing the commands that are 
needed at that location. 
To return from the full-screen mode to the original display status, press the <Esc> key. 
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■ [Port Long Name]
Switches the port name display. When you select this command, a checkmark appears next to it 
and long names are displayed. If you select this command when a checkmark is next to it, the 
checkmark disappears and short names are displayed. 

■ [Zoom In]
Gives a closer view of an area displayed on the screen. 

■ [Zoom Out]
Widens the area displayed on the screen. 

■ [Zoom To]
Selects the display magnification from a submenu. 

■ [Actual Size]
Returns the display to normal dimensions.

■ [Fit in Window]
Increases or decreases the display magnification so that the sheet exactly fits the current window. 
The entire sheet will be visible.

Long name

Short name
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[Tools] Menu

■ [Area Parts List]
This command can be used only when the Area window is active. A submenu displays the same 
objects that are in the Toolkit window displayed while the Area window is active. Clicking an object 
on the submenu, then clicking the Area window, places that object in the Area window. 
→ [Area Parts List] in “Toolkit Window” (page 153)

■ [Device List]
This command can be used only when the Zone window is active. A submenu here displays the 
same objects as the Toolkit window. Clicking an object on the submenu, then clicking the Zone 
window, places that object in the Zone window. 
→ [Zone Device List] in “Toolkit Window” (page 154)

■ [Component List]
This command can be used only when a Configuration window or User Module window is active. 
A submenu here displays the same objects as the Toolkit window. Clicking an object on the 
submenu, then clicking the Configuration/User Module window, places the object in that window. 
→ “Component List (Configuration Window)” in “Toolkit Window” (page 154), “Component List 
(User Module Window)” in “Toolkit Window” (page 155)

■ [Zone]
Displays the “Zone” dialog box. Here you can add, delete, or rename a zone.
→ See “Adding, Deleting, and Renaming a Zone” on page 231.

■ [Configuration]
Displays the “Configuration” dialog box. Here you can add, delete, or rename a configuration.
→ See “Adding, Deleting, and Renaming a Configuration” on page 233.

■ [Save User Module] 
This command can be used only when a User Module is selected in the Configuration window. 
Saves the selected user module. 
→ “User Module Manager” Dialog Box in “User Modules” (page 255)
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■ [User Module Manager]
Displays the “User Module Manager” dialog box. Here you rename or delete user modules. 
→ “User Module Manager” Dialog Box in “User Modules” (page 250)

■ [Show Signal Delay]
The digital signal delay value is displayed in the configuration window with sample units. 
→ "Show Signal Delay (Delay Display Value)" in "Configuration Window" (page 246)

■ [Analyze]
Displays the “Analyze” dialog box, and analyzes the configuration. 
→ "Analyze (Configuration Analysis)" in "Configuration Window" (page 249)

■ [Probe Monitor]
Turns the probe monitor ON or OFF. This command can be selected only when a Configuration 
window or User Module window is active while in online status.
→ “Probe Monitor” in “Configuration Window” (page 244)

■ [Monitoring Point List]
Opens the “Monitoring Point List” dialog box. Registers points for monitoring with headphones. 
→ "Monitoring Point List" in "Configuration Window" (page 247)

■ [Edit Mode]
Turns the edit mode ON or OFF. 
→ “Edit Mode” in “Editing Configurations” (page 136)

■ [Sheet]
Opens the “Sheet” dialog box. Sets the sheet size and background.
→ “Sheet” in “Objects” (page 200)

■ [Prohibit Diagonal Connections]
Allows you to draw horizontal and vertical wires only. Diagonal wires cannot be drawn. 
→ “Drawing Settings” in “Drawing and Editing Wires” (page 223)

■ [Grid]
Opens the “Grid” dialog box. Displays or hides the grid and sets the grid spacing. 
→ “Grid” in “Design Window Shared Settings and Operations” (page 210)

NOTE

Only users for whom the [Operation Security] → [Edit] checkbox in the “Security” dialog box has been checked can 
select this command. 
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[Window] Menu
Arranges multiple windows. The lower part of the menu displays the names of currently open 
windows. A checkmark appears next to the active window. When you click the name of a window, that 
window becomes active.

■ [Cascade]
Displays the windows overlapping one another. 

■ [Tile]
Displays the windows arranged side-by-side. 
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Toolkit Window

Displaying the Toolkit Window
You can display or hide the Toolkit window using the [Toolkit] command on the [View] menu. The 
Toolkit displays objects that can be arranged in each design window. You can arrange objects in each 
design window by dragging them from the Toolkit window or by double-clicking them in the Toolkit 
window. 
The objects are categorized by type and displayed here in a hierarchy. You can use the [+]/[-] buttons 
to display or hide items below a particular level in the window. Click the [+] button to display the items 
on the next level down, and the [-] button to hide them.

Moving the Toolkit Window
You can move the Toolkit window by dragging it. If you drag the window to right or left side, it will 
remain fixed. If you drag it to other locations, it will float independently. When DME Designer is started, 
the Toolkit window is displayed at the left side of the Designer window. 
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Toolkit Window Types
The contents of the Toolkit window will vary, depending on which window is active. 

The following objects are displayed in each window:

[Area Parts List]
The [Area Parts List] displays objects that can be arranged in the Area window. The same objects are 
displayed in the [Area Parts List] submenu on the [Tools] menu or on the context menu that appears 
when you right-click on the sheet. 

Active Design Window Toolkit Window

Area Window Area Parts List

Zone Window Device List

Configuration Window Component List

User Module Window Component List

Area Parts List Device List
Component List 
(Configuration 

Window)

Component List 
(User Module 

Window)

DME ✔

ICP ✔

External Device ✔ ✔

Component ✔ ✔

SPX Component ✔ ✔

User Module ✔

Pictures ✔ ✔ ✔ ✔

Text ✔ ✔ ✔ ✔

Boxes ✔ ✔ ✔ ✔

Ellipses ✔ ✔ ✔ ✔

NOTE

You can create multiple zones in an area. They are added using the menu bar [Tool] menu → “Zone” dialog box.
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[Device List]
The Device list displays objects that can be arranged in a Zone window (configuration). The same 
objects are displayed in the [Device List] submenu on the [Tools] menu or on the context menu that 
appears when you right-click on the sheet. 

[Component List] (Configuration Window)
The Component List displays objects that can be arranged in Configuration windows. The same 
objects are displayed in the [Component List] submenu on the [Tools] menu or on the context menu 
that appears when you right-click on the sheet. 

NOTE

Configurations are added using the menu bar [Tool] menu → “Configuration” dialog box.

[Tools] menu

Toolkit window [Device List] submenu on the [Tools] menu or 
on the context menu

Toolkit window
[Tools] menu

[Component List] submenu 
on the [Tools] menu 

or on the context menu
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[Component List] (User Module Window)
The Component List displays objects that can be arranged in the User Module window. The same 
objects are displayed in the [Component List] submenu on the [Tools] menu or on the context menu 
that appears when you right-click on the sheet. 

Toolkit window
[Tools] menu

[Component List] submenu 
on the [Tools] menu 

or on the context menu
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Objects

Object Types
The devices, shapes, and wires that can be arranged in each design window are called “Objects.” 
The following objects are available:

Various design elements, such as name, color and size, can be set in the “Properties” dialog box for 
each object. 
Size is set using the [Width] and [Height] boxes in the “Properties” dialog box. The maximum size 
values that can be set may vary according to the sheet size and object position. You can set a size 
that allows the object to fit in the sheet. 

Name
Window Where It can be 

Placed/Displayed
Explanation

Zone Area Zones

DME Zones DME and any cards inserted into its slots

ICP Zones User defined parameter control 

External Device Zones External Device

Component Configuration
User Module

User Module, Audio processor, Control parts

SPX Component Configuration
User Module

SPX components

User Module Configuration Combination of components

Slot Component Configuration Cards inserted into DME slot

Pictures All Image

Text All Text box

Boxes All Box shape

Ellipses All Circular shape

Wires All Connecting wire, straight line shape

Legend All
Zones
Configuration

An area displayed on the sheet where descriptive 
information is presented.

Sheet -- One sheet per design window.
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Zone
There must be at least one zone in the Area window. Zones are added and deleted using the “Zone” 
dialog box. Zones are not displayed in the Toolkit window or in the [Area Parts List] submenu in the 
[Tools] Menu
If you right-click on the name of a zone object located in the Area window, a context menu will be 
displayed. 

■ Zone Context Menu

[Open] 
Opens the Configuration window.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Area Properties” dialog box.
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■ Zone Object Properties
When you select a zone in the Area window, then click the [Properties] command on the [Edit] 
menu, the “Area Properties” dialog box is displayed. Here you can set properties for zone objects. 
The [Properties] command is also located on the context menu for zone objects. 

[Text] Box
You can enter up to 100 English characters for the object name. 
The object name is displayed in the rectangular box for the object. If there is a large number of 
characters and the object’s shape is too narrow, all characters might not be displayed. 

[Font] Button
Clicking here displays the “Select Font” dialog box. This sets the font used to display the object 
name. 
For information about the “Select Font” dialog box, see page 202. 

[Color] Button
Clicking here displays the “Select Color” dialog box. This sets the color of the object name text.
For information about the “Select Color” dialog box, see page 203. 

Text Position
Sets the location of the text. The list to the left sets the vertical position of the text. The list to the 
right sets the horizontal position. 

• Vertical Position
Select [Top], [Center], or [Bottom].

• Horizontal Position
Select [Left], [Center], or [Right].

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.
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[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

Background Image
Sets background effects for the object. 

• [Color] Button
Sets the color. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 203. 

• [Image] Button
Displays an image inside the object. You can use image files in the following formats: BMP 
(.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Clicking here displays the “Select Image” 
dialog box. Specify an image file and set its display method. 
For information about the “Select Image” dialog box, see page 205. 

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

Raised Sunken
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DME
DMEs are arranged in the Zone window. If DME properties settings have been made for an expansion 
card installed in one of the DME slots, the card will be displayed automatically.

DME24N

DME64N

DME24N with no I/O card installed.

DME24N with an I/O card installed in 
its expansion slot.

DME64N with no I/O cards connected in slots.

DME64N with I/O cards installed 
in expansion slots 1, 2, and 4.
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When I/O Cards Are Installed in DME Expansion Slots 
When an I/O card is selected for an expansion slot in the DME properties, an I/O port is added for 
the DME arranged in the Zone window. An I/O component block will be added to the configuration 
window. 
If [None] is selected for I/O cards in the DME properties, any I/O component blocks will also be 
deleted automatically from the Configuration window. (Even if the I/O components are deleted, the 
wiring will remain.) 

When the DME64N Cascade Setting is Turned ON
When [Show Cascade Port] is checked in the DME64N “DME Device Properties” dialog box, the 
cascade I/O components will be displayed in the Configuration window. 
If “Show Cascade Port” is turned OFF in the DME64N “DME Device Properties” dialog box, 
cascade I/O components will also be deleted automatically in the Configuration window. (Even if 
the Cascade I/O components are deleted, the wiring will remain.) 

DME64N block with card inserted in a slot and the Configuration window
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CobraNet Card
If the I/O card is a CobraNet card, a CobraNet icon will be displayed in the DME object. 

■ Object Selection
To open a configuration window for a DME object arranged in the Zone window, first select it by 
clicking on it, then double-click on it. If you right-click on the object, a context menu will be 
displayed. 

DME block with CobraNet card inserted
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■ DME Object Context Menu

[Open Configuration Window]
Opens the Configuration window.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the DME device that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Flash Unit LEDs]
When selected the DME front panel will flash, and will continue flashing until selected a second 
time.

[Output Level]
When you select this command, the “Output Level” dialog box will be displayed. This sets the DME 
master volume. 

[Properties]
Displays the “DME Device Properties” dialog box. 
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■ DME Properties
To display the “DME Device Properties” dialog box, select a DME object, then click the [Properties] 
command on the [Edit] menu. Here you can set DME properties. 

[Label] Box
You can enter up to 100 English characters to display over the object. 

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Port Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

NOTE

The name set in the [Label] box will be displayed on the list in the Toolkit window, [Import]/[Export] menu commands, 
and on the list in the dialog box. If there are multiple examples of the same DME, set different names for each so that you 
can distinguish one from the other. 

NOTE

For information about the “Select Color” dialog box, see page 203.

DME24N DME64N
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Analog I/O
Sets the label for the DME24N I/O port. When you click the [Edit I/O Port Label] button, the “Edit 
Port Label” dialog box is displayed. 

Cascade
Turns the DME 64N cascade ON or OFF. 

• Show Cascade Port
Checking this enables cascade. 

• Cascade Setting
Here you can make settings that apply when cascade is enabled. Clicking here displays the 
“Cascade Setting” dialog box. 

I/O Card
Settings for the [Slot1] ~ [Slot4] I/O cards. [Slot1] only can be set for DME24N.

• [Select I/O Card]
Specifies the type of I/O card.

• [Card Label]
I/O card names having up to 100 characters can be entered here.

• [Edit SlotN I/O Port Label] Button
Specifies an I/O port label for each slot. Clicking here displays the “Edit Port Label” dialog 
box.

Port Style On Zone Window
Specifies how the DME ports appear in the zone window.

• [Audio Port (Classic Style)]
Displays all audio ports.

• [Custom Port Style]
Customizes the port display.

[Left]
Sets the number of ports to be displayed on the left.

[Right]
Sets the number of ports to be displayed to the right.

• [Edit Port Label and Type]
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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■ “Cascade Setting” Dialog Box
Clicking the [Cascade Setting] button displays the “Cascade Setting” dialog box. Here you can 
display DME64E cascade connections and make settings related to them. These settings are 
common to the cascaded DMEs in the same zone.

Unit No. (Cascade Connection Number)
All DME units other than the first unit (default “1”) are assigned automatically, and are grayed out 
after connection indicating that the settings cannot be changed.

Head Margin
Here you can display and set the head margin for the Cascade connection audio signal. Select [0 
db] or [-18 db]. All DME Unit No. settings for DME units other than the first unit will be automatically 
set to the same value as the first unit when connected. These settings are grayed out after 
connection indicating that they cannot be changed.

Mixer I/O Channel
Here you can display and set the channel used for audio input/output to a mixer. If the checkbox is 
turned ON, the channel for the Cascade connection with the mixer is set. If turned OFF, the channel 
for connecting with the DME is set. 

[Check All] Button
Checks all checkboxes.

[Clear All] Button
Clears all checkboxes.

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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■ “Edit Port Label” Dialog Box
When you click the [Edit I/O Port Label]/[Edit SlotN I/O Port Label] button, the “Edit Port Label” 
dialog box is displayed. Here you can set the port labels displayed for components. Enter a [Short 
Name] and [Long Name] for [Inputs] and [Outputs]. You can enter up to 100 English characters for 
each name.
You can switch between long and short port names displayed in the configuration window with the 
[Port Long Name] command in the [View] menu. When you select this command, a checkmark 
appears next to it and long names are displayed. If you select this command while a checkmark is 
next to it, the checkmark disappears and short names are displayed. 
When the Port Style On Zone Window [Custom Port Style] is selected, labels specified here will not 
appear in the Zone Window. Labels specified here are always displayed in the Configuration 
Window.

■ Edit Port Label and Type Dialog Box
The Edit Port Label and Type dialog box will appear when the [Edit Port Label and Type ..] button is 
clicked. Here you can specify the port labels and types to be displayed in for the components.
To set labels enter the [Port Name] for [Left] and [Right]. Each name can be up to 100 characters in 
length.
To set the port type use [Port Type] to select the [Left] and [Right] types.
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ICP
You can arrange control panel objects in the Zone window. These can be controlled using user 
defined parameters.
First click on an ICP object arranged in the Zone window to select it, then double-click the object. This 
opens a “Control Panel Properties” window. If you right-click on the object, a context menu will be 
displayed. 

■ ICP Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the control panel object that is on the clipboard. If the same control panel object exists on 
the sheet where you are pasting, a new ICP object will be created. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the properties dialog box.
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■ ICP Properties
To display the “Control Panel Properties” dialog box, select a ICP object, then click the [Properties] 
command on the [Edit] menu.

[Label] Box
You can enter up to 100 text characters to display above the object. Labels for identical ICP 
objects that exist in other configurations will also be changed. 

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.

[Style]
Sets the object style. Select [Plain], [Raised], or [Sunken] from the list.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

[Back Color] Button
Sets the object color. Click to display the Select Color dialog box.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 203. 

[User Defined Lock]
Sets whether user defined parameters will be displayed or hidden. Pages with checkmarks will not 
be displayed. The four [1]/[2]/[3]/[4] tabs in the “User Defined Button” dialog box correspond to the 
pages on the DME unit main display. 

Ethernet Port
Turns Ethernet port rendering on or off. Ethernet port display will appear when the checkbox is ON. 
The radio buttons can be used to specify whether the display is on the left or right side.
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[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

External Device
Arranges external device objects in the Zone window. These objects can be added by plug-in 
functions. External applications can be linked to the devices arranged in the window. These links to 
external applications are set using the “External Device Properties” dialog box. 
To start the application linked to an external device object arranged in the Zone window, first click on 
the object to select it, then double-click it. If you right-click on the object, a context menu will be 
displayed. 

■ AD824/AD8HR
The AD824 is an eight-channel analog-to-digital converter. The AD8HR is an eight-channel analog-
to-digital converter that features a head amp with high quality sound. 
You can connect Yamaha AD824 and AD8HR A/D converters to a DME unit and control them 
remotely from DME Designer. DME Designer has a component editor for controlling [AD824] and 
[AD8HR] units. 
If you arrange an [AD824] or [AD8HR] from [External Device] in the Zone window, select the 
connected DME unit in the properties dialog box, and double-click on an [AD824] or [AD8HR] 
block, the component editor is displayed. 

NOTE

If no external application is linked to the an object, no application will start when the object is double-clicked.

NOTE

If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click.
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■ External Device Object Context Menu

[Open Component Editor] 
Starts the application assigned to the object. 
For the [AD824] and [AD8HR], it opens the component editor. 

[Cut] 
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “External Device Properties” dialog box.
At the lowest position below [External Device], [AD824] and [AD8HR] display the “Serial Controlled 
Device Properties” dialog box. The other objects display the “External Device Properties” dialog 
box. 

■ External Device Properties
To display the “External Device Properties” dialog box, select any external device object besides 
AD824 or AD8HR, then click the [Properties] command on the [Edit] menu.

[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.
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[Style]
Sets the object style. Select [Plain], [Raised], or [Sunken] from the list.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Port Label Color] Button
Sets the color of the I/O port label. Click to display the Select Color dialog box.

[Back Color] Button
Sets the object color. Click to display the Select Color dialog box.

Launch Application
The radio buttons determines whether an application or file will be linked to an external device.

• [Application] Box
The linked application will be displayed. Click the [Browse] button to locate and select an 
application. Specifies the path to an application to be launched when an External Device 
object is double-clicked.

• [File] Box
The linked file will be displayed. Click the [Browse] button to locate and select a file. Specifies 
the path to a file to be launched when an External Device object is double-clicked.

Port
Specifies the number of ports displayed for an External Device object.

• [Left]
Sets the number of ports to be displayed on the left.

• [Right]
Sets the number of ports to be displayed to the right.

• [Edit Port Label] Button
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

NOTE

For information about the “Select Color” dialog box, see page 203.
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■ External Device Properties (AD824, AD8HR “Serial Controlled Device 
Properties” Dialog Box)
To display the “Serial Controlled Device Properties” dialog box, select AD824 or AD8HR, then click 
the [Properties] command on the [Edit] menu.
This dialog box is the same as the “External Device Properties” dialog box, except for [Remote]. 

Remote
Select the DME you will control remotely from AD824 and AD8HR.

• [DME Unit] 
The DMEs in the current configuration will be displayed in a list. Select the DME you will 
control remotely. 

• [ID]
Selects an ID from 1 to 8. The default is 1.
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Component
Components are arranged in the Configuration window and the User Module window. They include 
audio processors like mixers and compressors, and control parts like switches and sliders. They can 
be added by plug-in functions. Component objects arranged in a configuration are displayed in block 
form. 
To open the component editor for an arranged component, first select it by clicking on it, then double-
click on it. If you right-click on the object, a context menu will be displayed. 

■ Component Object Context Menu

[Open Component Editor]
Opens the component editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Component Library]
Recalls libraries with component parameters saved in them. Clicking here displays the submenu. 
When a library is selected from the submenu, the library is read and the component parameters are 
changed. 
For more information about libraries, see “Library” (page 275). 

[Store Component Library]
Saves the component parameters. Click to display the Store dialog. If you then save without 
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 275 for more information.

[Properties]
Displays the “Component Properties” dialog box.

Label
ID

Input Port

Output Port

Amount of DSP memory used 
in the DME 
DME Designer Owner’s Manual



Chapter 4  Designer
■ Component Properties
Here you can set properties for each component. If multiple examples of the same component type 
are arranged on a single sheet, changing the properties of a single component does not change 
the others. 
To display the “Component Properties” dialog box, select a component object, then click the 
[Properties] command on the [Edit] menu.

[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

NOTE

Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is 
grayed out for users for whom [Control Component Editor] is turned OFF. 
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[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

NOTE

For information about the “Select Color” dialog box, see page 203.
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SPX Component
SPX components are arranged in the Configuration window and the User Module window. Component 
objects arranged in a configuration are displayed in block form. 
Clicking on a positioned SPX component will select it, and right-clicking will display a contextual 
menu.
Unlike normal components, SPX components use SPX-specific resources and therefore the usage 
percentage display that appears to the lower right of normal components will not appear. Check the 
SPX resource usage percentage via the SPX meter in the Resource Meter window. 

■ Context Menu for SPX Component Objects

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard. 

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on. 

[Duplicate]
Duplicates the object you clicked on. 

[Display Order]
Changes the display order of the objects, according to a command in the submenu. 

[Properties]
Displays the “SPX Component Properties” dialog box. 

[Recall Component Library]
Recalls libraries with component parameters saved in them. Clicking here displays the submenu. 
When a library is selected from the submenu, the library is read and the component parameters are 
changed. 
For more information about libraries, see “Library” (page 275). 
When you will change the effect type for the SPX component, select the desired type from the 
[Effect Type] displayed in the submenu.

NOTE

Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is 
grayed out for users for whom [Control Component Editor] is turned OFF. 
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■ SPX Component Properties
SPX component properties are set for each component. If multiple examples of the same 
component type are arranged on a single sheet, changing the properties of a single component 
does not change the others. 
To display the “SPX Component Properties” dialog box, select a component object, then click the 
[Properties] command on the [Edit] menu. 

[Label] Box
You can enter up to 100 characters to display over the object. 

[Width] Box
Specifies the width of the object in pixels. 

[Height] Box
Specifies the height of the object in pixels. 

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

[Label Font] button
Sets the font for the label. Clicking here displays the “Select Font” dialog box. 
For information about the “Select Font” dialog box, see “Select Font” dialog box (page 202). 

[Label Color] Button
Sets the color for the label text. Clicking here displays the “Select Color” dialog box. 

[Inputs/Outputs Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box. 

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box. 

[OK] Button
Updates the settings and closes the dialog box. 

[Cancel] Button
Closes the dialog box without changing the settings. 

NOTE

For information about the “Select Color” dialog box, see “'Select Color' Dialog Box” (page 203). 
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Slot Component
If an inserted I/O card is selected in the DME properties settings, it will be displayed in the 
Configuration window as a Slot component. 
Slot component objects arranged in a configuration are displayed in block form. 
If you select an arranged component by clicking on it, then double-click it, the Slot Out component 
editor opens. If you right click on the object, a context menu will be displayed. 

■ Slot Component Object Context Menu

[Open MY-Card Editor]
Opens the editor for an MY-Card inserted in a slot. 

[Open Slot Out Component Editor]
Opens the Slot Out component editor. 

[Cut]/[Copy]/[Paste]/[Delete]/[Duplicate]
The functions cannot be used with Slot components. 

[Display Order]
Changes the display order of the objects, according to a command in the submenu. 

[Properties]
Displays the “Slot Out Component Properties” dialog box. 
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■ Slot Out Component Properties
To display the “Slo tOut Component Properties” dialog box, select a Slot Out component object, 
then click the [Properties] command on the [Edit] menu. 

[Label] Box
You can enter up to 100 characters to display over the object. 

[Width] Box
Specifies the width of the object in pixels. 

[Height] Box
Specifies the height of the object in pixels. 

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

[Label Font] button
Sets the font for the label. Clicking here displays the “Select Font” dialog box. 
For information about the “Select Font” dialog box, see “'Select Font' Dialog Box” (page 202). 

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box. 

[Inputs/Outputs Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box. 

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box. 

[OK] Button
Updates the settings and closes the dialog box. 

[Cancel] Button
Closes the dialog box without changing the settings. 

NOTE

For information about the “Select Color” dialog box, see “'Select Color' Dialog Box” (page 203). 
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User Module
A user module combines a number of other components into a module that is treated as a single 
component. It can be arranged in the Configuration window. A user object arranged in a window is 
displayed as a single block. The User Module Design Window or User Module Window will open, 
according to the “User Module Manager” setting when you double click the user module (page 250). 
If you right-click on the object, a context menu will be displayed. 

■ User Module Object Context Menu

[Open User Module Design Window] 
Opens the User Module Design Window. 

[Open User Module Editor]
Opens the User Module Editor.

[Cut] 
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Component Library]
Recalls a library into which component parameters have been saved. Click to display a sub-menu. 
Select a library from the sub-menu to load the parameters into the component.
Refer to “Library” on page 275 for more information.
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[Store Component Library]
Saves the component parameters. Click to display the Store dialog. If you then save without 
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 275 for more information.

[Save User Module] 
Saves the selected user module. See “Saving User Modules” on page 255.

[Properties]
Displays the “User Module Properties” dialog box.

The submenu displays library files saved in the “Library” folder for user modules. 

• [Open File Dialog]
Displays the file select dialog box. You can recall libraries saved in folders other than the user 
module “Library” folder. 

■ User Module Properties
To display the “User Module Properties” dialog box, select a user module object, then click the 
[Properties] command on the [Edit] menu.

NOTE

Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is 
grayed out for users for whom [Control Component Editor] is turned OFF. 

NOTE

The “User Module Properties” dialog box is also displayed when a [Blank User Module] is arranged in the configuration 
window. 
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[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], [Sunken], or [Image]. When 
[Image] is selected the Open dialog will appear. Select an image file and click [Open] to place the 
selected image as an object.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Labels Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.

Inputs/Outputs Sets
Sets the number of input/output ports. Enter a number into the [Inputs] box and [Outputs] box, or 
set a value using the [▲] and [▼] buttons at the right of each box. The maximum of both input and 
output ports is 64.

Edit I/O Port Label
Input and output port names up to 100 characters in length can be entered.

Double-Click Action
Sets the action that occurs when you double-click on a user module object arranged in the 
Configuration window. 

• [Open User Module Design Window]
Opens the User Module window. 

• [Open User Module Editor]
Opens the User Module editor. 

NOTE

For information about the “Select Color” dialog box, see page 203.
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Security Settings
Turns user module security ON or OFF, and sets a password. 

• [Enable Security]
Enables user module security. If you turn this function ON when no password is currently set, 
the “Set Password” dialog box appears. Enter a password, then click the [OK] button. 

If you change the setting from OFF to ON, the “Input Password” dialog box appears. You 
cannot turn Security OFF until you enter the correct password. 

• [Set Password] Button
Changes the password for user modules. Clicking this button displays the “Input Password” 
dialog box. Enter the current password and click the [OK] button. The “Set Password” dialog 
box will be displayed, and you can set a new password. 
This button will be grayed out when [Enable Security] is turned OFF. 

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

NOTE

When security is active the editor cannot be opened unless the appropriate password is entered. Once the 
password has been entered security is temporarily disabled until the DME Designer is quit, or a different file is 
opened.
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Picture
An image can be arranged as an object on a sheet. This specifies a file for this purpose. You can use 
image files in the following formats: BMP (.bmp), PNG (.png), XBM (.xbm), XPM (.xpm), and JPEG 
(.jpg).
Before placing a picture object, prepare an image file. Copy the image file to the folder specified in the 
“Preferences” dialog box → [Application] tab → [ContentsFolder] in the Main Panel window. 
In the project file, the location and name of the image file are registered in an relative path below the 
[ContentsFolder] and the linked image file is read and displayed. If the image file is moved, renamed, 
or the [ContentsFolder] is changed, the image cannot be displayed. 

■ Placing Pictures
There are three picture placement methods:
• You can drop the [Picture] item from the Toolkit window into each design window. 
• You can double-click [Picture] on the Toolkit window. 
• You can click [Picture] in the [Area Parts]/[Device List]/[Component List] on the [Tools] menu, 

then click each design window. 

When you place a picture object, the “Open” dialog box is displayed. Select the image file and 
click the [Open] button. The picture will be placed in the design window.

NOTE

The default for the “Preferences” dialog box → [Application] tab → [ContentsFolder] in the Main Panel window is 
“C:\Program Files\YAMAHA\OPT Tools\DME Designer.” The [Designer] folder is located in the [DME Designer] folder. Within 
that folder, there is an [Images] folder prepared for saving image files. 

NOTE

Background images for sheets are specified in the “Sheet” dialog box. Pictures are arranged as objects on the sheets. 
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■ Picture Object
When you click a picture object that is located in each design window, handles (small squares) 
appear at the corners and sides of the object. You can expand or reduce the picture’s size by 
dragging a handle. 

If you double-click on the object, the “Open” dialog opens. There you can change the image file.
If you right-click on a picture object, a context menu will be displayed. 

■ Picture Module Object Context Menu

[Cut] 
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Picture Properties” dialog box.
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■ Picture Object Properties
To display the “Picture Properties” dialog box, select a picture object, then click the [Properties] 
command on the [Edit] menu.

[Label] Box
You can enter up to 100 English characters to display over the object.
If the box is left blank, the label will disappear. 

[Draw Picture Border]
Displays a border around picture objects.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 203. 

[Port Label Color] Button
Sets the color of the I/O port label. Click to display the Select Color dialog box.

[File Name] Box
Displays the path to the graphic file.

[Browse] Button
Selects a graphic file.

[Link Component Editor]
When On a Picture object can be double clicked to open the component editor specified by the 
[Select Component] button.

[Select Component] Button
Specifies the component editor to be opened when a Picture object is double clicked. Only 
effective when [Link Component editor] is On.
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Port
Specifies the number of ports to be displayed for a picture object.

• [Left]
Sets the number of ports to be displayed on the left.

• [Right]
Sets the number of ports to be displayed to the right.

• [Edit Port Label] Button
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Text Box
Text objects can be arranged in all design windows. Text is entered into the “Text Properties” dialog 
box. When first placed in the design window, the word “Text” is entered into the box. 
If you click the text object, handles (small squares) appear at the corners and sides of the object. You 
can adjust the size by dragging the handles. You can open the “Text Properties” dialog box by double-
clicking the box. If you right-click on the object, a context menu will be displayed. 

■ Text Object Context Menu

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Text Properties” dialog box.
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■ Text Object Properties
To display the “Text Properties” dialog box, double-click on a text object, or select a text object, 
then click the [Properties] command on the [Edit] menu.

[Text] Box
You can enter up to 10,000 English characters to display in the text object box.

[Text Font] Button
Sets the font. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202. 

[Text Color] Button
Sets the color of the text. Clicking here displays the “Select Color” dialog box.

[Background Color] Button
Sets the color of the background. Clicking here displays the “Select Color” dialog box.

[Draw Text Border] 
Displays a frame around the text object. If this is not checked, only the text will be displayed on the 
sheet. 

[Text Border Style] Box
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

[Link Component Editor]
When On a Text object can be double clicked to open the component editor specified by the 
[Select Component] button.

[Select Component] Button
Specifies the component editor to be opened when a Text object is double clicked. Only effective 
when [Link Component editor] is On.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

NOTE

For information about the “Select Color” dialog box, see page 203.
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Box (Rectangle)
You can arrange rectangles on the sheet. 
If you click the box, handles (small squares) appear at the corners and sides of the object. You can 
adjust the size by dragging the handles. You can open the “Box Properties” dialog box by double-
clicking the box. If you right-click on the object, a context menu will be displayed. 

■ Box Object Context Menu

[Cut] 
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Box Properties” dialog box.
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■ Box Object Properties
To display the “Box Properties” dialog box, double-click on a box object or select a box object, 
then click the [Properties] command on the [Edit] menu.

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken]. 

[Round Corner]
Creates a rectangular box with rounded corners. 

[Color] Button
Sets the color of the box. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 203. 

Line
Sets the line that frames the box. 

• [Type]
Displays a list where you can select the type of line to frame the box. The following types are 
available: [Solid], [Dash], [Dot], [DashDot], and [DashDotDot].

• [Size] Box
Sets the width of the line that frames the box. This setting can range from 1 to 100 pixels.

• [Color] Button
Sets the color of the line that frames the box. Clicking here displays the “Select Color” dialog 
box.
For information about the “Select Color” dialog box, see page 203. 

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Ellipse
[Ellipse] in the Toolkit window places a elliptical shape on the sheet.
When you click an Ellipse object that is located in the sheet, handles (small squares) appear at the 
corners and sides of the object. You can adjust the size by dragging the handles. You can open the 
“Ellipse Properties” dialog box by double-clicking the ellipse. If you right-click on the object, a context 
menu will be displayed. 

■ Ellipse Object Context Menu

[Cut] 
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Ellipse Properties” dialog box.
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■ Ellipse Object Properties
To display the “Ellipse Properties” dialog box, double-click on an ellipse object, or select an ellipse 
object, then click the [Properties] command on the [Edit] menu.

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.

[Color] Button
Sets the color of the ellipse. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 203. 

Line
Sets the line that frames the ellipse. 

• [Type]
Displays a list where you can select the type of line to frame the ellipse. The following types 
are available: [Solid], [Dash], [Dot], [DashDot], and [DashDotDot].

• [Size] Box
Sets the width of the line that frames the ellipse. This setting can range from 1 to 100 pixels.

• [Color] Button
Sets the color of the line that frames the ellipse. Clicking here displays the “Select Color” 
dialog box.
For information about the “Select Color” dialog box, see page 203. 

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Wire
Draws lines (wires) for connecting components and creating shapes. For instructions on drawing 
wires, see “Drawing and Editing Wires” on page 219.
First click on an wire object arranged on the sheet to select it, then double-click the object. This opens 
a “Wire Properties” window. 

If you right-click on a wire object, one of three types of context menus will be displayed, depending 
where you clicked. 

■ Wire Object Context Menu (Line Segment)

[Start Wire]
Begins drawing a line segment from the location where you clicked. 

[Delete Wire]
Deletes the entire wire.

[Cut] 
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard. 

[Delete]
Deletes the line segment where you right-clicked.

[Duplicate]
Duplicates the wire object.

Line SegmentNode

Termination

Line Segment Context Menu
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[Wire Color]
Specifies the wire color.

[Properties]
Displays the “Wire Properties” dialog box.

■ Wire Object Context Menu (Node)

[Start Wire]
Begins drawing a wire segment from the location where you right-clicked. 

[Delete Wire]
Deletes the entire wire.

[Delete]
Deletes the node. The nodes before and after will become directly connected. 

[Properties]
Displays the “Wire Properties” dialog box.

■ Wire Object Context Menu (Termination)

[Continue Wire]
Begins drawing wire from a termination node. 

[Start Wire]
Begins drawing a wire from the location where you right-clicked. 

[Delete Wire]
Deletes the entire wire.

[Properties]
Displays the “Wire Properties” dialog box.

Node Context Menu

Termination Context Menu
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■ Wire Object Properties
To display the “Wire Properties” dialog box, double-click on a wire object. You can also select a 
wire object, then click the [Properties] command on the [Edit] menu.

[Line Width] Box
Set the line width. This setting can range from 1 to 10 pixels.

[Line Type]
Displays a list where you can select the type of line. The following types are available: [Solid], 
[Dash], [Dot], [DashDot], and [DashDotDot].

[Line Color] Button
Sets the color of the line. Clicking here displays the “Select Color” dialog box.

[Selected Color] Button
Sets the color of the selected line. Clicking here displays the “Select Color” dialog box.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

NOTE

For information about the “Select Color” dialog box, see page 203.
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Legend (Descriptive Fields)
Displays a legend for all sheets except the User Module window. 
When you click the [Edit Legend] command on the [Edit] menu or double-click on one of the Legend 
fields displayed on the sheet, the “Edit Legend” dialog box is displayed. If you right-click on the 
Legend, the displayed context menu will have the [Edit Legend] command only. If you click there it will 
display the “Edit Legend” dialog box. 

The “Edit Legend” dialog box is used to enable/disable Legend display and to set the contents 
displayed there. You can display the [Edit Legend] command from the [Edit] menu.
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■ “Edit Legend” Dialog Box

[Project] Box, [Title] Box, [No.] Box, [Author] Box, [Company] Box, [Address1] Box, and 
[Address2] Box
Used to enter the Project, Title, Number, Author, Company, Address1, and Address2. You can enter 
up to 100 English characters for each field. 

[Date] Box and [Revisions] Box
You can enter up to five dates and five revisions. You can enter up to 100 English characters for 
each field. 

[Legend Base Font Style]
Displays a list where you can select the font. 

[Show Legend]
Place a checkmark here to display the legend on the sheet. 

[Save as Default Legend] 
Saves this legend as the default legend used when a new sheet is created. When a new 
configuration is created, it will have a legend with the same contents as this one. 

[Change for All Legends In Area]
Place a checkmark here to have the changes made here reflected in sheets in all design windows 
included in the area.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Sheet 
There is one sheet in each design window for arranging objects. The size of the sheet and its 
background image are specified with the “Sheet” dialog box. This dialog box is displayed using the 
[Sheet] command from the [Tools] menu.
Make the window where you are going to change sheet settings active, then click [Tools] menu → 
[Sheet]. 

■ “Sheet” Dialog Box

[Preset Size]
Displays a list where you can select preset paper sizes. 
When you select a paper size, numerical values are set for [Horizontal] and [Vertical]. 

[Custom Sizes]
Set a custom size by specifying the vertical and horizontal sizes of the sheet.

• [Horizontal] Box
Sets the horizontal width of the sheet. 

• [Vertical] Box
Sets the vertical height of the sheet. 

• [Fixed Aspect Ratio]
When this is checked the relationship between horizontal and vertical is fixed. When the value 
for [Horizontal] or [Vertical] changed, the size of the other direction changes so that the 
proportions of the paper remain the same. 

• [Save As Default Sheet Size]
When turned ON, the current values will become the default for creating sheets. New sheets 
will be created at the same size. 

NOTE

The upper left is the starting point for measuring sheet size. Therefore, in the [Horizontal] box set the number of 
pixels to the right edge, and in the [Vertical] box, set the number of pixels to the lower edge. The boundaries in 
which items are already arranged on the sheet will form the minimum sheet size. 
Because any objects that are moved, cut, or deleted will return to the same location if the [Undo] command is 
used, the minimum sheet size will be determined by the boundaries in which any objects were located, now or in 
the past.
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Background Effect
Sets the background for the sheet. 

• [Color] Button
Sets the color of the background. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 203. 

• [Image] Button
Displays an image as the sheet background. You can use image files in the following formats: 
BMP (.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Clicking here displays the “Select 
Image” dialog box.
For information about the “Select Image” dialog box, see page 205. 

• [Change for All Sheets]
Changes all sheets so that they are the same.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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“Select Font” Dialog Box
When you click the [Font] or [Label Font] button in an object’s properties dialog box, the “Select Font” 
dialog box is displayed. Sets the font.

■ Font
Selects the font. The currently selected font name is displayed in this box. Select a font by clicking 
its name on the list. 

■ Font Style
Sets the style of the text. The currently selected style is displayed in the box. Select a style by 
clicking its name on the list below. 
• Normal ..........Standard style
• Italic .............. Italic or slanted text
• Bold ..............Bold text
• Bold Italic......Bold italic text

■ Size
Sets the text size. The currently selected size is displayed in the box. Select a size by clicking it in 
the list below. 

■ Effects
Sets effects for the text. Check the effects you wish to set. 
• Strikeout........Adds a strikeout line through the center of the text. 
• Underline ......Adds an underline to the text.

■ Script
From the list, select the script (language) for the text. There is no need to change the language 
setting unless you want to specify a specific language. 

■ Sample 
Displays an example of the current settings. 
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“Select Color” Dialog Box
When you click the [Color] or [Label Color] button in an object’s properties dialog box, the “Select 
color” dialog box is displayed. Sets the color of objects and text. 

■ Setting Basic Colors
There are 48 basic colors provided in the [Basic colors] section. When you select a basic color by 
clicking on it, the position of that color in the color palette to the right is indicated by a cross (+). 
Information about the selected color is displayed below the color palette. 
Click the [OK] button to set the color you selected.

■ Setting Colors That Are Not in the [Basic colors] Section. 
You can select any color in the color palette displayed at the upper-right of the dialog box by 
clicking on it in the palette. Color information is displayed below the color palette. If you like the 
color you selected, click the [OK] button. If you don’t like the color, you can select a new color by 
clicking in another location in the color palette, or by dragging the cross symbol to another location 
there.
Grey colors can be selected on the tall, thin chart to the right of the palette. 
Click the [OK] button to set the color you selected.

■ Saving Colors You Have Created
In the custom color section, you can save up to 16 colors you have created. When you save a 
custom color, it can be selected by clicking on its color button, in the same way as for the [Basic 
colors]. 
Even if you open the “Select color” dialog box from the Properties of another object, any custom 
color you save will be displayed and you can use that same color for the other object. 
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1 Click the [Custom colors] box where you will save the color you create. 
The box you clicked will be selected and a frame will appear around it. 

2 Set the color on the color palette. 

3 Click the [Add to Custom Colors] button. 
The selected color will be added to [Custom colors].

NOTE

You can save another color in a box that already has an original color saved in it. Just click on the box to select it. 
The new color will overwrite the previous color, which will be lost.
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“Select Image” Dialog Box
You can display an image for the background of sheets or objects. You can use image files in the 
following formats: BMP (.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg).
In the project file, the location and name of the image file are registered in an relative path below the 
[ContentsFolder] and the linked image file is read and displayed. If the image file is moved, renamed, 
or the [ContentsFolder] is changed, the image cannot be displayed. 

If you click the [Image] button in the properties dialog box for an object that can display a background 
image or in the “Sheet” dialog box, the “Select Image” dialog box will be displayed. Specify an image 
file and set its display method. 

Image Layout
Selects the manner in which the image file will be displayed. 

• [Center]
Centers the image in the object or sheet.

• [Tile]
Displays multiple copies of the image side-by-side until the available space is filled. If the 
image file is smaller than the sheet, it will be displayed repeatedly like tiles on a wall. 

• [Fit]
Expands or reduces the size of the image to match the size of the sheet where it will be 
displayed. 

[File] Box
Specifies a path for the image file. A path can be directly entered in the box. You can also click the 
[Browse] button and select the image file. It will be entered automatically. 
To stop display of an image, delete all characters in the box, leaving the field blank. 

NOTE

The default for the “Preferences” dialog box → [Application] tab → [ContentsFolder] in the Main Panel window is 
“C:\Program Files\YAMAHA\OPT Tools\DME Designer.” The [Designer] folder is located in the [DME Designer] folder. Within 
that folder, there is an [Images] folder prepared for saving image files. 
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[Browse] Button
Specifies a path for the image file. Clicking here displays the “Open” dialog box. Select a file with 
one of the following extensions: “.bmp,” “.png,” “.xpm,” or “.jpg,” then click the [Open] button.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Design Window Shared Settings and Operations

Preferences
You can set the operating environment for the Designer window in the “Preferences” dialog box. This 
dialog box is opened using the [Preferences] command in the Designer window [Print] menu.

■ Graphics

Ports & Wires
Specifies wire color, thickness, and type for each port type.

• [Color]
Sets the default color for the port and wire.

• [Width]
Sets the default wire width from a range of 1 to 5.

• [Type]
Sets the port type.

NOTE

The initial color and thickness of the wires produced when drawing connections are specified here. The color and 
thickness of drawn wires can be changed via the Wire Properties dialog box.
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Crosshairs

• [Show Crosshairs While Dragging]
Place a checkmark here to have crosshairs displayed for guidance when dragging the wire 
endpoint.

• [Arbitrary Crosshair Length]
Specifies the length of the crosshair lines.
Enter a number into the [Arbitrary Crosshair Length] box to specify the length in pixels. 
[Infinite Crosshairs] causes the lines to go all the way to the edge of the window. 

Offset Paste/Duplicate from Original By
Sets the position when pasting or duplicating objects.

• [Auto-size (based on original object)]
If you place a checkmark here, the paste/duplicate position will be automatically adjusted so 
that the object does not overlap the original object. 

• [Horizontal Pixels] Box
Sets the horizontal distance. 

• [Vertical Pixels] Box
Sets the vertical distance. 

Auto Suffix Number
Turns automatic appending of sequentially-numbered suffixes to the names of placed objects on or 
off.

• [DME/ICP1]
When ON numbered suffixes will automatically be appended to added DME, and ICP objects.

• [Component]
When ON numbered suffixes will automatically be appended to added SPX and user module 
objects.

• [Other Objects]
When ON numbered suffixes will automatically be appended to added objects not covered by 
the above two categories.
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Compile Priority
Here you can make compile settings for the configuration. 

• [Resource]
Compiles arrangable components in order based on their component numbers. The Delay 
values differ depending on the signal lines. 

• [Fixed Delay]
Fixes the Delay value (number of Samples) for the signal lines. However, it also reduces the 
number of components that can be arranged.

• [Auto Delay Compensation]
This turns ON or OFF a function that automatically corrects the component delay when [Fixed 
Delay] is selected. 

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

NOTE

These compile settings are reflected in online status. If you change the settings in offline status, it will be enabled when 
going online after going offline once.

NOTE

Auto Delay Compensation will not function properly in configurations that have a loop connection.
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Grid
Displays a grid on the sheet in each design window to guide the placement of objects. You can also 
have the objects “snap to” (automatically align with) the grid when dragging them. When you click the 
[Grid] command on the [Tools] menu, the “Grid” dialog box is displayed. Here you can enable or 
disable display of the grid and set the grid interval and form. 

[Snap to Grid]
Makes objects align the grid when dragging them. 

Spacing 
This sets the spacing of the grid. This setting can range from 2 to 99 pixels.

• [X:] Box
This sets the spacing of the grid in the horizontal direction.

• [Y:] Box
This sets the spacing of the grid in the vertical direction.

[Show Grid]
Displays the grid. Place a checkmark here to enable display and select the type of grid.

• [Line]
Displays the grid using lines.

• [Dot]
Displays the grid using dots.

[Save As Default Setting]
Place a checkmark here to make the current grid settings the default when a new sheet is created. 

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Exporting Each Design Window
Configurations are saved in project files. This is done using the [File] menu → [Save] and [Save As] 
commands in the Main Panel window. For information about saving project files see “Project Files” on 
page 22.
Instead of saving projects in their entirety, you can output the information contained in the active 
window using the Designer Window [Print] → [Export DXF] command and save it in a DXF format file. 
These files have “.dxf” as their filename extension. 
Because the DXF format uses the standard CAD file format, it can be opened using CAD software. 
DXF format files can also be opened by graphics software that support vector graphics, such as 
Adobe Illustrator®. 

When you select this command, the “Export DXF” dialog box will be displayed.

• Symbols are substituted for external devices in the following three types of folders. 
Microphone → mike symbol
Power Amp → amp symbol
Speaker → speaker symbol

• Text decoration except for size will be eliminated. 
• Picture objects and background images for the sheet or objects will all be eliminated. 
• [Style] attributes for boxes will be eliminated. 

When you select the [Print] menu → [Export DXF] command, the “Export DXF” dialog box will be 
displayed.
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■ DXF File Name
Enter a filename for the DXF file. The default file name entered here will vary according to the 
currently active window. 
If you click the [...] button at the right of the box, the “DXF File Name” dialog box is displayed. 
Specify the DXF file filename and the folder where the file will be saved. 

Enter the filename, specify the folder where the file will be saved, then click the [Save] button. 
When you return to the “Export DXF” dialog box, the specified filename will be displayed in the 
[DXF File Name] box. 

■ Scale
Sets the reduction ratio. When the size of the sheet is large, you can reduce it before exporting it.

■ Text Style
Specifies the text font for output in DXF format. The default is the “TXT” (drawing font used in CAD). 

■ Block
Sets the block form used in the sheet. Displays a list where you can select the form. 

[Block]
Makes the blocks rectangular and groups the text in the port icons and port names. 

[Explode]
Makes the blocks into sets of four lines, and does not group the text in the port icons and port 
names. 

NOTE

When you click on the [Save] button in the “DXF File Name” dialog box, the DXF file is not saved. Only when you click on 
the [OK] button in the “Export DXF” dialog box, does the DXF file become saved.
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■ [Paper Size]
Sets the size of the paper. 

[Preset Size]
Displays a list where you can select preset paper sizes. When you select a paper size, numerical 
values are set for [Horizontal] and [Vertical]. 

[Custom Sizes]
Set a custom size by specifying the vertical and horizontal sizes of the sheet.

• [Horizontal] Box
Sets the horizontal width of the sheet. 

• [Vertical] Box
Sets the vertical height of the sheet. 

[Unit]
Selects the unit used for setting the sheet size.

[OK] Button
Saves the DXF file according to the settings in the dialog box. 

[Cancel] Button
Cancels the DXF file export process. 
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Printing Each Design Window
You can print out the content of each design window just as it appears on the screen. The content in 
the window will be expanded or reduced in size as necessary to match the size and orientation of the 
paper, and printed onto a single sheet of paper. Commands related to printing are found on the 
Designer Window [Print] menu.

■ [Print Setup]
When you select this command, the “Print Setup” dialog box will be displayed. Sets the paper size 
and orientation. 

[Paper Size]
Displays a list where you can select the paper size. 

Orientation
Sets the orientation of the paper. 

• [Portrait]
Prints on the paper with its long sides vertical.

• [Landscape]
Prints on the paper with its long sides horizontal.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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■ [Print Preview]
Displays a print preview of the active design window. You can check the appearance of the page 
before printing it. 

[Print]
Displays the “Print” dialog box.

[Close]
Closes the print preview window.

■ [Print]
Prints the active window. When you select this command, the “Print” dialog box will be displayed. 
Enter the number of copies to print into the [Number of Copies] box, and click the [Print] button.
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Arranging Objects
Multiple object placement methods are available. 

■ Dragging from the Toolkit Window
You can drag items from the Toolkit window to the location where you want to place them in each 
design window. 

■ Double-Clicking an Object in the Toolkit Window
You can double-click an object in the Toolkit window to place it in each design window. 

■ Selecting from the [Tools] Menu
Available objects are displayed on the [Area Parts List]/[Device List]/[Component List] submenus 
which are accessed from the [Tools] menu. When you click an object name, the mouse pointer 
changes shape. Click the location on the sheet where you want to place the object. 

■ Selecting from the Context Menu
If you right-click on the sheet, you will see the [Area Parts List]/[Device List]/[Component List] 
commands displayed on the context menu that appears. When you click an object name on the 
submenu, the mouse pointer changes shape. Click the location on the sheet where you want to 
place the object. 

Selecting Objects

■ Selecting with a Click
You can select an object by clicking on it. If you click another object or an empty location on the 
sheet, it will cancel selection of the object you previously clicked. 

■ Selecting with Click + <Ctrl> Key
When you want to select multiple objects, hold down the <Ctrl> key as you click each new object 
you want to select. If you hold down the <Ctrl> key and click again on one of the objects that is part 
of the multiple selection, it will cancel selection of that single object. 

■ Selecting by Dragging
If you position the mouse in an empty location on the sheet and start dragging from there, a frame 
will be displayed as the pointer moves.
Any objects within this frame will be selected. 

■ Changing the Selected Object Using the <Tab> Key
When a single object is selected, you can change the selection to the next object by pressing the 
<Tab> key. If you press <Shift> + <Tab>, the selection moves to the previous object. The selection 
order moves from left to right. 

NOTE

Wires cannot be selected with the <Tab> key.
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Editing Objects
Objects that have been arranged on the sheet can be edited using the [Cut], [Copy], [Paste], 
[Duplicate], and similar commands in the [Edit] menu. These edit commands will also appear in the 
context menu displayed when you right-click an object in the design window. Buttons for [Cut], 
[Copy], and [Paste] are also available on the Designer window toolbar. 

■ Undoing and Redoing Operations
You can undo operations using the [Undo] command on the [Edit] menu. You can use the [Redo] 
command to redo operations that have been undone.

■ Deleting Objects
Objects can be deleted by selecting them and pressing the <Delete> key. 

■ Moving Objects
You can move objects by dragging them with the mouse. If [Snap to Grid] is ON in the “Grid” dialog 
box, the dragged objects will automatically align with the grid. 
You can also move a selected object using the arrow keys. If [Snap to Grid] is ON in the “Grid” 
dialog box, the selected object will move from grid line to grid line. If [Snap to Grid] is OFF, the 
object will move pixel to pixel. 

NOTE

Some objects cannot be edited.

NOTE

Some objects cannot be deleted. With some other objects, you must first make appropriate settings in a dialog box 
before you can delete them.
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Changing the Order
Objects newly placed on the sheet will be displayed above any previously placed objects they 
overlap. You can change this behavior using the [Display Order] command on the [Edit] menu. Select 
the object for which you want to change the display order, then select the appropriate command from 
the [Display Order] submenu on the [Edit] menu. 

[Top] 
Moves the selected object to the top of the stack. 

[Bottom]
Moves the selected object to the bottom of the stack. 

[Front]
Moves the selected object up one level in the stack. 

[Back]
Moves the selected object down one level in the stack. 

Uppermost Object

BackBottom
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Drawing and Editing Wires

Wire
Objects that are arranged on sheets in the Configuration or User Module windows can be connected 
to each other by wires. Not only does this let you logically connect signal sources (output side) and 
destinations (input side), it also lets you draw connections and independent lines on the display. Each 
wire has at least two wire nodes. Between the nodes are line segments. 

■ Selecting Wires and Canceling Selection
You can select a line segment by clicking on it. 
If you hold down the <Alt> key while clicking, you will select the entire wire. 

NOTE

The color used when a wire object is selected can be set with [Selected Color] in the “Wire Properties” dialog box.

Line SegmentWire Node
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■ Line Segment
The line width default value is set from one to five pixels in the Designer window “Properties” dialog 
box. In the “Wire Properties” dialog box, the line thickness and color can be adjusted as required 
for the various wires arranged on the sheet.

Line Segment Selection
When you select a line segment by clicking on it, only that line segment is selected. If you hold 
down the <Ctrl> key while clicking, you can select multiple line segments. Furthermore, if you drag 
the mouse from an empty location on the sheet so that nodes are enclosed by a box, line segments 
between those nodes will be selected.

Canceling Line Segment Selection
If you select another object or an empty location on the sheet, it will cancel selection of the object 
you previously clicked. 
You can also cancel selections by holding the <Ctrl> key while clicking. 

<Ctrl> + Click Canceling Selection of a Line Segment 
Selected with <Ctrl> + Click
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■ Wire Nodes
Both ends of a wire, the location where wires bend, and the location where wires diverge are called 
“Nodes.” When a wire object is not selected, its nodes are not displayed. When a wire is selected, 
the nodes are displayed with a red circle. 

Node Selection
When you click on a node, only that node itself is selected. You can select multiple nodes by 
holding down the <Ctrl> key while clicking. Furthermore, if you drag the mouse from an empty 
location on the sheet so that nodes are enclosed by a box, the enclosed nodes will be selected.

Canceling Node Selection
If you select another object or an empty location on the sheet, it will cancel selection of the object 
you previously clicked. 
You can also cancel node selections by holding the <Ctrl> key while clicking. With this technique, 
you can cancel only the node you clicked on when multiple nodes are selected. 

<Ctrl> + Click Canceling Selection of a Node Selected with 
<Ctrl> + Click
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Hotspot
The small white rectangles at the edge of objects are called “Hotspots.” Wires usually connect to 
hotspots. 

• Some hotspots do not have a connection to a logical signal within the hardware.
• Component and user module hotspots normally include logical connections. 
• External device hotspots do not include logical connections. 

■ Selecting Hotspots
If you click a hotspot, drawing will start. To select, press <Shift> + click.
You can select multiple hotspots as follows: Select a hotspot with <Shift> + click, then select 
additional hotspots using <Ctrl> + <Shift> + click. 

Hotspots
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Drawing Settings
Several functions are available to help ensure accurate wire drawing.

■ Grid
To accurately draw in relation to the grid, turn ON [Snap to Grid] in the “Grid” dialog box. 

■ Draw Exact Vertical and Horizontal Lines
If you turn ON [Prohibit Diagonal Connections] in the [Tools] menu, wires will be drawn only 
vertically or horizontally. It will not be possible to draw diagonal wires. When you select this 
command, it is turned ON, and a checkmark appears next to it. If you select the command while it 
is ON, it will turn OFF. 
Even if “Prohibit Diagonal Connections” is turned OFF, this function will operate whenever you 
press the <Shift> key while drawing. 
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Wire Drawing
Wire drawing starts at the positions shown in the following table:

■ Connecting Hotspots with Hotspots

Method 1 Clicking
Click the hotspot where the connection originates to begin drawing, then click the destination 
hotspot. The two hotspots will be connected by a wire.

Method 2 Dragging
Drag from the origin hotspot to the destination hotspot. 

■ Connect with Bent Line
Method 1 From Hotspot to Hotspot
Click the hotspot where the connection originates to begin drawing, then click the location (which 
will become a node) where you want the line to bend. Finally, click the destination hotspot to 
complete the connection.

Drawing Start Location Start Method

Hotspot Click

Wire End Terminal Right-click → click [Continue Wire] on the menu

Node Right-click → click [Start Wire] on the menu

Line Segment Right-click → click [Start Wire] on the menu

Anywhere on the Sheet Right-click → click [Start Wire] on the menu

NOTE

When creating diagrams the keyboard cursor keys can be used to move the mouse cursor, and the <Enter. Key can be used 
to create nodes.

NOTE

A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME 
object's Cascade port. 

NOTE

When creating diagrams horizontally aligned hot spots can be automatically connected by pressing the <Shift> + <→> 
keys or <Shift> + <←> keys.

NOTE

A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME 
object's Cascade port. 
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Method 2 From Hotspot to Node or Line Segment
Click the hotspot where the connection originates to begin drawing, then click the location (node) 
where you want the line to bend. Click an already drawn wire node or line segment to complete the 
connection. If you connect to a line segment, a node will be created there.

■ Connect Multiple Hotspots in a Single Operation

Method 1 <Ctrl> Key Combinations
If you hold down the <Ctrl> key when finishing dragging, a wire will be drawn at all origin hotspots.
The wire will be connected to the destination hotspot you dragged and those that come after.

 

Begin dragging from the connection origin hotspot, then press the <Ctrl> key after aligning the 
mouse pointer with the hotspot you will connect too. A wire will be displayed below the destination 
hotspot. Finish dragging while holding the <Ctrl> key down. 

Method 2 Connect Multiple Selected Hotspots
Select multiple hotspots using <Shift> + click and <Ctrl> + click, then drag from one of the 
selected hotspots to the destination hotspot. The selected multiple origin hotspots will all be 
connected. 

NOTE

A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME 
object's Cascade port. 

Press <Ctrl> Key

Multiple Hotspots Selected
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Method 3 Using Shortcuts
Press the [F2] key to select the uppermost open hot spot to the right of the selected object and 
begin drawing a wire.

Press <Shift> + [F2] to select the uppermost open hot spot to the left of the selected object and 
begin drawing a wire.

Press the [F4] key to connect the uppermost open hot spot to the right of the selected object and 
the uppermost open hot spot to the left of the object on the right.

Press <Shift> + [F4] to connect the uppermost open hot spot to the left of the selected object and 
the uppermost open hot spot to the right of the object on the left.
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Press the [F5] key to connect the uppermost open hot spot to the right of the selected object and 
the uppermost open hot spot to the left of the object on the right, and continue automatically 
making sequential connections until no more open ports are available on either object. Automatic 
connections will not be made over other objects.

Press <Shift> + [F5] to connect the uppermost open hot spot to the left of the selected object and 
the uppermost open hot spot to the right of the object on the left, and continue automatically 
making sequential connections until no more open ports are available on either object. Automatic 
connections will not be made over other objects.

Press the [F8] key to clear all wires connected to the selected object.

■ Starting Drawing from the End Point/Node/Line Segment of an Existing Wire
You can draw from the end or midway point of an existing wire. If you start from a node or line 
segment, a branch line will be created. 

Method 1 Continue Drawing from a Wire End Point
When continuing an existing wire, right-click on the wire end point, then click [Continue Wire] on 
the displayed context menu. 

NOTE

When multiple objects are selected these operations apply to the first object selected.

NOTE

These shortcuts can be changed as required.
→ See Chapter 3 Main Panel Window, “Shortcut Keys” on page 134.
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Method 2 Start Drawing from a Node 
Right-click on a wire node, then click [Start Wire] on the displayed menu. You can start a branch 
wire from the node you clicked on. 

Method 3 Start Drawing from a Line Segment 
Right-click on a wire line segment, then click [Start Wire] on the displayed menu. A node will be 
created at the point you right-clicked, and you can start a branch wire from that node. 

■ Drawing from Anywhere on the Sheet
Right-click the start position for drawing, the click [Start Wire] on the context menu that is 
displayed. Click the location where the line should bend, then double-click at the end location to 
finish drawing. 

■ Finishing Drawing
When the hotspots or already drawn wires are connected, drawing is finished. 
To finish drawing without connecting to a hotspot, use one of the following methods:
• Right-click the mouse
• Double-click
• Press the <Esc> key
Drawing also finishes if another window is made active. 
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Wire Editing
You can delete wires, change node positions, connect to other wires, and perform other wire edit 
operations. 

■ Delete

Deleting an Entire Wire
Right-click the wire then click [Delete Wire] in the context menu

Deleting Nodes
Nodes can be deleted by selecting them and pressing the <Delete> key. Nodes on both sides of 
the deleted node will become directly connected. 

■ Editing by Dragging

Moving Nodes
You can move nodes by dragging them with the mouse.

When multiple nodes are selected and dragged with the mouse, you can move all selected nodes 
simultaneously. 

Selected Node
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Moving Line Segments
To move a line segment, select the nodes on both sides of the segment, and drag one of the 
nodes. 

■ Connecting to Other Wires
If you drag a node and lay it over another wire, the two will be connected at that position. If you 
drag it to a line segment, a node will be created. 

Logical connection
A connection from a source (output side) signal to a destination (input side) signal is called a “logical 
connection.” If a logical connection is present in a configuration, the actual hardware signal will be 
connected. A single wire can make a single logical connection.
Logical connections are possible only in the Configuration window and the User Module window. 
Wires in the Area window or Zone window can be drawn for display only. Even in the Configuration 
window and User Module window, you can also draw wires for display only. 

■ Situations Where No Logical Connection Is Created
• Both sides are source (output side) signals
• Both sides are destination (input side) signals
• Two source (output side) signals are connected to a destination
• There are two destination (input side) signals, and the wire is not connected to a source (output 

side) signal. 

Window Wire

Area Window Drawing for display only

Zone Window Drawing for display only

Configuration Window Logical connection and drawing for display only

User Module Window Logical connection and drawing for display only

Created Node
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Adding, Deleting, and Renaming a Zone
At least one zone is included within an area. In the default Area window that zone will be named 
[Zone1]. Multiple zones can be arranged in an Area. 
When you click the [Zone] command on the [Tools] menu, the “Zone” dialog box is displayed. Here 
you can add, delete, or rename a zone.

Zone List
Lists the zones included in the project. To change settings for a zone, select it by clicking it in the 
list. 

[Add] Button
Adds a zone. Clicking here displays the “Please enter new name” dialog box. Enter a new name, 
then click [OK]. A zone will be added. 

[Delete] Button
Deletes the zone selected on the list. Clicking here displays the “Are you sure?” dialog box. Click 
the [OK] button, and the zone will be deleted. Click the [Cancel] button, and the deletion will be 
cancelled. 

NOTE

A minimum of one zone is required. When only one zone remains, deletion is impossible.
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[Rename] Button
Changes the name of the zone selected on the list. Clicking here displays the “Enter new name for 
the current zone name” dialog box. Enter a zone name, then click the [OK] button.

[Close] Button
Closes the “Zone” dialog box.

NOTE

The current name of the zone you will be renaming is displayed in the “Current Zone Name” box of the “Enter new name 
for current zone name” message.
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Adding, Deleting, and Renaming a Configuration
At least one configuration is included within a zone. In a new Zone that configuration will be named 
[Configuration1]. You can add configurations as required. 
When you click the [Configuration] command on the [Tools] menu, the “Configuration” dialog box is 
displayed. Here you can add, delete, or rename a configuration.

Configurations
Lists the configurations included in the zone being edited. To change settings for a configuration, 
select it by clicking it in the list. 

[Add] Button
Adds a configuration. Clicking here displays the “Please enter new name” dialog box. Enter a 
configuration name, then click [OK]. A configuration will be added. 

[Delete] Button
Deletes the configuration selected on the list. Clicking here displays the “Are you sure?” dialog 
box. Click the [OK] button, and the configuration will be deleted. Click the [Cancel] button, and the 
deletion will be cancelled. 

NOTE

A minimum of one configuration is required. When only one configuration remains, deletion is impossible.
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[Rename] Button
Changes the name of the configuration selected on the list. Clicking here displays the “Enter new 
name for the current configuration” dialog box. Enter a configuration name, then click the [OK] 
button.

[Close] Button
Closes the “Configuration” dialog box.

NOTE

The current name of the configuration you will be renaming is displayed in the “Current Configuration Name” box of the 
“Enter new name for current configuration name” message.
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Area Window
In the Area window, the area is designed by arranging objects on a design sheet, When you click 
“Area” in the Navigator window, the Area window becomes active. You can also open the Area window 
using the [Area] command in the [View] menu.
The following objects can be arranged in the Area window: 
• Zone
• External Device
• Picture
• Text
• Box
• Ellipse
• Wire
• Legend

■ Title Bar
You can move windows by dragging the title bar. 

■ Zone
Zones are added and deleted using the “Zone” dialog box. You cannot perform operations such as 
deletion, cut, or copy. You can change the position and design of zone objects in the Area window. 
Double-click to open a Zone window. 

■ Objects
You can perform edit operations such as arrange, cut, copy, paste, delete, and move on all objects 
except zones. 

Title Bar
Menu Bar

Tool Bar

Toolkit Window

Zones

Picture 
(Image)

Sheet

Text (Text Object)

Box 
(Rectangle)

Ellipse (Circle)

Legend

Wire (Line)

Wire
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Arranging Objects
Objects other than zones can be placed in the window by dragging them from the Toolkit window. You 
can also place objects by double-clicking them in the Toolkit window. You can also display the [Area 
Parts List] from the [Tools] menu or from the context menu that appears when you right-click on the 
sheet. 
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Zone Window
In the Zone window, the zone configuration is designed by arranging zone devices on a design sheet, 
A zone configuration can be created that is the same as the actual hardware arrangement. 
To display the Zone window, double-click in the Area window. When you click a configuration in the 
Navigator window, it becomes active.
The following objects can be arranged in the Zone window: 
• DME
• ICP
• External Device
• Picture
• Text
• Box
• Ellipse (Circle)
• Legend

■ Title Bar
Displays the zone name you have in the “Zone” dialog box. There is always one zone named [Zone 
1] in a newly created project. 

■ Configuration
You can create multiple configurations within a zone, but they cannot be arranged within the Zone 
window. There is a Zone window for each configuration where devices can be arranged. To switch 
configurations, click the desired configuration in the Navigator window. 
You can add, delete, and rename configurations in the “Configuration” dialog box.

DME ICP

Title Bar
Menu Bar

Tool Bar

Toolkit Window Sheet

External Device

Picture (Image)

Text 
(Text Object)

Box (Rectangle)

Ellipse (Circle)

Legend
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■ Objects
You can perform edit operations such as place, cut, copy, paste, delete, and move to devices and 
shapes. If you double-click on a device arranged in the window, a Configuration window or dialog 
box will open.

Arranging Objects
You can place objects by dragging them from the Toolkit window. You can also place objects by 
double-clicking them in the Toolkit window. The same objects are displayed in the [Device List] 
submenu on the context menu that appears when you right-click the [Tools] menu or on the sheet. 
For information about the “Device List,” see page 154.

■ DME Arrangement
To place a DME object, first drag the [New] icon. When you drag the [New] icon and place it in the 
Zone window, you also add an icon for that DME to the Toolkit window. You can rename the DME in 
the “DME Device Properties” dialog box. This also renames the DME icon in the Toolkit Window.
You can place a created DME in another configuration, but you cannot place multiple identical 
DMEs in a single configuration. If there are multiple DMEs in a hardware configuration, create an 
equivalent number of DME objects. 

Device Action When Double-Clicked

DME Displays Configuration Window

ICP Displays “Control Panel Properties” dialog box

External Device Opens external application linked to the device.

Place New DME

Placed DME

DME not placed in
active configuration
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Placing a New DME
Below the DME folder in the Toolkit window are the [DME24N] and [DME64N] folders. Below these 
folders you will find a [New] icon. Drag it to the Zone window. 

When you drag the [New] icon and place it in the Zone window, you also add an icon for that DME 
to the Toolkit window. 

A DME added to the Toolkit window cannot be placed again in the same configuration window. The 
DME placed in the Toolkit window will be displayed with a muted color.
To place multiple DMEs, drag the [New] icon to add each DME. 

Placing Existing DMEs
When there are multiple configurations, you can place existing DMEs in configurations other than 
their original one.
Drag the DME icon created in the Toolkit window to the Zone window. 
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When you place the DME in the Zone window, the DME icon display in the Toolkit window will 
change to a muted color that indicates that it has already been placed. 

■ ICP Placement
Just like for a DME, the first step it placing an ICP is to drag the [New] icon from the Toolkit window. 
You can place the created ICP in another configuration, but you cannot place multiple identical 
ICPs in a single configuration. If there are multiple ICPs in a hardware configuration, create an 
equivalent number of ICP objects. 

Placing a New ICP
Subordinate to the ICP folder in the Toolkit window is the [ICP1] folder. Below these folders you will 
find a [New] icon. Drag it to the Zone window. 

ICP not placed in
active configuration

Placed ICP

Place New ICP
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When you drag the ICP [New] icon and place it in the Zone window, you also add an icon for that 
ICP to the Toolkit window. 

The ICP added in the Toolkit window will be displayed with a muted color to indicate it has already 
been placed. To place multiple ICPs, drag the [New] icon to add each new ICP. 

Placing Existing ICPs
When there are multiple configurations, you can place existing ICPs in configurations other than 
their original one.
Drag the ICP icon created in the Toolkit window to the Zone window. 

The ICP will be placed in the Zone window. The ICP added in the Toolkit window will be displayed 
with a muted color to indicate it has already been placed.
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Configuration Window
The Configuration window is used for arranging components on the sheet and making logical 
connections. It is displayed when you double-click on a DME. 

■ Title Bar
Displays “DME Name (Zone Name).” The configuration window for a DME64N placed in [Zone1] 
will be “DME64N (Zone1).” The DME name is set in the properties for the DME placed in the Zone 
window. 

■ Objects
Objects such components, user modules, and shapes are arranged in the Configuration window. 
When you double-click a component placed in the window, the component editor will open. If you 
double-click a user module, the user module will open.

■ I/O Component 
Depending on the settings for the DME placed in the Zone window, I/O components will be 
automatically placed or added. 
• I/O components can be arranged in the DME24N configuration window.
• When “Show Cascade Port” is ON in the DME64N “DME Device Properties” dialog, Cascade I/O 

is added automatically.
• When you set a slot in the properties for a DME placed in the Zone window, Slot I/O will be 

automatically added. 

You cannot apply edit operations like cut/copy/paste/duplicate to I/O components, Slot I/O, and 
Cascade I/O.

Title Bar
Menu Bar

Tool Bar

Toolkit Window
Sheet

User Module

Component

Wire

I/O Component 

Legend
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Placing Components
You can place objects by dragging them from the Toolkit window. You can also place objects by 
double-clicking them in the Toolkit window. The same objects are displayed in the [Component List] 
submenu on the [Tools] menu or on the context menu that appears when you right-click on the sheet. 
For information about the [Component List] in the Configuration window, see page 154.

■ Arranging a Number of Components of the Same Type
You can arrange a number of components of the same type. If there are two or more of the same 
component, numbers will be attached to their names as follows: “Compressor (2),” “Compressor 
(3)” and so on. Multiple components placed in the configuration are independent, and you can set 
different parameters for each of them. 

NOTE

If the [Matrix Mixer 64 input 64 output] or the [Matrix Mixer 64 input 32 output] components are placed in the DME64N 
configuration window, you will not be able to use other components, even though the window does not reach 100 percent. 
The [Matrix Mixer 64 input 64 output] or [Matrix Mixer 64 input 32 output] components cannot be used in the DME24N.
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Probe Monitor
Probe monitor is a function that lets you monitor output ports in your configuration with headphones. 
You can turn it ON or OFF using [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on 
the toolbar. The probe monitor can be set to ON or OFF for each DME. 

The probe monitor can be used only when online with the DME and Configuration window or user 
module active. When the probe monitor is ON, no editing is possible except in the Component Editor.

■ Probe Monitor Procedure

1 Turn the probe monitor ON. 
Click [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on the toolbar. 
The shape of the mouse pointer changes. 

2 Click the output port you want to monitor. 

The output port you clicked will be selected and monitoring will begin. 

If you click another output port, the location being monitored will change. 

Monitor object
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■ L/R Selection
To monitor the left channel and right channel simultaneously, <Shift> + click on the left channel, 
then do the some for the right channel. 

■ Exiting the Probe Monitor
Click [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on the toolbar to turn OFF 
the probe monitor. When probe monitor is turned off, the mouse pointer returns to its normal shape. 

■ Monitoring the Second or Later Time
The software remembers the location being monitored even when probe monitoring is turned OFF. 
The next time probe monitoring is turned ON, the location that was being monitored previously will 
be selected. 

NOTE

If the configuration is edited after turning monitoring OFF, the monitor location will not be selected.
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Show Signal Delay (Delay Display Value)
The signal delays according to the processing time in the audio processor. The [Show Signal Delay] 
command from the [Tools] menu calculates a delay value and displays it for the component. Selecting 
this command switches delay value display between ON and OFF. A checkmark appears when 
display is turned ON. 
When turned ON, the settings are compiled to obtain a delay value, which is displayed for 
components and lines. The delay value obtained through compilation remains valid until the 
configuration is edited. Sample units are used to display the delay value. 
This corresponds to the [Show Signal Delay] button on the toolbar. 

ON and OFF settings for [Show Signal Display] are saved for each configuration window. Switching 
the setting between ON and OFF in another configuration window has no effect on the current window. 
You can edit the configuration while [Show Signal Delay] is turned ON. 

Delay values for components and I/O components are displayed at the lower center of the object. 

Delay values for wires are displayed beside the input port of the connected object. 

NOTE

Delay values for SPX components vary depending on the Bypass ON/OFF status, because SPX components add the effect 
signal to the original signal. When [Show Signal Delay] is turned ON, the delay value for the Bypass ON status will be 
displayed.

NOTE

Delay values for Wav File Player components are displayed for external inputs. Delay values for local Wave files cannot be 
displayed.

When you turn ON [Show Signal Delay], the delay value appears 
above the object.
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Monitoring Point List
When you click [Monitoring Point List] in the [Tools] menu, the “Monitoring Point List” dialog box is 
displayed. Here you can register or edit points for monitoring with headphones. 

■ [Cut] Button
Cuts the selected monitoring point information. When monitoring point information is cut, 
information below that point moves up. 

■ [Copy] Button
Copies the selected monitoring point information. 

■ [Paste] Button
Pastes the copied monitoring point information at the selected line. 

■ [Insert] Button
The copied monitoring point information is inserted at the selected point. 

■ [Clear] Button
Deletes the selected monitoring point information. 

NOTE

Monitoring points can be edited only by users for whom the [Edit] security checkbox has been turned ON. 
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■ Monitoring Point List
Displays and allows editing of monitoring point information. 

[No.]
Displays the numbers for monitor link points. Numbers are assigned in order from the top. 

[Label] 
Displays and allows editing of monitoring point names. Clicking here selects the text. You can then 
enter a new name. 

[Component L]
Sets the monitoring point L channel component. Clicking here displays a list of components 
arranged in the active configuration window. You can then select components for monitoring. 

[Port L]
Sets the monitoring point L channel port. Clicking here displays a list of ports for the component 
selected in the [Component L] field. Click the port you want to monitor. 

[Component R]
Sets the monitoring point R channel component. Clicking here displays a list of components 
arranged in the active configuration window. You can then select components for monitoring. 

[Port R]
Sets the monitoring point R channel port. Clicking here displays a list of ports for the component 
selected in the [Component R] field. Click the port you want to monitor. 

■ [OK] Button
Updates the settings and closes the dialog box. 

■ [Cancel] Button
Closes the dialog box without changing the settings. 

NOTE

Components arranged in user modules are also displayed in the list. However, components for user modules for which 
security is set will not be displayed. 

NOTE

If you click a port in the designer window while the “Monitoring Point List” dialog box is displayed, the port will be 
registered to the monitoring point of current selected row. If you will register the monitoring points as stereo, click a port 
while holding down the <Shift> key to register Component L and Port L, then click a port again while holding down the 
<Shift> key to register Component R and Port R.

NOTE

Components arranged in user modules are also displayed in the list. However, components for user modules for which 
security is set will not be displayed. 
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Analyze (Configuration Analysis)
When you click the [Analyze] command on the [Tools] menu or the [Analyze] button on the toolbar, the 
“Analyze” dialog box is displayed. The wire connections in the currently active configuration window 
are analyzed, and the results are displayed in the “Analyze” dialog box. 
Because this function allows you to make sure there are no problems with component arrangement 
and wires without connecting to the DME unit, it is useful for eliminating complier errors before 
executing Synchronization. 

■ Message Box
Displays the progress of the analysis operation. When the analysis finishes, the results are 
displayed. 
If errors are detected during analysis, they will display as shown below. 

■ [Close] Button
Closes the dialog box. 

NOTE

The [Analyze] command on the [Tools] menu can be selected only when a configuration window is active. 
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User Module

User Modules
A module treated as a single component that combines a number of other components is called a 
“user module.” A user module can be arranged in the Configuration window just like any other 
component. User module editing consists of placing the component and making logical connections 
with wires, the same as for configurations. 
User modules are saved in the project file, but they can also be saved as files. User modules saved as 
files can be displayed in the Toolkit window and used in other project files. 
A “User Modules” folder will be created in the folder specified in [Contents Folder] in the “Preferences” 
dialog box in the Main Panel window. User modules will be saved there. If you do not change the 
setting in the “Preferences” dialog box, the location will be “C:\Program Files\YAMAHA\OPT Tools\DME 
Designer\User Modules.”

User Module Manager
When you click [User Module Manager] on the [Tools] menu, the “User Module Manager” dialog box is 
displayed. You can change settings, rename or delete in the window that opens when you double-
click a user module. 

■ User Modules
Lists user modules that are saved in the “User Modules” folder. Select the target user module by 
clicking on it. 

NOTE

The Main Panel Menu “Preferences” dialog box is displayed using [Preference] in the [File] menu.

NOTE

Only user modules saved can be displayed. User modules placed in the component editor are saved in project files, and 
can be used without being saved as files. However, they will not be displayed in the “User Module Manager” dialog box 
list. 
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■ Double Click Action
Sets the action that occurs when you double-click on a user module placed in the Configuration 
window. 

[Open User Module Design Window]
Opens the User Module window.

[Open User Module Editor] 
Opens the User Module editor. The user module editor is a window where controls for components 
that are placed in a user module can be laid out and their parameters changed. For more 
information about the user module editor, see “User Control/User Module Editor” on page 279.

■ Security Settings
Makes security settings for the user module selected on the list.

[Enable Security]
Enables user module security. If security is enabled, a password is requested when attempting to 
open the User Module window. If the correct password is not entered, the window will stay closed.
When you place a checkmark here, the “Set Password” dialog box appears. Enter the same 
password into the [Password] box and [Confirm Password] box, and click the [OK] button. 

To disable user module security, turn OFF the checkbox. If you click the checkbox when it already 
has a checkmark, the “Input Password” dialog box appears. Enter the password set for this user 
module, and click the [OK] button. You can disable security in this way. If you do not enter the 
correct password, you will not be able to disable security. 

[Set Password] Button
Changes the password. Clicking here displays the “Input Password” dialog box. Enter the current 
password and click the [OK] button. The “Set Password” dialog box will be displayed. Enter the 
same password into the [Password] box and [Confirm Password] box, and click the [OK] button. 

■ Default Library
Specifies the default library file for newly-created user modules.
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■ [Rename] Button
Changes the name of the user module selected on the list. Clicking here displays the “Rename 
User Module” dialog box. Enter a name into the user module name box, and click the [OK] button. 

■ [Delete] Button
Deletes the user module selected on the list.

■ [Import] Button
Imports the user module settings and library from the user module export file.

■ [Export] Button
Saves the user module settings and library to the user module export file.
Click to display the Export dialog, All features of this dialog window are the same as the standard 
Windows file save dialog, except for the [Export Library] option.
[Export Library] can be sued to select the library to be saved.

■ [Import Library] Button
Loads a file from the specified folder into the library.

NOTE

The user module name also becomes the file name. When naming a user module, do not use characters that cannot be 
used for filenames.
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■ [Export Library] Button
Saves the library to a file.
Use [Export Library] to select the library to be saved.

■ [OK] Button
Accepts the changed settings and closes the dialog box.

■ [Cancel] Button
Closes the dialog box without changing the settings.

NOTE

Settings in the “User Module Manager” dialog box are changed when you click the [OK] button. If you mistakenly set 
security, change the password, or delete a user module, you can click the [Cancel] button to close the dialog box and 
return to the original unchanged settings.
Please note that [Import], [Export], [Import Library], and [Export Library] will be applied even if the [Cancel] button is 
clicked.
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Creating User Modules
When you place a blank user module in the Configuration window, a new user module is created.

1 Make the Configuration window active.

2 Click the [+] next to [User Module] in the Toolkit window. 
The items in the level below the [User Module] folder will be displayed. 

3 Drag the [Blank User Module] to the Configuration window.

When you release the mouse button at the location where you will place the user module, the “User 
Module Properties” dialog box is displayed. 

4 Here you can set object properties. 
[Inputs/Outputs Sets] is set to 1. Set the required number of ports. 

5 Click the [OK] button. 
A user module will be created, and placed in the Configuration window. 

The user module properties can also be changed later. For information about the “User Module 
Properties” dialog box, see “User Module” on page 181.
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Saving User Modules
When user modules are saved, they appear below [User Module] in the Toolkit window. They can be 
used in other project files. 

Save the User Module using the [Save User Module] command on the [Tools] menu. The [Save User 
Module] command can be used only when a user module is selected in the Configuration window. 
When you select the command, the “Save User Module” dialog box will be displayed. Enter a name for 
the User Module, then click the [OK] button.

Set [Double Click Action] and [Security Settings] at the lower part of the “Save User Module” dialog 
box. 
They correspond to the same items in the “User Module Manager” dialog box. When saved with 
different settings than the “User Module Manager” dialog box, the saved settings are immediately 
applied.

■ Double Click Action
Sets the window that opens when you double-click on a user module placed in the component 
editor. 

[Open User Module Design Window]
Opens the User Module window.

[Open User Module Editor] 
Opens the User Module editor.

NOTE

User modules placed in the component editor are saved in the project file. When you want to use a user module in another 
project or in another configuration in the same project, save it using the “Save User Module” command. 
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■ Security Settings
Sets user module security. 

[Enable Security]
Enables user module security. 
If you place a checkmark here, the “Set Password” dialog box appears. Enter the same password 
into the [Password] box and [Confirm Password] box, and click the [OK] button. 

[Set Password] Button
Changes the password. Clicking here displays the “Input Password” dialog box. Enter the current 
password and click the [OK] button. The “Set Password” dialog box will be displayed. Enter the 
same password into the [Password] box and [Confirm Password] box, and click the [OK] button. 

If you try to save a user module with the same name as an already saved user module, a message 
asking “This file already exists. Overwrite?” will be displayed. To overwrite, click the [Yes] button. To 
change the name, click the [No] button, and change the file name in the “Save User Module” 
dialog box. 

NOTE

When the “Save User Module” dialog box is displayed, the name set in the user module’s “User Module Properties” 
dialog box will be entered into the [File name] box. If you change the name of a user module and save it using the “Save 
User Module” dialog box, the filename in the user module and the user module name displayed in the Toolkit window will 
also change.
The [Label] box displayed in the “User Module Properties” dialog box will not change.

NOTE

If characters not usable in file names are used in the file name set in the “User Module Properties” dialog box, an error 
message will be displayed at the same time as the “Save User Module” dialog box. Delete the unusable characters 
before saving. 
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User Module Window
User modules are edited in the User Module window. The User Module window is used for arranging 
components on the sheet and making logical connections. It is displayed when you double-click on an 
object arranged in the Configuration window.

■ Title Bar
The user module names are displayed on the title bar. User module names are set in the “User 
Module Properties” dialog box.

■ Objects
You can place, cut, copy, paste, delete, and move component and shape objects. When you 
double-click an object placed in the window, the component editor will open. 

■ Placing Components
Components are placed the same as in the Configuration window. 
You can place objects by dragging them from the Toolkit window to the User Module window. You 
can also place objects by double-clicking them in the Toolkit window. The same objects are 
displayed in the [Component List] submenu on the [Tools] menu or on the context menu that 
appears when you right-click on the sheet. 
For information about the User Module window [Component List], see page 155.

Title Bar
Menu Bar

Tool Bar

Component

Wire
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■ Placing a Number of Components of the Same Type
You can arrange a number of components of the same type. If there are two or more of the same 
component, numbers will be attached to their names as follows: “Compressor (2),” “Compressor 
(3)” and so on. Multiple components placed in the configuration are independent, and you can set 
different parameters for each of them. 
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Types of Components

Component Groups
When the Configuration window and User Module window are made active, a component list is 
displayed in the Toolkit window, and you can use the [Component List] on the [Tools] menu. 
Components can be separated into groups based on types. In the Toolkit window, component groups 
are displayed as folders. Some of the groups in the Toolkit window are further divided into subgroups. 
Click the [+]/[-] buttons to the left of the folders to display the components. 

NOTE

When the User Module window is active, [User Module] is not present on the menu.

Group

Component
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In the Designer window [Tools] menu → [Component List] menu, component groups are displayed as 
submenu items.
The items with small rightward-facing triangles are groups. Those without triangles are components. 

Component List

NOTE

When the User Module window is active, [User Module] is not present in the menu.

Group Component Variations

Crossover 2 Way
3 Way
4 Way
5 Way
6 Way

Crossover Processor 2 Way
3 Way
4 Way
5 Way
6 Way

Crossover Processor II 2 Way
3 Way
4 Way
5 Way
6 Way

Delay Long 1 Output
2 Output
3 Output
4 Output
5 Output
6 Output
7 Output
8 Output

Short 1 Output
2 Output
3 Output
4 Output
5 Output
6 Output
7 Output
8 Output

Group

Component
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Dynamics Compander CompanderH Mono
Stereo

CompanderS Mono
Stereo

Compressor Mono
Stereo

De-Esser Mono
Stereo

Ducking Mono
Stereo

Expander Mono
Stereo

Gate Mono
Stereo

Limiter Mono
Stereo

EQ GEQ Mono 7 Band
15 Band
31 Band

Stereo 7 Band
15 Band
31 Band

PEQ Mono 2 Band
3 Band
4 Band
6 Band
8 Band

Stereo 2 Band
3 Band
4 Band
6 Band
8 Band

Fader 1 Channel
2 Channel
4 Channel
8 Channel
12 Channel
16 Channel

Filter BPF Mono
Stereo

HPF Mono
Stereo

LPF Mono
Stereo

Notch Mono
Stereo

Programmable BPF Mono
Stereo

Programmable HPF Mono
Stereo

Programmable LPF Mono
Stereo

Meter 1 Channel
2 Channel
4 Channel
8 Channel
12 Channel
16 Channel

Miscellaneous Oscillator Mono

Wav File Player

Group Component Variations
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Mixer Auto Mixer 2 Channel
4 Channel
8 Channel
12 Channel
16 Channel

Delay Matrix 2 Input 2 Output
4 Output
8 Output
12 Output
16 Output

4 Input 2 Output
4 Output
8 Output
12 Output
16 Output

8 Input 2 Output
4 Output
8 Output
12 Output
16 Output

Matrix Mixer 2 Input 1 Output
2 Output

4 Input 1 Output
2 Output
4 Output

8 Input 1 Output
2 Output
4 Output
8 Output

12 Input 1 Output
2 Output
4 Output
8 Output
12 Output

16 Input 1 Output
2 Output
4 Output
8 Output
12 Output
16 Output

32 Input 16 Output
32 Output

64 Input 32 Output
64 Output

Pan LCR 1 Channel
2 Channel
4 Channel
8 Channel
12 Channel
16 Channel

LR 1 Channel
2 Channel
4 Channel
8 Channel
12 Channel
16 Channel

Surround 3-1
5.1
6.1

Group Component Variations
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Router 1 Input 2 Output
4 Output
8 Output
12 Output
16 Output

2 Input 2 Output
4 Output
8 Output
12 Output
16 Output

4 Input 2 Output
4 Output
8 Output
12 Output
16 Output

8 Input 2 Output
4 Output
8 Output
12 Output
16 Output

12 Input 2 Output
4 Output
8 Output
12 Output
16 Output

16 Input 2 Output
4 Output
8 Output
12 Output
16 Output

Source Selector 3 Position 1 Channel

4 Position 1 Channel
2 Channel
6 Channel

8 Position 1 Channel
2 Channel
6 Channel

16 Position 1 Channel

Speaker Processor 1 Way
2 Way
3 Way
4 Way
5 Way
6 Way

SPX

Slot Slot In Component Editor
Slot Out Component Editor

Cascade Cascade In Component 
Editor
Cascade Out Component 
Editor

Group Component Variations
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Component Editor Window

Component Editor
Component parameters are edited in the component editor. The same component can be placed 
multiple times on the same sheet in a Configuration or User Module window. If there are multiple 
examples of the same component in a configuration window or user module window, each component 
is independent and its parameters are set individually in a separate Component Editor window.

Opening the Component Editor
When you double-click on a component located in a Configuration window, the Component Editor 
window will open. There is not just one window that is called the component editor. The contents of the 
editor and the name on the title bar will differ according to type of component for which the window 
was opened. 

Component Editor Window Structure
The contents of the Component Editor window vary according to the component.

■ Title Bar
Displays the label. Label settings are made in the “Component Properties” dialog box. For 
information about component labels see “Component” (page 174) in “Objects.”.

Title Bar

Library

[ON] Button

Graph

Knob

Meter

Slider

Edit Box

Snap

Back Button
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■ Back Button
This button appears in the child window of windows that have a parent-child relationship, and can 
be clicked to return the parent window.

■ Status Bar

Component Name
Displays the component name. 

Component ID
Displays the component ID. 

Parameter ID
Displays the parameter ID for controls that are being operated. 

■ Snap
Up to four component editor parameter sets can be recorded temporarily. You can switch between 
parameter sets using buttons. 
Parameter sets can be copied by dragging and dropping a button onto any other button. Copy can 
also be carried out from the contextual menu that appears when a button is right-clicked.

■ Library
Saves and recalls component editor parameter sets as files. 
→ See “Library” on page 275.

■ Graph
Displays the effects of the component in a graphical format. When parameters are changed, the 
graph changes too. In graphs that have control points, adjust parameters by dragging the points. 
As you drag the points, the corresponding parameters reflect the changes you make. 

■ Meter
Displays the signal level.

■ Slider/Knob
You can change parameters by dragging the corresponding sliders or knobs. 

NOTE

When controlling the DME64N/24N by connecting an RS-232C compatible controller to the [REMOTE] terminal, a 
component ID is required for distinguishing the same components in the DME64N/24N. The component ID is included in 
the signal that controls the component parameters. For details about control methods, contact your nearest Yamaha 
representative or the authorized distributor at the end of the DME64N/24N Owner’s Manual.

Component Name

Component ID

Parameter ID
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Changing Parameters
In the Component Editor window, parameter settings can be made by dragging buttons and sliders, 
not only by directly entering numbers. In locations where multiple controls, like edit boxes and knobs, 
are combined, you can change the values either way. 

■ Preference
When you click the [Preference] command on the [File] menu in the Main Panel window, the 
“Preferences” dialog box is displayed. You can set the action of the knobs and sliders on the 
[Component Editor] tab of the “Preferences” dialog box. 
When you close the dialog box after changing settings, those changes are immediately reflected in 
the component.

Knob Mode
Sets how the knobs operate. 

Slider Mode
Sets the action that occurs when you click on the scale located under the sliders. 

Edit Box Zoom
Specifies whether the edit box will be enlarged or not on mouse-over.

Edit Box Font
Specifies the edit box font.

NOTE

This is the font when the box is enlarged, not the font that is used when the box is at it's smallest size. The text may bleed 
beyond the box with some fonts.
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■ Knob

You can change the way knobs operate, using the [Component Editor] tab → [Knob Mode] setting 
in the “Preferences” dialog box. 

Circular
The knob is dragged following its shape, as though you were drawing a circle.

Linear
As you drag the knob to the upper, the value increases. Dragging it down decreases the value. 

NOTE

To make a finer setting, press the <Shift> key while dragging the knob.
If you click a knob while pressing the <Ctrl> key, the setting will return to its default value.
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■ Slider

You can change the parameter by dragging the slider.
You can set the action that results from using the mouse on the scale area with [Component Editor] 
tab → [Slider Mode] in the “Preferences” dialog box.

Ramp
When the fader bar is clicked the knob will move a preset amount in the corresponding direction. 

Touch
The slider does not move without directly touching it, even if you click the mouse button. 

Jump
The slider jumps to the location where you click.

NOTE

To make a finer setting, press the <Shift> key while dragging the slider.
If you click a slider while pressing the <Ctrl> key, the setting will return to its default value.

Scale

Slider
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■ Buttons
There are several types of buttons. 

Switches between ON/OFF. When turned on, the button lights up. The color depends on the 
button’s function.

In button sets of this type, you can select one of several buttons. When you do all other buttons in 
the set turn off.

Click here to execute a command. 

Displays a menu.

When turned ON When turned OFF

Click this button

to switch all channels 
in the block.
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Displays another window. 

■ Edit Box

Displays current values for settings. You can modify values by typing from the keyboard or using 
the mouse. When a value is changed, the knob or slider moves. 

Mouse-over
When [Edit Box Zoom] in the [Component Editor] tab of the Preferences dialog box is checked, the 
edit box will zoom when the mouse is positioned over it (mouse-over).

Click
Text in the selected edit box will turn red. Values can be entered and edited via the keyboard. It is 
not necessary to enter the unit. Press the <ENTER> key to confirm the entry and display the unit.

Changing Values Using Spin Boxes
When the mouse pointer is placed over an edit box, a spin box appears. Clicking the up arrow 
button [▲] increases the value, while clicking the down arrow [▼] decreases it. 
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Double-click
Selects a number. You can change the selected number using the keyboard. There is no need to 
enter units. When you press the <Enter> key, the numbers you entered will be set and the units 
displayed. 

Moving with the <Tab> Key
If you press <Tab> key while an edit box is selected, the selection will move to the next edit box. 
If you press <Shift> + <Tab>, the selection moves to the previous edit box. 

Changing Selections with the Key/Mouse Wheel
You can modify values in selected edit boxes using the direction keys or the mouse wheel. 

• Up and Down Arrow Keys
Increases or decreases number settings.

• <PageUp> Key/<PageDown> Key
Increases or decreases number settings in large increments. The <PageUp> key increases 
and the <PageDown> key decreases the setting.

• <Enter> Key
When you press the <Enter> key, the numbers you entered will be confirmed. 

• <Ctrl> Key + <Enter> Key
When you press the <Ctrl> + <Enter> key, the setting will return to its default value. 

• Mouse Wheel
Rolling the mouse wheel upward (away from you) increases the value. Rolling it down 
(towards you) decreases the value. 

• Dragging
Dragging upward increases the value, while dragging downward decreases it. 

• <ESC> Key
The <ESC> key can be used to cancel a value being entered.

Enter a number from 
the keyboard.

Set the value with 
the <Enter> key. 
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■ Graph

Displays parameters graphically. When parameters are changed, the graph also changes. 
In graphs that have control points, you can adjust parameters by dragging the points. On graphs 
with control points that are limited to movement in one direction only, aligning the mouse pointer 
with the control point and pressing the mouse button causes the mouse pointer to change to a 
double-headed arrow pointing in both directions of movement. Change the parameter by dragging 
in the directions of the arrow. 
Control points that can be dragged in any direction usually have their position determined by 
multiple parameters in the component editor. These multiple parameters can be adjusted by 
dragging the point. 
When there are multiple control points in the graph, they are identified by their colors. A bar with the 
same color as each control point can be found below the corresponding knob or edit box. 

NOTE

When a graph that has control points is copied to the User Control Editor or User Module Editor, the controls points will 
not be displayed. The controllers assigned to the corresponding parameters must also be copied to display the control 
points.

Control Point
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Snap
About Snap
The Snap function records parameters for the component editor, user control editor, and user module 
editor temporarily. Clicking a button switches the parameter set, setting all parameters in the editor to 
the status that existed when the parameters were recorded in the memory. You can record the current 
values for parameters. Furthermore, when you recall a library, it is recorded to the Snap button that is 
on at that time. For more information about libraries, see “Library” (page 275). 

■ Snap Buttons ([A] through [D])
The Snap buttons allow you to switch between parameter sets. The buttons change in appearance 
according to their ON/OFF status and to whether or not there were changes to the parameter set 
from when the editor was started. 

When there has been no change to the parameter set since the editor was started 
When a button is selected it lights up. 

When a parameter set that is different than when the editor was started has been recorded 
to a button 
The color of the button name changes on buttons for which the parameter set has changed. When 
a button is selected it lights up. 

Snap Buttons

ON  OFF

ON  OFF
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■ Recording Parameter Sets

Recording parameters from the current window
The parameters present when the snap button is switched are recorded to the snap button before 
the switch. 

1 Click the snap button ([A] through [D]) that will record the parameter set. This turns it 
ON. 

2 Set the parameters in the editor to the settings you want to record. 

3 Click another snap button. 

Recalling a Library

1 Click the snap button that has recorded the parameter set. This turns it ON. 

2 The library is recalled. 

■ Switching Parameter Set
If you click a snap button that has a parameter set recorded, the system switches to the parameter 
set recorded there. 

■ Copying Parameter Sets
Parameter sets can be copied between snap buttons [A]~[D].

• Select from the contextual menu.
• Drag and drop.

Drag-and-drop copy will also work between components of the same type.
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Library

The Library
Component editor, user control editor, and user module editor parameters can be saved as library 
files. By reading back a saved library file, you can reset all the editor parameters to the status they had 
when the file was saved. Saving in a library file is called “storing,” while bringing back the settings is 
called “recalling” them. 
Library files have the following file name extensions: “.cel” for component editors, “.ucl” for user 
control editors, and “.uml” for user module editors.

If you store library files in folders that conform to the following path, they will be automatically 
displayed in the component editor [Recall Library] menu: “C:\Program Files\YAMAHA\OPT Tools\DME 
Designer\Editor\Library\Component Group Name\Component Name.” 
The dialog box used for storing items in the library opens with the library folder displayed. 

[Store Library] Button

[Recall Library] Button

[Recall Library] 
Menu
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If you save like this without changing the folder, the item you saved will be displayed on the [Recall 
Library] menu. When a library is saved, it can be displayed in the component editor for other project 
files besides the currently open one, and also in new project files. 

■ Library Filenames
Because the library filenames are displayed in the [Recall Library] menu, use a filename that helps 
you understand the contents of the parameter set in the file. When saving in the default folder, there 
is no need to include the component name in the filename. 
For example, when you are storing a parameter set in the stereo compressor library, the “Save 
Library File” dialog will be displayed with the “C:\Program Files\YAMAHA\OPT Tools\DME 
Designer\Editor\Library\Compressor\Compressor Stereo” folder selected. If you save in that folder, 
the file you save will be displayed only in the [Recall Library” menu for stereo compressor 
components only. It will not be displayed in any other library. 
If you use a filename that makes it easy to understand the parameter contents or the conditions 
under which they are used, you can select them without confusion when recalling. 

Storing in the Library
The library is the place to store component editor parameters. 

■ Editor Window

1 Set the parameters to be stored in the library. 

2 Click the [Store Library] button in the component editor. 
The “Save Library File” dialog box will be displayed.

3 Enter the filename.
Select a filename that makes it easy to understand the contents of the parameter set. 

4 Specify the folder for saving the file. 
If you want the saved file displayed on the [Recall Library] menu, do not change the folder for 
saving. 

5 Click the [Save] button. 

■ Designer Window
Right-click a component or user module in the Designer window to show the contextual menu. Use 
the [Store Component Library] command to store the library.
The menu that appears when the contextual menu [Store Component Library] command is clicked 
is the same as the menu that appears when the Edit window [Store Library] button is clicked. 
Specify a file name and save the file.

NOTE

If you change the [Contents Folder] in the “Preferences” dialog box in the Main Panel window, a “Library” folder will be 
created in the specified folder, and a folder for each component will be created there.

NOTE

In the “Save Library File” dialog box, you can specify another folder for saving library files, and save them there. Library files 
that are saved in another folder also can be recalled by specifying the folder.
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Recalling a Library
The recall function reads stored parameters into the component editor. 

■ Editor Windows
You can recall libraries in the component editor, user control editor, and user module editor 
windows by clicking the [Recall Library] button. When a library is recalled in an editor window, the 
parameter set is recorded to the selected snap button. 

1 Click the snap button ([A] through [D]) that will record the parameter set. 

2 Click the [Recall Library] button in the component editor. 
The [Recall Library] menu will be displayed.

3 Click the library name (filename) in the [Recall Library] menu. 
The parameters in the library will be recalled. 

■ Designer Window
If you right-click on a component or user module in the design window, a context menu will be 
displayed. You can recall a library using the [Recall Component Library] command. 
If you click [Recall Component Library] in the context menu, the same menu is displayed as when 
you click the [Recall Library] button in the editor window. If you select a library that is displayed in 
the submenu, that library is recalled. 

Not only the library name, but also the effect type is displayed in the submenu that appears when 
you right-click on an SPX component. 
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■ Recalling a Library Stored in a Folder Other Than the Default 
Libraries not stored in the default folder do not appear on the [Recall Library] menu. You must 
specify the file you want in order to recall it.

1 Click the [Recall Library] button in the component editor. 
The [Recall Library] menu will be displayed.

2 Click the [Recall Library] menu [Open File Dialog]. 
The “Open” dialog box will be displayed.

3 Move to the correct folder and select a library file. 

4 Click the [Open] button. 
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User Control/User Module Editor

User Control
The user control function lets you lay out a set of component controls in the Configuration window or 
User Module window, and create a control window with them. The controls in the user control editor 
are linked to the controls for the original component. If the parameters are changed in the user control 
editor, the parameters will change in the same way in the component editor. If parameters are 
changed in the component editor, the controls in the user control window will also change in the same 
way. 
You can create a compact control window by only including controls for parameters that are used 
frequently. 
You can also lay out controls for multiple components, so that you can adjust parameters for them from 
a single window. 

There is also a [Library] button in the user control editor, which you can use to save parameters to the 
library. 
User controls are created by selecting [View] menu → [User Control] → [New User Control] in the 
Main Panel window. Created user controls are displayed in the [View] menu → [User Control] 
submenu. If you select one, a window will open for it. The controls which can be opened by the user 
control editor are automatically set according to the user security settings of the currently logged in 
user.

User Control Editor

Laid Out Controls

Edit Palette

Component Editor

Controls Laid Out 
in the User Control
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[User Control] Menu
User controls are displayed in the [View] → [User Control] submenu of the Main Panel window. If you 
click the [User Control] button in the Main Panel window, you will display the same menu as the [View] 
menu → [User Control] submenu. 

User Control Name
Displays a menu of user controls included in the current configuration of the current zone. Clicking 
one of the user controls opens the user control editor. A checkmark appears next to already open 
windows. 

New User Control
When you select the “New User Control” command, the “User Control Manager” dialog box will be 
displayed. Here you can create, delete, rename, and otherwise manage user controls. For 
information about the “User Control Manager” dialog box, see page 70.
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Creating New User Controls
New user controls are added in the “User Control Manager” dialog box. 

1 Click [User Control Manager] on the Main Panel window [Tools] menu. 
The “User Control Manager” dialog box will be displayed.

2 Click the [New] button. 
The “New User Control” dialog box will be displayed.

3 Enter the name for the new user control into the [Name] box. 

4 Sets security for User Control. 
Different settings are provided for individual security levels and users.
Security cannot be set higher than the user security level.

Click the [User Level] [▼] button to select a security level.

NOTE

You can also display the “User Control Manager” dialog box by clicking the [View] menu → [User Control] → [New User 
Control] command.
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Use [User Name] to select a user.

5 Click the [OK] button. 
The user control will be created and displayed on the list in the “User Control Manager” dialog box.

6 Click the [OK] button in the “User Control Manager” dialog box. 
When a new user control is created, it will be displayed in the [View] menu → [User Control] 
submenu in the Main Panel window. If you click the control, it will be displayed in a user control 
editor window.

[Snap] and [Library] appear appears in a new user control.
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User Control Security
Security can be set independently for each User Control. User Control levels higher than the user 
security level will not be displayed in the menu or the User Control Manager dialog box.
The security level settings for both the user control and the user affect editing and display of user 
controls.

■ User Control Security Level
Security 1 ~ 10 can be set for each level or user. Level 1 is the highest level and 10 is the lowest. 
If the security level for a user control is set to 2, only users at level 1 or level 2 can display or edit it
Security levels for user controls can be changed in the “User Control Manager” dialog box by a 
user who has logged on at a security level equal to or higher than the user control.

1 Click [User Control Manager] on the Main Panel window [Tools] menu. 
The “User Control Manager” dialog box will be displayed.

2 Changing User Control Security

• To Change the Security level
Click the [Security Level] box of the User Control to be changed.
The security level list will appear.

Click the level to be set for the User Control.
The selected level will be displayed in the [Security Level] box.

NOTE

The levels displayed on the list will differ according to the security level of the user.
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• Setting Security for Individual Users
Click the [User] box of the User Control to be changed.
The user list will appear.

Click the user to be set for the User Control. 
The selected user name will be displayed in the [User] box.

3 Click the [OK] button. 

■ User Security Settings
In the “Security” dialog box in the Main Panel window, you can set the user control levels at which 
to allow or disallow editing and display.
A user can edit user controls if a check has been placed for that user in the [Operation Security] → 
[Edit] checkbox. User controls at a level equal to or lower than the level set in [Operation Security] 
→ [User Control Level] will be displayed in the menu.
Using user security, you can set whether user controls will open at logon or when a file is opened. 
If [Startup User Control] is turned ON, the user control editor will be automatically displayed when 
files that include user controls are opened.
For information about the “Security” dialog box, see “Security (Creating Users and Making User 
Settings)” on page 55.

NOTE

The users that can be selected will depend on the user security level.
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User Module Editor
The user module editor lets you make a layout of controls for components arranged in the user module 
window. For each user module there is one user module editor. The name of the user module is 
displayed in the title bar. Only components that are arranged in a particular user module can be laid 
out in the specific control window that is associated with that user module. Both the user module and 
the control window will have the same name. 

■ Opening a User Module Editor Window
Use [Double Click Action] in the “User Module Manager” dialog box or “User Module Properties” 
dialog box to set the window that will open when you double-click in the Configuration window. If 
the [Open User Module Editor] checkbox has been turned ON for a user module, a user module 
editor can be opened for it. For information about the “User Module Manager” dialog box, see 
page 250. For information about the “User Module Properties” dialog box, see page 181. 
A User Module can also be opened via the User Module contextual menu in the Designer window.

NOTE

You can copy controls from a user module to the user control editor. 

User Module Editor

Laid Out Controls

Edit Palette

Component Editor

Controls Laid Out 
in the User ControlStatus Bar
DME Designer Owner’s Manual 285



Chapter 5  Components

286
Operation Mode and Design Mode
There are two modes for the user control editor/user module editor and the component editor: 
“operation mode” and “design mode.” In operation mode you adjust parameters, while in design 
mode you lay out controls.
You can switch between operation mode and design mode using the context menu that is displayed 
when you right-click in the user control editor/user module editor or component editor.

The [Design Mode] command switches the design mode between ON and OFF. A checkmark 
appears when the design mode is turned ON. If you click in the context menu when the checkmark is 
present, design mode will turn OFF, and the edit window will return to operation mode.

NOTE

Only users for whom the [Operation Security] → [Edit] checkbox in the “Security” dialog box has been checked can turn the 
design mode ON. 

NOTE

You can select controls in the component editor so that you can copy them into the user control editor/user module editor.
When you want to select multiple objects, hold down the <Ctrl> key as you click each new object you want to select.

Switches 
between 

operation mode 
and design 

mode
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Status Bar
The lock icon will appear in the User Module when security is active.
→ User Module properties (page 181).
→ User Module (page 250).

The lock icon will appear locked when the password has not been entered, and layouts edited in the 
Design Mode cannot be saved.

When the password is entered it becomes temporarily possible to save the layout.

The lock icon will not appear if the [Enable Security] checkbox in the “Properties” dialog box is not 
checked.
DME Designer Owner’s Manual 287



Chapter 5  Components

288
Edit Palette
The edit palette is automatically displayed whenever the user control editor/user module editor is 
active in design mode. Whenever you move the user control editor/user module editor, the edit palette 
moves together with it. When you turn OFF design mode, the palette disappears.
Commands for editing in the user control editor/user module editor are provided on the edit palette.

■ [Design Mode Off] Button
Turns OFF the design mode.

■ [Undo] Button/[Redo] Button
Used to undo/redo operations.

■ [Cut] Button/[Copy] Button
Cuts or copies the selected controls. 
→ See “Cut/Copy/Paste Controls” on page 303.

■ [Paste] Button
Pastes cut or copied controls.
→ See “Cut/Copy/Paste Controls” on page 303.

[Design Mode Off] Button

[Undo] Button
[Redo] Button

[Cut] Button
[Copy] Button

[Paste] Button

Control Alignment Grid Setting
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■ Alignment of Controls
Aligns the positions of multiple controls.

[Align Left] Button
Aligns all selected controls with the left edge of the leftmost selected control. 

[Align Right] Button
Aligns all selected controls with the right edge of the rightmost selected control. 

[Align To Top] Button
Aligns all selected controls with the top edge of the uppermost selected control. 

[Align To Bottom] Button
Aligns all selected controls with the bottom edge of the lowermost selected control. 

[Align Horizontally] Button
This button can be used only when three or more controls are selected.
It arranges the controls in a uniform horizontal line. Without changing the position of the leftmost 
and rightmost control, this button arranges the controls between them at uniform intervals. It puts 
the same amount of space between each control and its neighbor.

[Align Vertically] Button
This button can be used only when three or more controls are selected.
It arranges the controls in a uniform vertical line. Without changing the position of the uppermost 
and lowermost control, this button arranges the controls between them at uniform intervals. It puts 
the same amount of space between each control and its neighbor.

[Horizontal/Center Align] Button
Aligns the selected controls horizontally with the center position.

[Vertical/Center Align] Button
Aligns the selected controls vertically with the center position.

[Align Left] Button

[Align Right] Button

[Align To Top] Button
[Align To Bottom] Button

[Align Horizontally] Button
[Align Vertically] Button

[Horizontal/Center Align] Button
[Vertical/Center Align] Button

[Picture] Button

[TEXT] Button
 [Box] Button

[Ellipse] Button

[Frame] Button
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■ [Picture] Button
Places a graphic file.

■ [TEXT] Button
Places a text box.

■ [Box] Button
Places a square.

■ [Ellipse] Button
Places an ellipse.

■ [Frame] Button
Places a frame.

■ Grid Setting
When arranging controls, you can align them along the grid. This menu sets the spacing of the 
grid.

Clicking the [▼] button displays a menu. Click the menu to set the grid spacing. Select [OFF] to 
turn OFF the grid.

NOTE

When the grid is turned ON (when any grid item besides OFF is selected), clicking any control that is not aligned with the 
grid position, will cause it to align with the nearest grid.
Please note that after copying multiple controls in one operation from the component editor and adjusting their positions 
manually, their positions could become disarranged when you select them by clicking on them, if they do not already 
align with the grid interval.
Furthermore, if you change the grid spacing after aligning the positions of controls in the user control editor/user module 
editor, the controls will be placed into positions that do not align with the grid even if they are arranged using the align 
buttons. When there are controls that do not align with the grid, turn the grid OFF.

Grid=10 Grid=20
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User Control Editor/User Module Editor Context Menu
The context menus that appear when you right-click in a window will differ in operation mode and in 
design mode. In design mode, other commands will be added, depending on where you click.
The context menu for the user module editor contains the [Set User Module As Master Layout] 
command.

■ Operation Mode
Commands that are displayed in the context menus for operation mode will also be displayed in 
design mode.

[Design Mode]
Switches between design mode and operation mode. When you are in design mode, a checkmark 
will appear to the left of the command name. 

[Peak Hold]
Turns the peak hold meter ON or OFF and performs a reset. The ON or OFF setting for peak hold 
applies to the whole zone. 

• [On]
When you select this, peak hold is turned ON, and a checkmark appears next to it. If you 
select this item while it is checked, peak hold is turned OFF. 

• [Reset]
Resets peak hold. 

[Close All Editor Windows]
Closes all component editor windows.

[Open Parameter Link]
Opens the “Parameter Link” window. For information about the Parameter Link window, see 
“Parameter Link” (page 73). 

NOTE

Peak hold is a function that makes it easy to see the maximum signal value by lighting up at the level of the 
maximum value as the signal peak comes in.
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[Parameter Link Mode]
A checkmark appears when this is turned ON. 
Turning this ON changes to parameter link mode, where group parameters can be linked. 
When this is turned OFF, group parameters will not be linked, and they can be changed 
individually. Turn this OFF when editing the offset for each parameter. 
Parameter link mode is linked to the [Parameter Link] check box in the Parameter Link window. 

[Set User Module As Master Layout] (User Module Editor Only)
Sets the layout of active user module editor as the master layout. The window size and the 
background will be applied to user module editors created in the future.

■ The Context Menu Displayed in Design Mode When You Right-Click an Empty 
Location

[Tab Order]
When using user control editors or user module editors, this function displays the order in which 
you move through them by pressing the <Tab> key. When you select this command, numbers are 
displayed next to the edit boxes. A checkmark appears next to [Tab Order] in the context menu. To 
exit tab order settings, click [Tab Order] the context menu or click anywhere besides a tab order 
number in the user control editor.

Clicking the displayed numbers changes the order. The numbers are changed in the order that 
they are clicked. To exit tab order settings, click [Tab Order] the context menu or click anywhere 
besides a tab order number in the user control editor.
→ See “Changing the Tab Order” on page 313.

[Set Background Image]
Sets a background image for a window. Clicking here displays the “Background Image” dialog 
box.
→ See “Setting Background Images for Windows” on page 295.
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■ The Context Menu Displayed in Design Mode When You Right-Click a Control

[Open Original Component Editor]
This menu is displayed when you right-click a control in design mode. It opens the component 
editor for the control you clicked.

[Add Parameter to Parameter Link]
Adds a control to the parameter link group. Click the group name displayed in the submenu. See 
“Creating Parameter Links” (page 314). 

If you click a parameter link group name, a control is added to that group. 

[Property]
Opens the properties dialog box for the control.
→ See “Control Properties” on page 303.

NOTE

There some controls, such as edit boxes and sliders, that do not display the [Property] command.
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Changing the Window Size
In design mode, you can change the window size of the user control editor. If you align the mouse 
pointer with a side or corner of the window, its shape will change into a double-headed arrow. When 
the arrow is shaped like this, dragging it will change the size of the window.

Even if you change the width of the window, the library button will remain where it is, in the upper right 
corner.
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Setting Background Images for Windows
The default color for the user control editor/user module editor window background is black, the same 
as for the component editor window. However, you can change the color or display an image in the 
background. These settings are made in the “Background Image” dialog box. To display this dialog 
box, right-click in the user control editor window while in design mode, then click [Set Background 
Image] on the displayed context menu. 

■ [Default]
Sets the background color to black, the same as the component editor. Select this if you have set 
the background with [Color] or [Image], and you want to return to the original background.

■ [Color]
Sets the color of the background. Use the [Select Color] button to select a color. 

[Select Color] Button
Clicking here displays the “Select color” dialog box. This sets the color of the background. For 
information about the “Select color” dialog box, see page 203.

NOTE

If you select a light color, it may be difficult to see the grid.
DME Designer Owner’s Manual 295



Chapter 5  Components

296
■ [Image]
Displays an image for the background. You can use image files in the following formats: BMP 
(.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Use the [Select Image] button to select an 
image file. 

[Select Image] Button
Clicking here displays the “Select Image” dialog box. Here you can select an image file to be 
displayed as the window background. 

[Layout] Box
This box displays a list where you can select how the image file will be displayed. 

• [Center]
Centers the image in the window.

• [Tile]
Displays multiple copies of the image side-by-side until the available space is filled. If the 
image file is smaller than the window, it will be displayed repeatedly like tiles on a wall. 

• [Fit]
Expands or reduces the size of the image to match the size of the window where it will be 
displayed. 

[File] Box
Specifies a path for the image file.
Click the [Select Image] button and select an image file. The path will be automatically entered. 
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Placing Controls
Controls can be placed when you are in the design mode. You can turn the design mode ON and OFF 
by right-clicking in the user control editor/user module editor, or component editor, then clicking the 
[Design Mode] command in the context menu that is displayed.
You can place controls by dragging them from the component editor or by using the copy and paste 
commands. 

■ Selecting Controls
If you click a control in the component editor while in design mode, the control will be selected and 
a red frame will be displayed around it. Controls like knobs, sliders, edit boxes, and labels are all 
separate objects. Only the item clicked will be selected. 

If you hold down the <Ctrl> key while clicking, you can select multiple controls and labels. If you 
use <Ctrl> + click on a selected control, it will cancel that control’s selection. 
If you position the mouse in an empty location on the sheet and start dragging from there, a frame 
will be displayed as the pointer moves. All controls enclosed by that frame will be selected. 

[Library]

Edit Palette

Knob

Slider

Edit Box

Buttons

Text

Graph

Solid Frame
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■ Placing Controls by Dragging Them (User Control Editor)
You can drag the controls you want to copy from the component editor to the user control editor. 

1 Open the component edit window that has the controls you will be placing in the user 
control box.

2 Open the user control editor.
User control names are displayed in the [View] → [User Control] submenu in the Main Panel 
window Click a user control name to open its window.

3 Right-click in the component editor or the user control editor. 
The context menu will be displayed.

4 Click [Design Mode] on the menu.

Design mode will be turned ON. 

5 Drag the controls from the component editor to the user control editor. 

NOTE

If you drag controls like knobs and sliders, edit boxes and labels that show parameter types, and place them one-by-one 
in the user control editor, they must be arranged in the user control editor. If you select multiple items and drag them, you 
can copy them as a group into the user control editor, keeping their original arrangement. 
When copying multiple controls from a single component editor, if you select all the controls you want copy and drag 
them together as a unit, their original positional relationship and tab order will be maintained. 
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Arrange the controls in the user control editor.

■ Placing Controls by Dragging Them (User Module Editor)
You can drag the controls you want to copy from the component editor window in the user module 
to the user module editor.

1 Create a user module, then arrange and connect the components for it.

2 Store the user module by checking [Double Click Action] ➞  [Open User Module Editor] 
in the Store dialog box (see “Saving User Modules” on page 255 for details about 
storing user modules). 

3 Double-click a user module in the Configuration window.
The user module editor and edit windows for the components arranged in the user module will 
be displayed.

4 Right-click in the component editor or user module editor, then click the [Design Mode] 
command in the context menu.
Design mode will be turned ON. 

5 Drag the controls from the component editor to the user module editor. 
Arrange the controls in the user control editor.
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■ Placing Controls Using Copy and Paste
Copy the controls in the component editor and paste in the user control editor or user module 
editor.
To copy controls in the component editor, press the [Copy] command shortcut keys, <Ctrl> + <C>.
To paste in the user control editor or user module editor, press the [Paste] command shortcut key, 
<Ctrl> + <V>, or the [Paste] button on the edit palette.

1 Click on the source component editor window to make it active, then select the control 
or controls you want to copy.

2 Press the <C> key while holding down the <Ctrl> key.
The selected controls will be copied to the clipboard.

3 With the target user control editor or user module editor active, press the <V> key while 
holding down the <Ctrl> key.
You can also paste by clicking the [Paste] button on the edit palette.
The controls will be copied.
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■ When You Cannot Copy
Regardless of whether you drag or use copy and paste, you cannot create multiple copies from the 
same single component. If you drag controls that are already copied into the user control editor or 
user module editor, the mouse pointer will change into the “unavailable” mark (a circle with a 
diagonal slash), indicating that you cannot copy.

You can copy more than one component of the same type into the user control editor, as long as 
they come from different components located in the configuration or user module.

Controls for components arranged in the configuration can be copied only to the user control 
editor. 
Controls for components arranged in a user module can be copied to both the user control editor 
and the user module.

■ Order of Controls
Controls newly pasted in the user control editor will be displayed above any previously pasted 
controls they overlap. The tab order for edit boxes will be the order in which they were pasted. 
Because the order cannot be changed, paste solid frames with parameter groups arranged on 
them before copying controls.

NOTE

In the component editor, you can select multiple controls using <Ctrl> + click or by dragging. Once controls are copied, 
they will be pasted in the order in which they were copied. 
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Moving and Aligning Controls
In the user control editor or user module editor, you can move or align copied controls.

■ Selecting Controls
In the user control editor or user module editor, controls are selected in the same way as in the 
component editor. Click a control to select it, or press <Ctrl> + click to select multiple controls. If 
you use <Ctrl> + click on a selected control, it will cancel that control's selection. If you position the 
mouse in an empty location in the user control editor or user module editor and start dragging from 
there, a frame will be displayed as the pointer moves. All controls enclosed by that frame will be 
selected. 
A red frame will be drawn around the selected controls.

■ Moving Controls
Move selected controls by dragging them or by pressing the arrow keys on your keyboard. When 
you select multiple controls using <Shift> + click, you can move all of them at the same time.

Dragging
When grid is ON, the upper left of the dragged controls will automatically align with the grid. When 
dragging, the coordinates displayed here refer to the upper left corner of the object being 
dragged. The “Distance to Right” and “Distance to Bottom” are displayed in pixel units, using the 
upper-left of the window as a reference point.

 

When multiple controls are selected and dragged, the coordinates are those of the upper-left 
corner of the control where the mouse is aligned.

Arrow Keys
When the grid is ON, the arrow keys move controls a grid unit at a time. When the grid is OFF, 
controls are moved one pixel at a time. 

■ Alignment
You can align controls using the following alignment buttons on the edit palette: [Align Left], [Align 
Right], [Align To Top], [Align To Bottom], [Align Horizontally], [Align Vertically], [Horizontal/Center 
Align], and [Vertical/Center Align].
You can only use the [Align Horizontally] or [Align Vertically] buttons when three or more controls 
are selected.
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Cut/Copy/Paste Controls
You can edit controls arranged in the user control editor or user module editor using the [Cut], [Copy], 
and [Paste] commands in the edit palette.

■ Cut
Cuts controls arranged in the user control editor. Select one or more controls, then press the [Cut] 
button on the edit palette

■ Copy
Copies controls arranged in the user control editor or user module editor. Select one or more 
controls, then press the [Copy] button on the edit palette.

■ Paste
Pastes cut or copied controls. Click the [Paste] button on the edit palette. If you cannot paste, the 
button color turns pale.

■ Delete
Controls can be deleted by selecting them and pressing the <Delete> key. 

Undo and Redo Commands During Editing
You can undo or redo control movements, size changes, or deletions using the [Undo] and [Redo] 
commands in the [Edit] menu. 

Control Properties
A properties dialog box will open when you either double click a controller in the User Control Editor or 
User Module Editor, or right-click the controller and select [Properties] from the contextual menu. Here 
you can specify a design for the controller.
Multiple properties of the same type can be set at the same time by clicking the controllers while 
holding the <Ctrl> key and then opening the properties dialog box.
Edited items are shown in bold text until you either click [OK] or [Cancel].

NOTE

If you close an editor window, you will no longer be able to undo and redo operations performed there.

NOTE

Sliders have no property settings.
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■ “Knob Properties” Dialog Box
When you right-click on a knob, then select [Properties] from the context menu, the “Knob 
Properties” dialog box will be displayed. This dialog box sets the size of the knob. 

[Size]
Displays a list where you can select the knob size. Select [Large], [Medium], [Small], or [Very 
Small].

[Color]
Select a color from the list: [White], [Red], [Yellow], [Green], [Blue], or [Violet].

■ “Toggle Button Properties” Dialog Box
The Toggle Button Properties dialog box will appear when you either double click the ON/OFF 
button or right-click it and select [Properties] from the contextual menu. This sets the text displayed 
by the button, along with the color of the button.

[Text] box
Enter the text to be displayed by the button. You can set different text for when the button is ON and 
for when it is OFF.

[Size]
Select a button size from the list: [Small (37x11)], [Small (51x11], [Medium (74x11)], [Medium 
(74x22)], or [Large (111x33)].

NOTE

You can change the size of a knob by dragging one of the marks at the four corners (top, bottom, left, right) of the knob 
in the user control editor.
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[Color]
Displays a list where you can select the color of the button. If you click the [▼], a list of button 
colors will be displayed.

[Text Font] Button
Sets the font, size and style. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202.

■ “Radio Button Properties” Dialog Box
The Radio Button Properties dialog box will appear when you either double click a radio button or 
right-click it and select [Properties] from the contextual menu. You can set the button's color, size, 
and font.

[Color]
Select a color from the list: [White], [Red], [Yellow], [Green], [Blue], or [Violet].

[Size]
Select a button size from the list: [Small (37x11)], [Small (44x11], [Medium (75x11)], [Medium 
(74x22)], or [Large (111x33)].

[Text] Box
Enter the text to be displayed by the button.

[Text Font] Button
Sets the font, size and style. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 202.
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■ “Text Properties” Dialog Box
The Text Properties dialog box will appear when you either double click a parameter name or other 
text, or right-click it and select [Properties] from the contextual menu. Here you can enter the text to 
be displayed.

[Text] Box
Enter the text to be displayed by the button.

[Text Font] button
Click this button to display the “Select Font” dialog box. Sets the font, font size, and style. For 
information about the “Select Font” dialog box, see page 203.

[Alignment]
Specifies the horizontal alignment of the text: [Left], [Center], or [Right].

[Rotate]
Rotates the text by the specified angle: [-90], [0], [90], or [180].

[Link Component Editor]
Specifies the component editor to be opened when text is clicked.

[Text Color] Button
Click this button to display the “Select Color” dialog box. Sets the color of the text. For information 
about the “Select Color” dialog box, see page 203.
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■ Edit Box Properties
The Edit Box Properties dialog box will appear when you either double click an edit box or right-
click it and select [Properties] from the contextual menu. Here you can set the edit box size.

[Size]
Select an edit box size from the list: [Large], [Medium], or [Small].

■ Level Meter Properties
The Level Meter Properties dialog box will appear when you either double click a level meter or 
right-click it and select [Properties] from the contextual menu. Here you can specify the number of 
meter segments and scale.

[Segment]
Select a number of meter segments from the list: [2], [6], or [60].

[Scale]
Select the type of scale to be displayed beside the meter from the list. This option is only available 
when [Segment] is set to 60.

■ “Solid Frame Properties” Dialog Box
The Solid Frame Properties dialog box will appear when you right-click a solid frame and select 
[Properties] from the contextual menu. Here you can enter the text to be displayed. Here you can 
set the frame size and divider location.

Frame Size
The width is set using the [Width] and the height is set using [Height]. The units are pixels.

Partition Line/Sub-Partition Line
Sets partition lines within the frame. [Partition Line] is a long partition line displayed from end to 
end, and [Sub-Partition Line] is a short partition line.

• [Direction]
Select the direction of a partition line from the list. [Vertical] inserts a vertical partition line and 
[Horizontal] inserts a horizontal partition line. When [None] is select, partition lines are not 
displayed.

NOTE

You can change the size of a frame by dragging one of the marks at the four corners (top, bottom, left, right) of the frame 
in the user control editor. 

Partition Line

Sub-Partition Line
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• [Position]
Displays the currently set line position. Displays the number of pixels from the top of the solid 
frame when [Vertical] is selected for the [Direction], and the number of pixels from the left of 
the solid frame when [Horizontal] is selected.

• [Add] Button
If you set the position of the partition line in the box on the right and click the [Add] button, the 
partition line will be added and displayed in the [Position] list.

• [Delete] Button
Deletes the partition line selected in the [Position] list.

■ “Color Frame Properties” Dialog Box
The Color Frame Properties dialog box will appear when you right-click a solid frame and select 
[Properties] from the contextual menu. Here you can enter the text to be displayed. Here you can 
set the frame size and divider location. 

Frame Size
The width is set using the [Width] and the height is set using [Height]. The units are pixels and the 
minimum value is 3.

Frame Color
Sets the color of the color frame. 
Click this button to display the “Select color” dialog box. For information about the “Select color” 
dialog box, see page 203.

Fill Color
Sets the frame fill color.
Click the [Select Color] button to display the “Select color” dialog box. Refer to “Select Color” 
Dialog Box in the Object section on page 203 for information on this dialog box.

Line Width
Sets the thickness of the lines at [Top]/[Left]/[Right]/[Bottom]. Set “0” to display no lines.

NOTE

You can change the position of a partition line by dragging one of the marks on the line in the user control editor. 

NOTE

You can change the size of a frame by dragging one of the marks at the four corners (top, bottom, left, right) of the frame 
in the user control editor. 
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■ User Picture Properties Dialog Box
Right-click the image and select [Properties] from the contextual menu to display the User Picture 
Properties dialog box.

[File Path] Box
Displays the path to the graphic file.

[Select File] Button
Selects a graphic file.

Size

• [Width]
Specifies the width in pixels.

• [Height]
Specifies the height in pixels.

• [Reset] Button
Click to display the graphic at it's original size.

• [Stretch]
When ON, the graphic will be enlarged when a size that is bigger than it's original size is 
specified.

[Link Component Editor]
When ON, clicking the [Select Component] button selects the editor that is opened when the 
graphic is clicked.
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■ Text Properties Dialog Box
Right-click the text box and select [Properties] from the contextual menu to display the Text 
Properties dialog box.

[Text] Box
Displays and edits the text to be displayed.

[Text Font]
Selects the font. Click to display the Select Font dialog box.
Refer to “Select Font” Dialog Box on page 202 for more information on the Select Font dialog box.

[Text Color] Button
Sets the text color. Click to display the Select Color dialog box.

[Alignment]
Selects [Left], [Center], or [Right] text alignment.

[Rotate]
Rotates the text box.

[Link Component Editor]
When ON, clicking the [Select Component] button selects the editor that is opened when the text 
box is clicked.
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■ Box Properties Dialog Box
Right-click the box and select [Properties] from the contextual menu to display the Box Properties 
dialog box.

Box Size
• [Width]

Specifies the width in pixels.

• [Height]
Specifies the height in pixels.

Box Style
• [Style]

Sets the style of the object. Select [Plain], [Raised], or [Sunken] from the list.

• [Round Corner]
Turn ON to produce a round-cornered box. Use [Curve] to select the degree of roundness.

Line
• [Type]

Select a type of frame line from the list: [Solid], [Dash], [Dot], [Dash Dot]. Or [Dash Dot Dot].

• [Size]
Sets the thickness of the frame line in pixels. The range is from 1 to 100.

• [Select Color] Button
 Sets the color of the frame line. Click to display the “Select color” dialog box.
 Refer to “Select Color” Dialog Box on page 203 for more information on the Select Color 
dialog box.

Fill Color
• [Select Color] Button

 Sets the frame fill color. Click to display the “Select color” dialog box.
 Refer to “Select Color” Dialog Box on page 203 for more information on the Select Color 
dialog box.
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■ Ellipse Properties Dialog Box
Right-click the ellipse and select [Properties] from the contextual menu to display the Ellipse 
Properties dialog box.

Ellipse Size
• [Width]

Specifies the width in pixels.

• [Height]
Specifies the height in pixels.

Line
• [Type]

Select a type of frame line from the list: [Solid], [Dash], [Dot], [Dash Dot]. Or [Dash Dot Dot].

• [Size]
Sets the thickness of the frame line in pixels. The range is from 1 to 100.

• [Select Color] Button
Sets the color of the frame line. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 203 for more information on the Select color dialog 
box.

Fill Color
Sets the ellipse fill color when ON.

• [Select Color] Button
Sets the ellipse fill color. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 203 for more information on the Select color dialog 
box.
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Changing the Tab Order
The tab order for controls is determined by the order in which they were pasted into the user control 
editor or user module editor. If you right-click the user control editor or user module editor, you can 
check or change the tab order using the [Tab Order] command on the context menu.

If you select the [Tab Order] command, tab order numbers will be displayed at the upper-left of each 
edit box. Clicking the displayed numbers changes the order.

1 Right-click in the user control editor or user module editor. 
The context menu will be displayed.

2 Click [Tab Order] in the context menu. 
Numbers for the current tab order are displayed to the upper-left of each edit box.

3 Click the tab order numbers in the order in which you want to set the tab order.
Even if you do not want to change tab order number 1, click all the numbers in the order you desire, 
starting from number 1. When you click on each number, it will change to the number that reflects 
the order in which it was clicked.

4 Once you have finished specifying the order, click somewhere within the window 
where there is no tab number.
The tab order numbers will disappear.

The changed tab order will apply the next time DME Designer is started.
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Creating Parameter Links

You can group controls (parameters) and link their parameters. You can create parameter link groups 
and add controls to them in the component editor. Parameter link settings are made in the Parameter 
Link window. For information about parameter links and the Parameter Link window, see “Parameter 
Link” (page 73). 

■ Creating Parameter Links
If you right-click on a control, a context menu will be displayed. 
The [Global Link] → [Add Group] and [Local Link] → [Add Group] commands create new groups. 
Controls can be added by right-clicking. 

■ Adding Controls to a Group
If you right-click a control in the component editor, a context menu will be displayed. You can 
create groups or add controls using commands in the [Add Parameter to Parameter Link] 
submenu. Groups that do not have the same type of parameters will be grayed out and cannot be 
selected. 

Global Link 

The group names for global link groups are displayed in the [Global Link] submenu. When you 
click a group name, a control is added to the group. 

NOTE

A parameter can belong to one group only. Furthermore, only parameters of the same type can be grouped.
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Local Link 

The group names for local like groups are displayed in the [Local Link] submenu. When you click a 
group name, a control is added to the group. 

■ Adding Multiple Controls
You can select multiple controls in Design Mode. When multiple controls are selected, multiple 
parameters can be added to a group simultaneously. 
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Crossover
Separates input signals into multiple frequency channels and outputs them. The following five types of 
components are available in the Crossover group: 2 Way, 3 Way, 4 Way, 5 Way, and 6 Way. 
Crossover components have a single input and multiple outputs.

Double-click a component to display the component editor for it.

Name Function

1 Crossover Curve Displays the level of each frequency band, 
distinguished by color.

Section Parameter Setting Range Function

2 Input Level -∞ to +10 dB Sets the input signal level. 

3 Output Level -∞ to ±0 dB Sets the output signal level for each 
frequency band. 

4 Mute ON/OFF Mutes the output signal level for each 
frequency band. 

5 Phase ON/OFF Reverses the phase of the output signal for 
each frequency band. 

6 Frequency Frequency 20 Hz to 20 kHz Sets the cross frequency between each 
frequency band. 

1

2

3 6

4

7

5

8 9

)

! @

Crossover component
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The number of output channels varies according to the component variation.

Set the attenuation curve for the lowest band and the middle bands with the Low Pass Filter (LPF) and 
High Pass Filter (HPF), and the highest band with HPF. Each frequency band has its own color, with 
Low being red, Mid being green, and so on. These correspond to the colors of the lines on the graph.

7 LPF Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

8 Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency. 

9 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency. 

) HPF Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

! Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency. 

@ Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency. 

2 Way Low/High

3 Way Low/Mid/High

4 Way Low/Low-Mid/High-Mid/High

5 Way Sub-Low/Low/Low-Mid/High-Mid/High

6 Way Sub-Low/Low/Low-Mid/Mid/High-Mid/High
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■ Graphic Control Points
The graph control points show [Output Level] and [Frequency]. As you modify the parameters 
using the knobs and edit boxes, the control points move. Also, as you drag the points, the [Output 
Level] and [Frequency] parameters reflect the changes you make. 

You can adjust the [Output Level] parameter by vertically dragging the control point in the center of 
each curve. 

You can adjust the [Frequency] parameter by horizontally dragging the control point at the 
intersection of the curves for each frequency band.

Changing the [Output Level] Parameter 

Changing the [Frequency] Parameter
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■ LFP/HPF
[Type] sets the attenuation slope and the filter type for the LPF and HPF. The selected items are 
displayed on the buttons. Clicking these buttons displays a menu. Combinations of six slope types 
and four filter types are available. [6dB/Oct], [12dB/Oct], [18dB/Oct], [24dB/Oct], [36dB/Oct], and 
[48dB/Oct] set the attenuation per octave. A low value produces gentle attenuation. A large value 
produces sudden attenuation.

• THRU
No filter is applied. There is no attenuation, which produces a level line at all frequencies.

• AdjustGc (Adjustable Gc)
With this setting, you can adjust Gc (gain on the cutoff frequency) between -6 dB and +6 dB. 
If you set -3 dB it becomes a Butterworth filter. If you set -6 dB, it becomes Linkwitz-Riley filter.
When you select Adjustable Gc, the Gc knob is displayed.

• Butrwrth (Butterworth)
This filter has the most general characteristics. The pass band is flat and the gain for the 
cutoff frequency is -3 dB.

• Bessel
For curves where phase characteristics are important, Bessel has gentler attenuation than 
Butterworth, and there is little distortion of the waveform when square waves are passed 
through.

• Linkwitz (Linkwitz-Riley)
As second-order filters, the sum of the output voltages for LPF and HPF have a gain of 0 dB 
across the entire band. The pass band is flat, but the cutoff frequency gain is -6 dB. 

Type

Linkwitz-Riley

Butterworth

Bessel
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Crossover Processor
A crossover processor consists of a crossover, delay, parametric equalizer, and compressor. After the 
input signal is processed by the crossover, effects of the delay, parametric equalizer, and compressor 
are applied to each frequency band. The following two types are available in the Crossover Processor 
group: Crossover Processor and Crossover Processor II. 

Crossover Processor
The following five types of components are available in the Crossover Processor group: 2 Way, 3 Way, 
4 Way, 5 Way, and 6 Way. Crossover processors have a single input and 2 to 6 outputs. 

Double-click a component to display the component editor for it. Band numbers may vary depending 
on the component, but they share a common configuration in the component editor.
If you click the [Crossover], [Compressor], [PEQ], or [Delay] button in the [Navigator] section, an 
editor for the crossover, compressor, parametric equalizer, or delay will be displayed in a separate 
window. A separate component editor will open for each output channel (such as Low or Mid) when 
you click on the compressor, parametric equalizer, or delay.

Section Parameter Setting Range Function

1 Navigator Crossover -- This opens the crossover editor window.

2 Delay -- This opens the delay editor window.

3 PEQ -- This opens the parametric equalizer editor 
window.

4 Compressor -- This opens the compressor editor window.

5 Input Level -∞ to +10 dB Sets the input signal level. 

6 Output Level -∞ to +10 dB Sets the output signal level for each 
frequency band. 

7 Mute ON/OFF Mutes the signal for each frequency band. 

8 Phase ON/OFF Reverses the phase of the output signal for 
each frequency band. 

1

2 3 4

5

6

7
8

Component editor for Crossover Processor 
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The output number varies according to the component variation.

Set the attenuation curve for the lowest band and the middle bands with the Low Pass Filter (LPF) and 
High Pass Filter (HPF), and the highest band with HPF. Each frequency band has its own color, with 
Low being red, Mid being green, and so on. These correspond to the colors of the lines on the graph.

■ Crossover
When you click the [Crossover] button for the crossover processor, it opens the crossover editor 
window.

2 Way Low/High

3 Way Low/Mid/High

4 Way Low/Low-Mid/High-Mid/High

5 Way Sub-Low/Low/Low-Mid/High-Mid/High

6 Way Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Name Function

1 Crossover Curve Displays the level of each frequency channel, 
distinguished by color.

Section Parameter Setting Range Function

2 Frequency Frequency 20 Hz to 20 kHz Sets the cross frequency between each 
frequency band. 

1

2

36

7 8 4 5

[Crossover Processor-Crossover] editor window 
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3 LPF Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

4 Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency. 

5 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency.

6 HPF Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

7 Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency. 

8 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency.
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■ Delay
When you click the [Delay] button for the crossover processor, it opens the delay editor window. 
Here you can set the delay for each frequency band. 

Parameter Setting Range Function

1 Delay ms: 0 to 500
Sample: the range 
depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends 
on the Frame value.
Beat: the range depends 
on the Beat value.

Sets the delay time.

2 Level -∞ to ±0 dB Sets the output signal level for each channel

3 On ON/OFF Turns delay ON. 

4 Mute ON/OFF Mutes the signal for each frequency band. 

5 Delay Scale ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay time. The 
selected button will light up, and the units in the [Delay] 
edit box will change.
If [Beat] is selected, use the knob to set the BPM 
(beats/minute).

1

2

3

5

4

[Crossover Processor - Delay] editor window
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■ Parametric Equalizer
When you click [PEQ] button for the crossover processor, it opens the parametric equalizer editor 
window. Here you can make parametric equalizer settings for each frequency band. 

Name Function

1 PEQ Curve Displays the PEQ curve.

Parameter Setting Range Function

2 Type PEQ
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF

Select the filter type from a menu. 

3 Q: 0.1 to 16.0 Sets the frequency band width for each band. 

4 Frequency 20 Hz to 20 kHz Sets the frequency for each band. 

5 Gain -18 dB to +18 dB Sets the gain for each band. 

6 Bypass ON/OFF Turns ON bypass for each band. 

7 PEQ On ON/OFF Turns the PEQ ON. 

1

2

3

4

5

6

7

[Crossover Processor-PEQ] editor window 
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■ Compressor
When you click the [Compressor] button for the crossover processor, it opens the compressor 
editor window. Here you can make compressor settings for each frequency band. 

Name Function

1 Compressor Curve Displays results graphically. The horizontal axis is the 
input signal level, and the vertical axis is the output 
level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Ratio 1:1 to ∞:1 Sets the compression ratio.

6 Knee HARD, 1, 2, 3, 4, 5 Sets the way compression is applied.

7 Attack 0 to 120 ms Sets the attack time.

8 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the 
operating frequency.

9 Gain ±0 dB to +18 dB Sets the output gain.

) On ON/OFF Turns the compressor ON. When you turn this button 
OFF, the compressor is bypassed.

1

2 )3

4 5 6

7 8 9

[Crossover Processor-Compressor] editor window 
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Crossover Processor II
The following five types of components are available in the Crossover Processor II group: 2 Way, 3 
Way, 4 Way, 5 Way, and 6 Way. Crossover processor II components have a single input and 2 to 6 
outputs. 

Double-click a component to display the component editor for it. The number of bands may vary 
depending on the component, but they share a common configuration in the component editor. 
There are input and output level meters in the upper part of the window. If you click the [Crossover], 
[Delay], [PEQ], or [Compressor] button in the [Navigator] section, an editor for the crossover, delay, 
parametric equalizer, or compressor will be displayed in a separate window. A separate component 
editor will open for each output channel (such as Low or Mid) when you click on the delay, parametric 
equalizer, or compressor. 

Name Function

1 Input Meter Displays the input signal level.

2 Output Meter Displays the output signal level.

Section Parameter Setting Range Function

3 Input Gain -∞ to +10 dB Sets the input signal level. 

4 Mute ON/OFF Mutes the input signal. 

5 Output Gain -∞ to +10 dB Sets the output signal level for each 
frequency band. 

6 Mute ON/OFF Mutes the output signal for each frequency 
band. 

21

3

4

5 6 )987

Crossover Processor II
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■ Crossover
When you click the [Crossover] button for the crossover processor, it opens the crossover editor 
window. 

7 Navigator Crossover -- This opens the crossover editor window. 

8 Delay -- This opens the delay editor window. 

9 PEQ -- This opens the parametric equalizer editor 
window. 

) Compressor -- This opens the compressor editor window. 

Name Function

1 Crossover Curve Displays the level of each frequency band, 
distinguished by color.

Section Parameter Setting Range Function

2 Frequency Frequency 20 Hz to 20 kHz Sets the cross frequency between each 
frequency band. 

3 Polarity Polarity Normal/Inverted Reverses the output signal phase for each 
frequency band. 

4 Mute Mute ON/OFF Mutes the signal for each frequency band. 
This is linked to the Mute setting in the 
original window. The display appears as a 
dotted line when muted.

Name Function

1

2

3

4

5

6 79 )

8

Crossover Processor II component editor
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5 LPF Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

6 Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency. 

7 Gc -6 dB to 6 dB When [Adjustable Gc] is selected for [Type], 
this sets the gain for the cutoff frequency. 

8 HPF Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

9 Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency. 

) Gc -6 dB to 6 dB When [Adjustable Gc] is selected for [Type], 
this sets the gain for the cutoff frequency. 
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■ Delay
When you click the [Delay] button for the crossover processor, it opens the delay editor window. 
Here you can set the delay for each frequency band. 

Parameter Setting Range Function

1 Delay ms: 0 to 500
Sample: the range depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends on the Frame value.
Beat: the range depends on the Beat value.

Sets the delay time. 

2 Level -∞ to ±0 dB Sets the output signal level for each 
channel. 

3 On ON/OFF Turns delay ON. 

4 Delay Scale ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay 
time. The selected button will light up, 
and the units in the [Delay] edit box 
will change. 
If [Beat] is selected, use the knob to 
set the BPM (beats/minute).

1

2

3

4
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■ Parametric Equalizer
When you click the [PEQ] button for the crossover processor, it opens the parametric equalizer 
editor window. Here you can make parametric equalizer settings for each frequency band. 

Name Function

1 PEQ Curve Displays the PEQ curve. 

Parameter Setting Range Function

2 Type PEQ
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF

Select the filter type from the menu. 

3 Q 0.1 to 16.0 Sets the band width of each band. 

4 Frequency 20 Hz to 20 kHz Sets the frequency of each band. 

5 Gain -18 dB to +18 dB Sets the frequency gain for each band. 

6 Bypass ON/OFF Bypasses all PEQ bands. 

7 PEQ On ON/OFF Turn the PEQ ON. 

1

2

3

4

5

6

7
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■ Compressor
When you click the [Compressor] button for the crossover processor, it opens the compressor 
editor window. Here you can make compressor settings for each frequency band. 

Name Function

1 Compressor Curve Displays results graphically. The horizontal axis is the 
input signal level, and the vertical axis is the output 
level. 

2 Gain Reduction Meter Displays the gain reduction attenuation. 

3 Output Meter Displays the output signal level. 

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value. 

5 Ratio 1:1 to ∞:1 Sets the compression ratio. 

6 Knee HARD, 1, 2, 3, 4, 5 Sets the way compression is applied. 

7 Attack 0 to 120 ms Sets the attack time. 

8 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time. 
The setting range may vary, depending on the 
operating frequency.

9 Gain ±0 dB to +18 dB Sets the output gain. 

) On ON/OFF Turns the compressor ON. When you turn this button 
OFF, the compressor is bypassed. 

1

23 )

4 5 6

7 8 9
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Delay
This is a multi-tap delay that provides independent delay and level control for each output. You can 
specify the delay time in milliseconds, samples, meters, feet, time code frames, or number of beats. 
Within the delay group, there are two subgroups called Long and Short. Each has a different setting 
range for the delay.

Delay Long
Delay long components are available with from one to eight outputs. Each has a single input and from 
one to eight outputs.

Double-click a component to display the component editor for it. Only the number of outputs in each 
component is different. The other parts are the same.

Section Parameter Setting Range Function

1 Delay All Bypass ON/OFF Bypasses from input to output. 

2 Input Level -∞ to ±0 dB Sets the input signal level. 

3 Mute ON/OFF Mute the input signal. 

4 Delay Tap Delay ms: 0 to 1300
Sample: the range depends 
on the Fs value.
Meter: 0 to 446.7
Feet: 0 to 1465.4
Frame: the range depends on 
the Frame value.
Beat: the range depends on 
the Beat value.

Sets the delay time.
There are two edit boxes, displaying 
milliseconds and the units selected for [Delay 
Scale].

5 Level -∞ to ±0 dB Sets the output signal level for each channel. 

6 On ON/OFF Turns ON each channel’s delay. 

7 Mute ON/OFF Turns ON muting for each channel’s output. 

8 Delay Scale Delay Scale ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay time. 
The selected button will light up, and the 
units in the [Delay] edit box will change.
If [Beat] is selected, use the knob to set the 
BPM (beats/minute).

1
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4

7

Delay Long Component Editor
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Delay Short
Delay short components are available with from one to eight outputs. Each has a single input and from 
one to eight outputs.

Double-click a component to display the component editor for it. Only the number of outputs in each 
component is different. The other parts are the same.

Section Parameter Setting Range Function

1 Delay All Bypass ON/OFF Bypasses from input to output. 

2 Input Level -∞ to ±0 dB Sets the input signal level. 

3 Mute ON/OFF Mute the input signal. 

4 Delay Tap Delay ms: 0 to 130
Sample: the range depends 
on the Fs value.
Meter: 0 to 44.7
Feet: 0 to 146.5
Frame: the range depends on 
the Frame value.
Beat: the range depends on 
the Beat value.

Sets the delay time.
There are two edit boxes, displaying 
milliseconds and the units selected for [Delay 
Scale].

5 Level -∞ to ±0 dB Sets the output signal level for each channel. 

6 On ON/OFF Turns ON each channel’s delay. 

7 Mute ON/OFF Turns ON muting for each channel’s output. 

8 Delay Scale Delay Scale ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay time. 
The selected button will light up, and the 
units in the [Delay] edit box will change.
If [Beat] is selected, use the knob to set the 
BPM (beats/minute).

1 8
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Delay-Short component editor
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Dynamics
Components in the dynamic group adjust the dynamic range of the sound. There are eight types of 
components, each of which is available in mono channel and stereo channel versions. The seven 
types are: compander hard, compander soft, compressor, de-esser, ducking, expander, gate, and 
limiter.

■ KeyIn
All components in the dynamic group, except the de-esser, have KeyIn input. This is used as a 
trigger source that activates the effects of the component.

The trigger source is set in the [KeyIn] section of the component editor. 

The currently selected trigger source is displayed on the button. Click the button and select the 
trigger source from the menu. 

• [SELF]
Sets the input signal as the trigger source for mono channel components.

• [L]/[R]
Sets the left or right input signal as the trigger source for stereo channel components.

• [LR BOTH]
Sets both the left and right input signals as the trigger source for stereo channel components. 
The strongest input signal will be the trigger source, whether from the left or right channel.

• [KEYIN]
The KeyIn input will be the trigger source.

[KeyIn] Section

Mono channel Stereo channel
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Compander
The compander combines the effects of a compressor and an expander. A compressor compresses 
signals that exceed the threshold, while the expander reduces signals that fall below the threshold. 
There are two compander groups, CompanderH (compander hard) and CompanderS (compander 
soft). Within each group, there are mono channel and stereo channel companders. 

Mono channel companders have one input, one output, and one KeyIn input. Stereo channel 
companders have two inputs, two outputs, and one KeyIn input.

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components.
The compander hard and compander soft differ in the compression ratio of their fixed expander. The 
expander compression is expressed by the straight portion of the lower-left part of the compander 
curve. The compression ratio of the compander hard is large. The slope is also large. The 
compression ratio of the compander soft is small, with a gentle compression. The parameters in the 
component editor are the same.

Name Function

1 Compander Curve Displays results graphically. The horizontal axis is 
the input signal level, and the vertical axis is the 
output level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Ratio 1:1 to ∞:1 Sets the compression ratio.

6 Width +1 dB to +90 dB Sets the width of the expander. 

7 Attack 0 to 120 ms Sets the attack time.

8 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the 
operating frequency.

9 Gain -18 dB to ±0 dB Sets the output gain.

CompanderH

Mono channel
Stereo channel

CompanderS

Mono channel
Stereo channel

1
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CompanderH Mono component editor CompanderS Stereo component editor
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Compressor
Compresses signals that exceed a threshold. Narrows the dynamic range of the signal, making it 
easier to mix or record signals with a wide dynamic range such as vocals or piano music. Both mono 
channel and stereo channel compressors are provided.
Mono channel compressors have one input, one output, and one KeyIn input. Stereo channel 
compressors have two inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono 
channel and stereo channel components.

) KeyIn Mono SELF
KEYIN

Selects the trigger source from a menu. The 
currently selected trigger source is displayed on the 
button.

Stereo L
R
LR BOTH
KEYIN

! On ON/OFF Turns the compander ON. 
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De-Esser
Compresses the signal above a specified frequency. The de-esser controls sibilant (hissing) sounds 
included in speech that are produced by the letter “S.” Both mono channel and stereo channel de-
essers are provided.
Mono channel de-essers have one input and one output each. Stereo channel de-essers have two 
inputs and two outputs each.

Name Function

1 Compressor Curve Displays results graphically. The horizontal axis is 
the input signal level, and the vertical axis is the 
output level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Ratio 1:1 to ∞:1 Sets the compression ratio.

6 Knee HARD, 1, 2, 3, 4, 5 Sets the way compression is applied.

7 Attack 0 to 120 ms Sets the attack time.

8 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the 
operating frequency.

9 Gain ±0 dB to +18 dB Sets the output gain.

) KeyIn Mono SELF
KEYIN

Selects the trigger source from a menu. The 
currently selected trigger source is displayed on the 
button.

Stereo L
R
LR BOTH
KEYIN

! On ON/OFF Turns the compressor ON. 
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Double-click a component to open the component editor for it. The parameters are the same for mono 
channel and stereo channel components.

Name Function

1 De-Esser Curve Displays results graphically. The horizontal axis is the 
input signal level, and the vertical axis is the output 
level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Ratio 1:1 to ∞:1 Sets the compression ratio.

6 Knee HARD, 1, 2, 3, 4, 5 Sets the way the de-esser effect is applied.

7 Attack 0 to 120 ms Sets the attack time.

8 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the 
operating frequency.

9 Gain ±0 dB to +18 dB Sets the output gain.

) Frequency 80 Hz to 10 kHz Sets the minimum signal frequency for compression. 

! On ON/OFF Turns the de-esser ON. 
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Ducking
Attenuates the output a particular amount, when an input signal exceeds its threshold. Both mono 
channel and stereo channel duckers are provided.
Mono channel duckers have one input, one output, and one KeyIn input. Stereo channel duckers have 
two inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono 
channel and stereo channel components. 

Name Function

1 Ducking Curve Displays results graphically. The horizontal axis is 
the input signal level, and the vertical axis is the 
output level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Range -70 dB to ±0 dB Sets the amount by which the level is reduced.

6 Attack 0 to 120 ms Sets the attack time.

7 Hold 44.1 kHz: 0.02 ms to 2.13 s
48 kHz: 0.02 ms to 1.96 s
88.2 kHz: 0.01 ms to 1.06 s
96 kHz: 0.01 ms to 981 ms

Sets the hold time.
The setting range may very, depending on the 
operating frequency.

8 Decay 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the decay time.
The setting range may very, depending on the 
operating frequency.

9 KeyIn Mono SELF
KEYIN

Selects the trigger source from a menu. 
The currently selected trigger source is displayed 
on the button.

Stereo L
R
LR BOTH
KEYIN

) On ON/OFF Turns the ducking ON. 
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Expander
Widens the dynamic range of the signal. Low-level signals such as noise are diminished. Both mono 
channel and stereo channel expanders are provided.
Mono channel expanders have one input, one output, and one KeyIn input. Stereo channel expanders 
have two inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono 
channel and stereo channel components. 

Name Function

1 Expander Curve Displays results graphically. The horizontal axis is 
the input signal level, and the vertical axis is the 
output level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Ratio 1:1 to ∞:1 Sets the compression ratio.

6 Knee HARD, 1, 2, 3, 4, 5 Sets the way the expander is applied.

8 Attack 0 to 120 ms Sets the attack time.
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Gate
Attenuates signals that are lower than the threshold level. Both mono channel and stereo channel 
gates are provided.
Mono channel gates have one input, one output, and one KeyIn input. Stereo channel gates have two 
inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono 
channel and stereo channel components. 

8 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the 
operating frequency.

9 Gain ±0 dB to +18 dB Sets the output gain.

) KeyIn Mono SELF
KEYIN

Selects the trigger source from a menu. The 
currently selected trigger source is displayed on the 
button.

Stereo L
R
LR BOTH
KEYIN

! On ON/OFF Turns the expander ON. 
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Limiter
Signals above the threshold are compressed at an ∞:1 ratio, preventing output of signals that exceed 
the threshold level. Mono channel and stereo channel components are provided.
Mono channel components have a single input and output plus a key input, while stereo channel 
components have two inputs and outputs and a key input.

Name Function

1 Gate Curve Displays results graphically. The horizontal axis is 
the input signal level, and the vertical axis is the 
output level.

2 Gain Reduction Meter Displays the gain reduction attenuation.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Range -70 dB to ±0 dB Sets the amount by which the level is reduced.

6 Attack 0 to 120 ms Sets the attack time.

7 Hold 44.1 kHz: 0.02 ms to 2.13 s
48 kHz: 0.02 ms to 1.96 s
88.2 kHz: 0.01 ms to 1.06 s
96 kHz: 0.01 ms to 981 ms

Sets the hold time.

8 Decay 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the decay time.
The setting range may very, depending on the 
operating frequency.

9 KeyIn Mono SELF
KEYIN

Selects the trigger source from a menu. The 
currently selected trigger source is displayed on the 
button.

Stereo L
R
LR BOTH
KEYIN

) On ON/OFF Turns the gate ON. 
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Double click the component to open the component editor. Mono channel and stereo channel 
components have the same parameters.

Name Function

1 Limiter Curve Displays the limiter response in graph form. The 
horizontal axis represents input signal level and the 
vertical axis represents output level.

2 Gain Reduction Meter Displays the amount of gain reduction.

3 Output Meter Displays the output signal level.

Parameter Setting Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold value.

5 Attack 0 to 120 ms Sets the attack time.

6 Release 44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time. The range varies according 
to the operating frequency.

9 KeyIn Mono SELF
KEYIN

The trigger source can be selected from this menu. 
The currently selected source is displayed in the 
button.

Stereo L
R
LR BOTH
KEYIN

) On ON/OFF Turns the limiter ON.
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Equalizer (EQ)
The equalizer boosts or cuts the levels of specified frequencies. The EQ group contains graphic 
equalizers (GEQ) and parametric equalizers (PEQ).
The frequency bands in the graphic equalizer are fixed. The graphical interface lets you visually check 
the gain of each frequency. There are three different types of equalizers, each with a different number 
of frequency bands. Mono channel and stereo channel equalizers are available for each type.
With the parametric equalizer, you can freely adjust the frequency bands, their amplitudes, and 
bandwidths. There are six different types of parametric equalizers, each with a different number of 
frequency bands. Mono channel and stereo channel equalizers are available for each type. 

Graphic Equalizer (GEQ)
Boosts or cuts signals within the specified frequencies. The mono group contains 7 band, 15 band, 
and 31 band mono channel components. The stereo group contains 7 band, 15 band, and 31 band 
stereo channel components.
Mono channel GEQs have one input and one output each. Stereo channel GEQs have two inputs and 
two outputs each.

Double-click a component to display the component editor for it. The number of bands varies 
depending on the component, but all share a common configuration in the component editor.

Name Function

1 Input Meter Displays the input signal level.

2 EQ Curve Displays the equalizer effect.

3 Output Meter Displays the output signal level.
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Stereo channel
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■ EQ Graph [Bypass] Button
A number for each frequency band is displayed on these buttons. When you click the button, it 
lights up and the bypass turns ON. When you turn this ON, bypassed sound (unchanged sound) is 
output. When you turn this OFF, the sound is output with effects applied.

Section Parameter Setting Range Function

4 Equalizer Bypass ON/OFF Bypasses all bands in the GEQ equalizer 
section.

5 Gain Set by [Range]. Sets the output gain for its band. 

6 GEQ ON ON/OFF Turns the GEQ ON. 

7 Range (Button) ±15
±12
±6
-24

Selects the gain adjust width.

8 EQ Flat -- Returns the faders of all bands to 0dB.

9 Input Level -∞ to +10 dB Sets the input signal level. 

) Phase ON/OFF Reverses the phase of the input signal.

! HPF Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency. 

@ Bypass ON/OFF Turns bypass ON. 

# LPF Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency. 

$ Bypass ON/OFF Turns bypass ON. 

% Notch Frequency 20 Hz to 20 kHz Sets the notch filter frequency. 

^ Q: 0.1 to 63.0 Sets the width of the frequency band that will 
be changed by the filter. 

& Bypass ON/OFF Turns bypass ON. 

* Output Level -∞ to ±0 dB Sets the signal level.

( On ON/OFF Turns output ON. 

Bypass ON Bypass OFF
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Parametric Equalizer (PEQ)
Boosts or cuts signals within specified frequencies. In both the Mono group and Stereo group there 
are 2 band, 3 band, 4 band, 6 band, and 8 band components available.
Mono channel PEQs have one input and one output each. Stereo channel PEQs have two inputs and 
two outputs each. The number of bands varies depending on the component, but all share a common 
configuration in the component editor.

Double-click a component to display the component editor for it. The number of bands varies 
depending on the component, but all share a common configuration in the component editor.

Name Function

1 EQ Curve Displays the equalizer effect.
You can change the parameter by dragging 
the control point with the mouse. 

Section Parameter Setting Range Function

2 Input Level -∞ to +10 dB Sets the input signal level. 

3 Phase ON/OFF Reverses the phase of the input signal.

4 Equalizer Type PEQ
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF

Select the filter type from the menu.

5 Q 0.1 to 16.0 Sets the band width for each frequency 
band. 

6 Frequency 20 Hz to 20 kHz Sets the frequency for each band. 

7 Gain -18 dB to +18 dB Sets the level of the frequency that will be 
changed.

8 Bypass ON/OFF Turns ON bypass for each band. 

1

8

5

6

7

3

2

!

)

9
4

PEQ component editor
DME Designer Owner’s Manual



Chapter 6  Component Guide
■ Filter Type
Various types of curves are available for changing the level. Click the [Type] button and select the 
type from the menu. 

• PEQ
This is a general parametric equalizer. 

• L. SHELF (Low Shelving)
There is no sound attenuation at low frequencies. The sound is attenuated at a constant rate 
from the cutoff frequency towards the higher frequencies. The attenuation rate per octave can 
be set to [6 dB/Oct] or [12 dB/Oct].

• H.SHELF (High Shelving)
There is no sound attenuation at high frequencies. The sound is attenuated at a constant rate 
from the cutoff frequency towards the lower frequencies. The attenuation rate per octave can 
be set to [6 dB/Oct] or [12 dB/Oct].

• HPF
This is a high-pass filter (Q=0.7). Attenuates the low frequencies with a gentle curve (12 dB/
Oct). 

• LPF
This is a low-pass filter (Q=0.7). Attenuates the high frequencies with a gentle curve (12 dB/
Oct). 

9 Equalizer PEQ ON ON/OFF Turns the PEQ ON

) Output Level -∞ to ±0 dB Sets the output signal level.

! On ON/OFF Turns output ON. 
DME Designer Owner’s Manual 347



Chapter 6  Component Guide

348
Fader
Controls the output level for each channel. Fader components are available for 1, 2, 4, 8, 12, and 16 
channels.

Double-click a component to display the component editor for it. The number of channels varies, but 
all components share a common configuration in the component editor.

■ [Fade]
Sets the action of the fader when there is a large change in its position during scene recall. When 
you turn this ON, the fader moves gradually to the position after the jump. If you turn this OFF, it 
immediately jumps to the parameters saved in the recalled scene. 
See “The ‘Scene Manager’ Dialog Box” (page 63) for details about settings for the components to 
be faded and the time period when the [Fade] is On. 

Parameter Setting Range Function

1 Phase ON/OFF Reverses the phase of the output signal for each 
channel. 

2 On ON/OFF Turns ON each channel’s output. 

3 Fader -∞ to +10 dB Sets the output signal level for each channel. 

4 Fade ON/OFF Sets fade during scene recall ON or OFF.
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Fader component editor
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Filters
A filter passes specific frequencies and attenuates all others. 
There are seven types of filters available in the filter group: band pass filter (BPF), high pass filter 
(HPF), low pass filter (LPF), notch filter (Notch), programmable BPF, programmable HPF, and 
programmable LPF. 

Band Pass Filter (BPF)
The band pass filter passes the signal from a specified frequency band, while attenuating frequencies 
outside that band. There are two types of BPF components: mono channel and stereo channel. Mono 
channel BPFs have one input and one output. Stereo channel BPFs have two of each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components. 

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 BPF Frequency 20 Hz to 20 kHz Sets the center frequency.

4 Q: 0.1 to 16.0 Sets the band width of a frequency band. 

5 Bypass ON/OFF Turns bypass ON. 

6 Output Level -∞ to ±0 dB Sets the output signal level.
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High Pass Filter (HPF)
The high pass filter passes frequencies in the signal that are higher than a specified frequency, while 
attenuating lower frequencies in the signal. There are two types of HPF components: mono channel 
and stereo channel. Mono channel HPFs have one input and one output. Stereo channel HPFs have 
two of each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components.

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 HPF Frequency 20 Hz to 20 kHz Sets the cutoff frequency. 

4 Slope 6 dB/Oct
12 dB/Oct

Sets the attenuation for each octave.

5 Bypass ON/OFF Turns bypass ON. 

6 Output Level -∞ to ±0 dB Sets the output signal level.
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Low Pass Filter (LPF)
The low pass filter passes frequencies in the signal that are lower than a specified frequency, while 
attenuating higher frequencies in the signal. There are two types of LPF components: mono channel 
and stereo channel. Mono channel LPFs have one input and one output. Stereo channel LPFs have 
two of each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components. 

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 LPF Frequency 20 Hz to 20 kHz Sets the cutoff frequency. 

4 Slope 6 dB/Oct
12 dB/Oct

Sets the attenuation for each octave.

5 Bypass ON/OFF Turns bypass ON. 

6 Output Level -∞ to ±0 dB Sets the output signal level.
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Notch Filter (Notch)
The notch filter attenuates the signal within a specified frequency band, while passing frequencies 
outside that band. There are two types of notch filter components: mono channel and stereo channel. 
Mono channel notch filters have one input and one output. Stereo channel notch filters have two of 
each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components. 

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 Notch Frequency 20 Hz to 20 kHz Sets the center frequency.

4 Q: 0.1 to 63.0 Sets the band width of the frequency band 
that will be changed

5 Bypass ON/OFF Turns bypass ON. 

6 Output Level -∞ to ±0 dB Sets the output signal level.
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Programmable BPF
The band pass filter passes the signal from a specified frequency band, while attenuating frequencies 
outside that band. With the programmable band pass filter you can set the filter type and the slope 
between the frequency band that is passed and the band that is cutoff. 
There are two types of programmable BPF components: mono channel and stereo channel. Mono 
channel programmable BPFs have one input and one output. Stereo channel programmable BPFs 
have two of each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components. 

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 HPF Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency. 

4 Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

5 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency.

6 Bypass ON/OFF Turns bypass ON. 
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7 LPF Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency. 

8 Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

9 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency. 

) Bypass ON/OFF Turns bypass ON. 

! Output Level -∞ to ±0 dB Sets the output signal level.

Section Parameter Setting Range Function
DME Designer Owner’s Manual



Chapter 6  Component Guide
Programmable HPF
The high pass filter passes frequencies in the signal that are higher the specified frequency, while 
attenuating lower frequencies in the signal. With the programmable high pass filter you can set the 
filter type and the slope between the frequency band that is passed and the band that is cutoff. 
There are two types of programmable HPF components: mono channel and stereo channel. Mono 
channel programmable HPFs have one input and one output. Stereo channel programmable HPFs 
have two of each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components. 

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 HPF Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency. 

5 Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

6 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency. 

7 Bypass ON/OFF Turns bypass ON. 

8 Output Level -∞ to ±0 dB Sets the output signal level.

2 6

1

3

7

4

5

Programmable HPF component editors 
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Programmable LPF
The low pass filter passes frequencies in the signal that are lower than the specified frequency, while 
attenuating higher frequencies in the signal. With the programmable low pass filter you can set the 
filter type and the slope between the frequency band that is passed and the band that is cutoff. 
There are two types of programmable LPF components: mono channel and stereo channel. Mono 
channel programmable LPFs have one input and one output. Stereo channel programmable LPFs 
have two of each. 

Double-click a component to display the component editor for it. The parameters are the same for 
mono channel and stereo channel components.

Section Parameter Setting Range Function

1 Input Level -∞ to +10 dB Sets the input signal level. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 LPF Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency. 

5 Type Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the 
filter type. 
[THRU] turns off the filter.

6 Gc -6 dB to +6 dB When [AdjustGc] (Adjustable Gc) is selected 
for [Type], this sets the gain for the cutoff 
frequency. 

7 Bypass ON/OFF Turns bypass ON. 

8 Output Level -∞ to ±0 dB Sets the output signal level.

2
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Programmable LPF component editor
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Meter
Displays signal levels. Meter components are available with 1, 2, 4, 8, 12, and 16 channels. 

Double-click a component to display the component editor for it. The number of channels varies 
depending on the component, but all share a common configuration in the component editor.

Name Function

1 Meter Displays signal levels for each channel. 

1

Meter component editor
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Miscellaneous
In the Miscellaneous group, there are the Oscillator subgroup and the Wav File Player.

Oscillator
The Oscillator subgroup contains a monochannel oscillator component. The oscillator generates sine 
waves at fixed frequencies of 100 Hz, 1 kHz, and 10 kHz, a variable frequency sine wave, pink noise, 
and burst noise. The oscillator component has two outputs. 

Double-click a component to display the component editor for it. 

Pink Noise
A standard signal used for sound measurement.
This sound covers a frequency range of 20 Hz to 20 kHz. As the frequency doubles, the energy of 
the sound is cut in half. The sound level is equal at all frequencies.

Burst
Outputs pink noise continuously.

Section Parameter Setting Range Function

1 Wave Form Sine 100 Hz
1 kHz
10 kHz
Vari

Selects the frequency and waveform that will 
be generated. Only one of the six [Sine] and 
[Noise] buttons can be selected. 

2 Noise Pink
Burst

3 Frequency 20 Hz to 20 kHz When [Vari] is selected for [Sine], this sets 
the frequency of the generated sine wave. 

4 Output Level -∞ to +6 dB Displays the signal level.

5 On ON/OFF Turns ON the oscillator. 

6 Meter -- Displays the output signal level.

1
6

4

3
5

2

Oscillator component editor 
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Wav File Player
The Wav File Player is a component for playing Wave files. Only one Wav File Player component can 
be arranged for each single DME unit. 

Double-click the component to display the component editor for it. 

NOTE

If you switch the effect type for SPX components while playing Wave file by Wav File Player, drop-outs in the sound played in 
the Wav File Player may occur. 

Section Parameter Setting Range Function

1 Ex. Input Level -∞ to 0 dB Sets the input level from an input port. Only effective 
when “External Input” is selected as the playback file.

2 Wav File Player Play 001 to 100 Selects and displays the playback file.
Only files set in the DME unit in which this component 
is placed by the Wav File Manager can be selected.

3 List -- Open the Wav File Manager to display a list of files set 
in the DME unit in which this component is located.
This list functions as a play list.

4 IG -- Selects the previous file in the play list. 

5 HI -- Selects the next file in the playsuit. 

6 F -- Plays the selected Wave file. Mute is turned OFF 
when “External Input” is selected.

7 J -- Stops playback of the Wave file. Muted when 
“External Input” is selected.

NOTE

Playback will be paused if synchronization is carried out in the “Designer ← DME” direction during playback.
Playback will resume once synchronization is complete, but if a Wave file was being played it will resume playback from the 
beginning.

1

2 4 5 6 7 3

Wav File Player component editor
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Mixer
The Mixer group contains the Auto Mixer, Delay Matrix, and Matrix Mixer. 

Auto Mixer
There is a noise gate for each input channel, which passes only signals that exceed a specified 
threshold. There are five mixer types, each with a different number of inputs. 

Double-click a component to display the component editor for it. The number of channels varies 
depending on the component, but all share a common configuration in the component editor. The auto 
mixer component editor consists of two sections: input channels and master output. 

1

3

8

4

5

2

6
7 )

9

!

Auto Mixer component editor 
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Section Parameter Setting Range Function

1 Input Channels Phase ON/OFF Reverses the phase of each channel’s 
input signal. 

2 Gate Indicator -- When the gate is open, the light turns 
green. When the gate is closed, the light 
turns yellow.

3 Threshold -54 dB to ±0 dB Sets the threshold value for each gate.

4 Hold 44.1 kHz: 110 m to 2.13 s
48 kHz: 101 m to 1.96 s
88.2 kHz: 55.1 m to 1.06 s
96 kHz: 50. 6m to 981 m

Sets the gate hold time.
The setting range may vary, depending 
on the operating frequency.

5 Input Channels Decay 44.1 kHz: 110 m to 46 s
48 kHz: 101 m to 42.3 s
88.2 kHz: 55 m to 23 s
96 kHz: 51 m to 21.1 s

Sets the speed for closing the gate.
The setting range may vary, depending 
on the operating frequency.

6 Solo ON/OFF Turns solo ON. 

7 On ON/OFF Turns ON each channel’s input. 

8 Fader -∞ to +10 dB Sets the input signal level for each 
channel. 

9 Master Output Gain Correct ON/OFF Turns ON gain correction. 

) On ON/OFF Turns ON each channel’s output. 

! Master -∞ to +10 dB Sets the output signal level.
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Delay Matrix
This is a matrix mixer that allows you to set an independent delay time and level adjustment for each 
output. There are three groups of delay matrix, based on the number of inputs: 2 Input, 4 Input, and 8 
Input. In each of the three groups there are five mixers available with 2, 4, 8, 12, or 16 outputs, for a 
total of 15 components.

Double-click a component to display the component editor for it. The number of input and output 
channels varies depending on the component, but all share a common configuration in the 
component editor.
The delay matrix component editor consists of four sections: input, output, matrix, and block. The 
[Master] buttons in the [Input] and [Output] sections display windows where you can make master 
input and output settings. Delay and level for each channel are set in separate windows that display 
four channels each. 

Section Name Function

1 Input Master Opens the Input Master window.

2 Output Master Opens the Output Master window.

3 Matrix Delay meters
Output level meters

Displays output level and delay time for each output 
channel. Clicking here displays the Crosspoint window.

2 Input

4 Input

8 Input

1

2
4
5

7
6

3

Delay Matrix component editor 
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■ Matrix (Delay Meter/Output Level Meter)
The upper row has delay meters, while the middle row has output level meters. You can view 
parameters for all output channels at once. 

When you click the output channel number on the matrix, the [Delay Matrix - All Inputs to One 
Output] editor window opens. When you click the input channel number on the left side of the 
matrix, the [Delay Matrix - One Input to All Outputs] editor window opens.

The matrix is divided into groups. For the 2 Input matrix, each group has two input channels and 
four output channels. For the 4 Input matrix, each group has four input channels and four output 
channels. Groups in matrixes with more than four inputs are the same as for the 4 Input matrix. 
When you place the mouse pointer over a group, its channel numbers are highlighted. Click to 
open the [Delay Matrix - Crosspoint] editor window.

4 Block On Turns ON output for all channels in the Crosspoint 
window. Lights the [ON] button (does not change the 
delay matrix component editor).

5 Off Turns OFF output for all channels in the Crosspoint 
window (does not change the delay matrix component 
editor). 

6 Nominal Resets all output levels in the Crosspoint window, 
making them 0 dB. The delay settings are not changed.

7 Minimum Resets all output levels in the Crosspoint window, 
making them -∞ dB. The delay settings are not 
changed.

Section Name Function

Output Level Meter

Delay Meter

Click to open the [Delay Matrix - All Inputs
to One Output] editor window.

Click to open the [Delay Matrix - One Input
to All Outputs] editor window.

Click to open the “In 1-4 x 
Out 1-4” Crosspoint window.

Click to open the “In 5-8 x Out 
5-8” Crosspoint window.

For 2 input matrix, click to 
open the “In 1-2 x Out 1-4” 
Crosspoint window.
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■ Input Master
If you click the [Input Master] button in the delay matrix component editor, it will open the [Delay 
Matrix - InputMaster] editor window. Here you can turn the master input for each channel ON and 
OFF and set the level. 

Section Parameter Setting Range Function

1 Input Phase ON/OFF Reverses the phase of each channel’s signal. 

2 Level -∞ to +10 dB Sets the level of the signal from each channel’s 
input. 

3 Solo ON/OFF Turns ON solo for each channel. 

4 On ON/OFF Turns ON each channel’s input. 

5 Block On -- Turns ON input for all channels in the Input Master 
window. When turned ON, the [On] button lights up. 

6 Off -- Turns OFF input for all channels in the Input Master 
window. 

7 Nominal -- Resets all input signal levels in the Input Master 
window, making them 0 dB. 

8 Minimum -- Resets all input signal levels in the Input Master 
windows, making them -∞ dB.

5
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[Delay Matrix - InputMaster] editor window
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■ Output Master
If you click the [Output Master] button in the delay matrix component editor, it will open the [Delay 
Matrix - OutputMaster] editor window. Here you can turn the master output for each channel ON 
and OFF and set the level. 

Section Parameter Setting Range Function

1 Output Meter -- Displays the output signal level for each channel. 

2 Level -∞ to +10 dB Sets the output signal level for each channel. 

3 On ON/OFF Turns ON each channel’s output. 

4 Block On -- Turns ON output for all channels in the Output 
Master window. When turned ON, the [On] button 
lights up. 

5 Off -- Turns OFF output for all channels in the Output 
Master window. 

6 Nominal -- Resets all output signal levels in the Output Master 
window, making them 0 dB. 

7 Minimum -- Resets all output signal levels in the Output Master 
window, making them -∞ dB.

4
5

7
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3

[Delay Matrix - OutputMaster] editor window
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■ All Inputs to One Output
When you click the output channel number on the matrix, the [Delay Matrix - All Inputs to One 
Output] editor window opens. All input channels and one output channel are displayed. The output 
channel is the one you have clicked on in the delay mixer component editor.

Output Channel Switching
The [Delay Matrix - All Inputs to One Output] editor window displays the output channel clicked on 
in the delay matrix component editor. The [Channel] buttons in the [Output] section of the [Delay 
Matrix - All Inputs to One Output] editor window switch the channel group that is displayed in the 
window. 

If you make the delay matrix component editor active while the [Delay Matrix - All Inputs to One 
Output] editor window is displayed, and then click another output channel, that channel group will 
be displayed in the [Delay Matrix - All Inputs to One Output] editor window.
One [Delay Matrix - All Inputs to One Output] editor window is displayed for each delay matrix 
component editor.

Section Parameter Setting Range Function

1 Bus Send Level Delay 0 to 500 Sets the delay time for each input channel.

2 Level -∞ to +10 dB Sets the output signal level for each input channel.

3 On ON/OFF Turns ON the output for each input channel. 

4 Output Channel -- Displays the selected output channel. Select 
another channel from a menu. 

5 On ON/OFF Turns ON the output for the channel displayed in 
the window. 

6 Meter -- Displays the output signal level of the channel 
displayed in the window. 

7 Block On -- Turns ON all channel inputs. When turned ON, the 
[On] button lights up. 

8 Off -- Turns OFF all channel inputs.

9 Nominal -- Resets all of input signal levels, making them 0 dB.

) Minimum -- Resets all of input signal levels, making them -∞ dB.
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■ One Input to All Outputs
When you click the input channel number on the left side of matrix, the [Delay Matrix - One Input to 
All Outputs] editor window opens. One input channel and all output channels are displayed. The 
input channel is the one you have clicked on in the delay mixer component editor.

Input Channel Switching
The [Delay Matrix - One Input to All Outputs] editor window displays the input channel for the 
channel number clicked on in the delay matrix component editor.
The [Channel] buttons in the [Input] section of the [Delay Matrix - All Inputs to One Output] editor 
window switch the channel group that is displayed in the window. 

Section Parameter Setting Range Function

1 Input Channel -- Displays the selected input channel. Select another 
channel from a menu. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 Level -∞ to +10 dB Sets the input signal level. 

4 Solo ON/OFF Turns solo ON. 

5 On ON/OFF Turns input ON. 

6 Bus Send Level Delay 0 to 500 Sets the delay time for each output channel.

7 Level -∞ to +10 dB Sets the signal level for each output channel. 

8 On ON/OFF Turns ON the output for each output channel. 

9 Block On -- Turns ON all channel outputs. When turned ON, the 
[On] button lights up. 

) Off -- Turns OFF all channel outputs.

! Nominal -- Resets all output signal levels, making them 0 dB. 

@ Minimum -- Resets all output signal levels, making them -∞ dB.

9
)
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If you make the delay matrix component editor active while the [Delay Matrix - One Input to All 
Outputs] editor window is displayed, and then click another input channel, that channel will be 
displayed in the [Delay Matrix - One Input to All Outputs] editor window.
One [Delay Matrix - One Input to All Outputs] editor window is displayed for each delay matrix 
component editor.

■ Crosspoint
If you click a level meter in the delay 
matrix component editor, that group's 
[Delay Matrix - Crosspoint] editor 
window will be displayed. Turns the 
input channels ON and OFF and sets 
their levels. Just like the delay matrix 
component editor, the input channels 
are arranged vertically while the output 
channels are arranged horizontally.

Section Parameter Setting Range Function

1 Input Channel -- Switches to another channel group. 

2 Output Channel -- Switches to another channel group. 

3 Bus Send Level Delay 0 to 500 Sets the delay time for each crosspoint.

4 Level -∞ to +10 dB Sets the output signal level for each crosspoint. 

5 On ON/OFF Turns ON output for each crosspoint. 

6 Block On -- Turns ON output for all channels in the Crosspoint 
window. The [On] button lights up. 

7 Off -- Turns OFF output for all channels in the Crosspoint 
window. 

8 Nominal -- Resets all output signal levels in the Crosspoint 
window, making them 0 dB. 

9 Minimum -- Resets all output signal levels in the Crosspoint 
window, making them -∞ dB.
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Channel Group Switching
The [Delay Matrix - Crosspoint] editor window displays four channels each for Input and Output. 
It displays the channel group you click on in the delay matrix component editor. The [Channel] 
buttons in the [Input] and [Output] sections of the [Delay Matrix - Crosspoint] editor window switch 
the channel group that is displayed in the window. 

If you click another channel group when the delay matrix component editor is active and an [Delay 
Matrix - Crosspoint] editor window is displayed, that channel group will be displayed in the open 
[Delay Matrix - Crosspoint] editor window.
Only one [Delay Matrix - Crosspoint] matrix window is displayed for each delay matrix component 
editor.

Matrix Mixer
In the matrix mixer, the input channels and output buses are arranged in a checkerboard 
configuration. You can adjust the group balance for each output bus. There are 24 components in the 
in the Matrix Mixer group, each with different numbers of input and output channels. There are seven 
groups based on the number of inputs, as follows: 2 Input, 4 Input, 8 Input, 12 Input, 16 Input, 32 
Input, and 64 Input.

[Input] section 
[Channel] menu 

[Output] section 
[Channel] menu 
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Double-click a component to display the component editor for it. The number of input and output 
channels varies depending on the component, but all share a common configuration in the 
component editor.
The matrix mixer component editor consists of four sections: input, output, matrix, and block. The 
[Master] buttons in the [Input] and [Output] sections display windows where you can make master 
input and output settings. The level for each channel is set in separate windows that display four 
channels each. 

NOTE

If a 64 input 64 output Matrix Mixer component or a 64 input 32 output Matrix Mixer component is placed in the DME64N 
configuration window, no other components can be used even though the resource meter does not reach 100%. The 64 
input 64 output Matrix Mixer component or the 64 input 32 output Matrix Mixer component cannot be used in the DME24N.

Section Name Function

1 Input Master Opens the Input Master window.

2 Output Master Opens the Output Master window.

3 Matrix Output level meters These meters display the output level for each channel. 
Clicking here displays the Crosspoint window.

4 Block On Turns ON output for all channels in the Crosspoint window. 
Lights the [ON] button (does not change the matrix mixer 
component editor).

5 Off Turns OFF output for all channels in the Crosspoint window 
(does not change the matrix mixer component editor). 

6 Nominal Resets all output levels in the Crosspoint window, making 
them 0 dB. 

7 Minimum Resets all output levels in the Crosspoint window, making 
them -∞ dB.
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■ Matrix (Output Level Meters)
In the matrix, you can view levels for all output channels at once. The meter will be grayed out when 
the corresponding channel is set to Off. 

When you click an output channel number on the matrix, the [Matrix Mixer - All Inputs to One 
Output] editor window opens. When you click the input channel number on the left side of the 
matrix, the [Matrix Mixer - One Input to All Outputs] editor window opens.

The matrix is divided into groups, each with four input channels and four output channels. When 
you place the mouse pointer over a group, its channel numbers are highlighted. Click to open the 
[Matrix Mixer - Crosspoint] editor window.

Output level meter

Click to open the [Matrix Mixer - All
Inputs to One Output] editor window.

Click to open the [Matrix Mixer - One
Input to All Outputs] editor window.

Click to open the “In 1-4 x Out 5-8” 
[Matrix Mixer - Crosspoint] editor window
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■ Input Master
If you click the [Input Master] button in the matrix mixer component editor, it will open the [Matrix 
Mixer - InputMaster] editor window. Here you can turn the master input for each channel ON and 
OFF and set the level. 

Section Parameter Setting Range Function

1 Input Phase ON/OFF Reverses the phase of each channel’s signal.

2 Level -∞ to +10 dB Sets the signal level from each channel input to the 
output bus.

3 Solo ON/OFF Turns ON solo for each channel.

4 On ON/OFF Turns ON each channel’s input.

5 Block On -- Turns ON input for all channels in the Input Master 
window. When turned ON, the [On] button lights up.

6 Off -- Turns OFF input for all channels in the Input Master 
window.

7 Nominal -- Resets all output signal levels in the Input Master 
window, making them 0 dB.

8 Minimum -- Resets all output signal levels in the Input master 
window, making them -∞ dB.

[Matrix Mixer - InputMaster] G f B ^ [ E B h E
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[Matrix Mixer - InputMaster] editor window
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■ Output Master Window
If you click the [Output Master] button in the matrix mixer component editor, it will open the Output 
Master window. Her you can turn the master output for each channel ON and OFF and set the level. 

Section Parameter Setting Range Function

1 Output Meter -- Displays the output signal level for each channel. 

2 Level -∞ to +10 dB Sets the output signal level for each channel. 

3 On ON/OFF Turns ON each channel’s output. 

4 Block On -- Turns ON output for all channels in the Output 
Master window. When turned ON, the [On] button 
lights up.

5 Off -- Turns OFF output for all channels in the Output 
Master window. 

6 Nominal -- Resets all output signal levels in the Output Master 
window, making them 0 dB. 

7 Minimum -- Resets all output signal levels in the Output Master 
window, making them -∞ dB.

[Matrix Mixer - OutputMaster] G f B ^ [ E B h E
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■ All Inputs to One Output
When you click the output channel number on the matrix, the [Matrix Mixer - All Inputs to One 
Output] editor window opens. All input channels and one output channel are displayed. The output 
channel is the one you have clicked on in the matrix mixer component editor.

Output Channel Switching
[Matrix Mixer - All Inputs to One Output] editor window displays the output channel clicked in the 
matrix mixer component editor. The [Channel] buttons in the [Output] section of the [Matrix Mixer - 
All Inputs to One Output] editor window switch the channel group that is displayed in the window. 

If you make the matrix mixer component editor active while the [Matrix Mixer - All Inputs to One 
Output] editor window is displayed, and then click another output channel, that channel group will 
be displayed in the [Matrix Mixer - All Inputs to One Output] editor window.
One [Matrix Mixer - All Inputs to One Output] editor window is displayed for each matrix mixer 
component editor.

Section Parameter Setting Range Function

1 Bus Send Level Level -∞ to +10 dB Sets the output signal level for each input channel.

2 On ON/OFF Turns ON the output for each input channel.

3 Output Channel -- Displays the selected output channel. Select 
another channel from a menu. 

4 On ON/OFF Turns ON the output for the channel displayed in 
the window.

5 Meter -- Displays the output signal level of the channel 
displayed in the window.

6 Block On -- Turns ON all channel inputs. When turned ON, the 
[On] button lights up.

7 Off -- Turns OFF all channel inputs.

8 Nominal -- Resets all input signal levels, making them 0 dB.

9 Minimum -- Reset all input signal levels, making them -∞ dB.
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■ One Input to All Outputs
When you click the input channel number on the left side of the matrix, the [Matrix Mixer - One Input 
to All Outputs] editor window opens. One input channel and all output channels are displayed. The 
input channel is the one you have clicked on in the delay mixer component editor.

Input Channel Switching
The [Matrix Mixer - One Input to All Outputs] editor window displays the input channel for the 
channel number clicked on in the matrix mixer component editor.
The [Channel] buttons in the [Input] section of the [Matrix Mixer - All Inputs to One Output] editor 
window switch the channel group that is displayed in the window.

If you make the matrix mixer component editor active while the [Matrix Mixer- One Input to All 
Outputs] editor window is displayed, and then click another input channel, that channel will be 
displayed in the [Matrix Mixer - One Input to All Outputs] editor window.
One [Matrix Mixer - One Input to All Outputs] editor window is displayed for each matrix mixer 
component editor.

Section Parameter Setting Range Function

1 Input Channel -- Displays the selected input channel. Select 
another channel from a menu. 

2 Phase ON/OFF Reverses the phase of the input signal.

3 Level -∞ to +10 dB Sets the input signal level. 

4 Solo ON/OFF Turns solo ON. 

5 On ON/OFF Turns input ON. 

6 Bus Send Level Level -∞ to +10 dB Sets the signal level for each output channel. 

7 On ON/OFF Turns ON the output for each output channel. 

8 Block On -- Turns ON all channel outputs. When turned 
ON, the [On] button lights up. 

9 Off -- Turns OFF all channel outputs.

) Nominal -- Resets all output signal levels, making them 
0 dB. 

! Minimum -- Resets all output signal levels, making them 
-∞ dB.
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■ Crosspoint
If you click a level meter in the matrix mixer component editor, the output crosspoint window for the 
group will be displayed. Turns the input channels ON and OFF and sets their levels. Just like the 
matrix mixture component editor, the input channels are arranged vertically while the output 
channels are arranged horizontally.

Section Parameter Setting Range Function

1 Input Channel -- Switches to another channel group. 

2 Output Channel -- Switches to another channel group. 

3 Bus Send Level Level -∞ to +10 dB Sets the output signal level for each crosspoint. 

4 On ON/OFF Turns ON output for each crosspoint. 

5 Block On -- Turns ON output for all channels in the Crosspoint 
window. When turned ON, the [On] button lights up. 

6 Off -- Turns OFF output for all channels in the Crosspoint 
window. 

7 Nominal -- Resets all output signal levels in the Crosspoint 
window, making them 0 dB. 

8 Minimum -- Resets all output signal levels in the Crosspoint 
window, making them -∞ dB.

[Matrix Mixer - Crosspoint] G f B ^ [ E B h E

5
6

8
7

1

2

3

4

[Matrix Mixer - Crosspoint] editor window
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Channel Group Switching
The [Matrix Mixer - Crosspoint] editor window displays four channels each for Input and Output. 
It displays the channel group that was clicked on in the matrix mixer component editor. The 
[Channel] buttons in the [Input] and [Output] sections of the [Matrix Mixer - Crosspoint] editor 
window switch the channel group that is displayed. 

If you click another channel group when the matrix mixer component editor is active and an [Matrix 
Mixer - Crosspoint] editor window is displayed, that channel group will be displayed in the open 
[Matrix Mixer - Crosspoint] editor window.
Only one [Matrix Mixer - Crosspoint] matrix window is displayed for each matrix mixer component 
editor.

[Input] section 
[Channel] menu 

[Output] section 
[Channel] menu 
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Pan
The Pan group contains the following subgroups: LCR, LR, and Surround.

■ Pan Nominal Position
Component editors for both LCR and Surround contain the “Pan Nominal Position” parameter. 
The button for that parameter displays its current setting. Clicking the button displays a menu with 
[Center] and [LR], which are used to set the pan 0 dB reference. 

Center (Center Nominal)
Uses the center volume as a reference, setting it as 0 dB. The LR speakers are -3 dB. 

LR (LR Nominal)
Uses the LR speaker volumes as a reference, setting them as 0 dB. The center volume is +3 dB. 

LCR
In the LCR component, one input is divided into left, center, and right outputs. The number of outputs 
is triple the inputs. Components are available with 1, 2, 4, 8, 12, and 16 channels. 

Double-click a component to display the component editor for it. The number of channels varies 
depending on the component, but all share a common configuration in the component editor.
DME Designer Owner’s Manual



Chapter 6  Component Guide
LR
Separates a single input into left and right outputs. Components are available with 1, 2, 4, 8, 12, and 
16 channels. 

Double-click a component to display the component editor for it. The number of channels varies 
depending on the component, but all share a common configuration in the component editor.

Parameter Setting Range Function

1 CSR 0 to 100% Sets the ratio for sending the center signal to LR. 

2 Pan L63 - Center - R63 Sets LR orientation. 

3 Pan Nominal Position Center
LR

Selects the nominal position from a menu. 

Parameter Setting Range Function

1 Pan L63 - R63 Sets the LR orientation. 

2 Pan Nominal Position Center
LR

Selects the nominal position from a menu.

1

3

2

LCR component editor 

2

1

Pan component editor 
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Surround
There are three types of surround pan components in the Surround subgroup: 3-1, 5.1, and 6.1. 
The surround pan component editor has a two-dimensional surround pan graph where you can set the 
location of the sound image. 

You can set the sound location using the mouse in the two-dimensional surround pan graph. 
The sound image location is displayed at the bottom of the two-dimensional surround pan graph, but 
numbers cannot be entered there. 

Name
Location, 

Setting Range
Function

1 2D Surround Pan Graph -- Sets the sound image orientation. You can 
move the sound image by clicking and 
dragging.

2 Speaker 
Button

L Left L63  F63 Clicking here moves the sound image to the 
button location.

3 C Center C  F63

4 R Right R63  F63

5 Ls Left Surround L63  R63

6 Bs Back Surround C  R63

7 Rs Right Surround R63  R63

8 LFE Low Frequency 
Effect (Sub Woofer)

-- Indicates that there is a sub woofer. Clicking 
makes the LFE level 0 dB. The sound image 
does not move by clicking.

9 Left-Right Position L63 - C - R63 Displays the LR sound image. 

) Front-Back Position L63 - C - R63 Displays the front-back sound image. 

1

2

8

3 4

5 6 7

9 )

Surround 6.1 component editor 
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Dragging
You can move the control by dragging it with the mouse. 

Click
If you click within the graph, the control point will move to that position. 

Click
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Speaker Button
If you click any speaker button besides the [LFE] button, the control point will jump to that 
speaker’s position. 

Click
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■ Surround 3-1
Surround 3-1 has four channel surround pan, with three channels in front, and one in the rear. There 
is one input and four outputs. 

Double-click a component to display the component editor for it. 

Section Name/Parameter Setting Range Function

1 2D Surround 
Pan Graph

2D Surround 
Pan Graph

-- Sets the sound image orientation. You can 
move the sound image by clicking and 
dragging. 

2 Speaker Button -- Clicking here moves the sound image to the 
button location.

3 Position Left-Right Position L63 - C - R63 Displays the LR surround location. 

4 Front-Back Position F63 - C - R63 Displays the front-back surround location. 

5 Divergence Front 0 to 100% Sets the ratio for sending the front-center 
signal to front L and front R. 

6 Pan Nominal Position Center
LR

Selects the nominal position from a menu.

1

2

3 4

5

6

2

Surround 3-1 component editor 
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■ Surround 5.1 
Surround 5.1 has surround pan with three channels in front, two in the rear, and one sub woofer 
channel. There is one input and six outputs. 

Double-click a component to display the component editor for it. 

Section Name/Parameter Setting Range Function

1 2D Surround 
Pan Graph

2D Surround 
Pan Graph

-- Sets the sound image orientation. You can 
move the sound image by clicking and 
dragging. 

2 Speaker Button -- Clicking here moves the sound image to the 
button location.

3 Position Left-Right Position L63 - C - R63 Displays the LR surround location. 

4 Front-Back Position F63 - C - R63 Displays the front-back surround location. 

5 Divergence Front 0 to 100% Sets the ratio for sending the front-center 
signal to front L and front R. 

6 LFE Level -∞ to +10 dB Sets output level to the sub woofer. 

7 Pan Nominal Position Center
LR

Selects the nominal position from a menu. 

1

3 4

5

6

7

2

2

Surround 5.1 component editor 
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■ Surround 6.1 
Surround 6.1 has surround pan with three channels in front, three in the rear, and one sub woofer 
channel. There is one input and seven outputs. 

Double-click a component to display the component editor for it. 

Section Name/Parameter Setting Range Function

1 2D Surround 
Pan Graph

2D Surround 
Pan Graph

-- Sets the sound image orientation. You can 
move the sound image by clicking and 
dragging. 

2 Speaker Button -- Clicking here moves the sound image to the 
button location.

3 Position Left-Right Position L63 - C - R63 Displays the LR surround location. 

4 Front-Back Position F63 - C - R63 Displays the front-back surround location. 

5 Divergence Front 0 to 100% Sets the ratio for sending the front-center 
signal to front L and front R. 

6 Rear 0 to 100% Sets the ratio for sending the rear-center 
signal to rear L and rear R. 

7 LFE Level -∞ to +10 dB Sets output level to the sub woofer. 

8 Pan Nominal Position Center
LR

Selects the nominal position from a menu. 

1

2

2

3 4

5

6

7

8

Surround 6.1 component editor 
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Router
The router assigns inputs to outputs. Each of the six router groups has a different number of inputs. 
The groups are 1 input, 2 input, 4 input, 8 input, 12 input and 16 input. Each group has five 
components, with 2, 4, 8, 12, and 16 outputs. 

Double-click a component to display the component editor for it. The number of channels varies 
depending on the component, but all share a common configuration in the component editor.

Routers let you route signals from various [Input] locations by connecting them to various [Output] 
locations.
One output can be connected to one input only. A single input can be output to multiple channels, but 
multiple inputs cannot be output over a single channel. In other words, you can distribute the inputs, 
but you cannot mix them. You cannot setup routing for more signals than the number of output 
channels. 

1 Input

2 Input

8 Input

12 Input

16 Input4 Input
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■ Routing Settings
To change an assignment, click at the position where the desired input and output channels 
intersect. When the mouse pointer is moved over a cell, the input and output channels are 
highlighted, and a red line is displayed connecting them. Click to set routing for that position. If 
another output channel has been assigned to the clicked input channel, the original assignment 
will not be cleared. If another input channel has been assigned to the clicked output channel, the 
original assignment will be cleared. 

■ Clearing Routing Settings
If you click the dot that indicates routing, the routing indicated by that dot will be cleared and the 
dot will be erased.

Click

Not Cleared Cleared

Click
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Source Selector
This component selects a single input source from multiple input sources.
“Position” is the number of input sources, and “Channel” is the number of channels included in the 
source. For example, a “4 Position 2 Channel” component allows you to select a single 2-channel 
source from four 2-channel input sources.
3 Position and 16 Position components are all 1 Channel types, while 1, 2, and 6 Channel versions of 4 
Position and 8 Position components are provided.
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Double-click a component to open the component editor. The component editor is the same for all 
types, the only difference being the number of sources.

The Source Selector connects the selected input to the output. For example, if you select [1] for a 4 
Position 2 Channel component, IN1-1 will be connected to OUT-1 and IN1-2 will be connected to 
OUT2. If you select [2] IN2-1 will be connected to OUT-1 and IN2-2 will be connected to OUT2.

Source Selector Component
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Speaker Processor
The Speaker Processor is a crossover processor that includes APF (All Pass Filter), horn EQ, and 
limiter functions. Six component types are available: 1 Way, 2 Way, 3 Way, 4 Way, 5 Way, and 6 Way.
Speaker Processor components have one input and one or multiple outputs.

Double-click a component to open the component editor.

Name Function

1 Crossover response (phase) Crossover phase response, color coded for 
output channel.

2 Crossover response (level) Crossover level response, color coded for 
each output channel.

3 Input meter Displays the input signal level.

4 Output meter Displays the output level for each band.

5 Crossover Curve Display Button Turns crossover curve display for each 
output channel on or off.

Section Parameter Range Function

6 Delay Delay ON/OFF Applies delay to the crossover response.

7 PEQ PEQ ON/OFF Applies PEQ to the crossover response.

1

3
4

2

8 9 ) ! @ # $

5655 7

Speaker processor Component
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Different numbers of channels are provided by each component variation.

Each frequency band has its own color, with Low being red, Mid being green, and so on.

8 Navigator Input Level -∞ to +10 dB Specifies the input signal level.

9 Crossover – Opens the crossover editor window.

) Delay – Opens the delay editor window.

! PEQ – Opens the parametric equalizer editor 
window.

@ Output Level -∞ to +10 dB Sets the output level from each output 
channel.

# Mute ON/OFF Mutes the output of each output channel.

$ Limiter – Opens the limiter editor window.

1 Way ALL

2 Way Low/High

3 Way Low/Mid/High

4 Way Low/Low-Mid/High-Mid/High

5 Way Sub-Low/Low/Low-Mid/High-Mid/High

6 Way Sub-Low/Low/Low-Mid/Mid/High-Mid/High
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■ Graph Control Points
The crossover level control points indicate [Output Level] and [Frequency]. The control points will 
move in response to [Output Level] changes made via the knobs or edit boxes. The [Output Level] 
and [Frequency] parameters can also be changed by directly dragging the control points. 
Changes to the [Frequency] parameter are shown on the crossover phase response graph. 

The control point in the center of the graph can be dragged vertically to change the [Output Level] 
parameter.

Control points at the intersections between the frequency bands can be dragged horizontally to 
change the [Frequency].

The [Output Level] parameter changes.

The crossover phase response will change.
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■ Crossover
Click the Speaker Processor [Crossover] button to open the crossover editor window.

Section Parameter Range Function

1 Polarity Polarity Normal/Inverted Inverts the polarity of each output channel.

2 Mute Mute ON/OFF Mutes the output of each output channel. 
This parameter is linked to the Mute setting in 
the original window.

3 Frequency Frequency 20 Hz to 20 kHz Sets the crossover frequency between output 
channels.
The display appears as a dotted line when 
muted.

4 LPF Type Thru
6dB/Oct
12dB/Oct AdjustGc
12dB/Oct Butrwrth
12dB/Oct Bessel
12dB/Oct Linkwitz
18dB/Oct AdjustGc
18dB/Oct Butrwrth
18dB/Oct Bessel
24dB/Oct AdjustGc
24dB/Oct Butrwrth
24dB/Oct Bessel
24dB/Oct Linkwitz
36dB/Oct AdjustGc
36dB/Oct Butrwrth
36dB/Oct Bessel
48dB/Oct AdjustGc
48dB/Oct Butrwrth
48dB/Oct Bessel
48dB/Oct Linkwitz

Sets the roll-off slope and filter type for each 
octave.
The filter is bypassed when [Thru] is 
selected.

5 Frequency 20 Hz to 20 kHz Sets the LPF cutoff frequency.

6 Gc -6 dB to +6 dB Sets the cutoff frequency gain when the 
[Type] setting is [AdjustGc] (Adjustable Gc). 

1

2

3

47

5 68 9

[Speaker Processor - Crossover] editor window
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■ Delay
Click the Speaker Processor [Delay] button to open the window. Delay can be set independently 
for each output channel.

7 HPF Type Thru
6dB/Oct
12dB/Oct AdjustGc
12dB/Oct Butrwrth
12dB/Oct Bessel
12dB/Oct Linkwitz
18dB/Oct AdjustGc
18dB/Oct Butrwrth
18dB/Oct Bessel
24dB/Oct AdjustGc
24dB/Oct Butrwrth
24dB/Oct Bessel
24dB/Oct Linkwitz
36dB/Oct AdjustGc
36dB/Oct Butrwrth
36dB/Oct Bessel
48dB/Oct AdjustGc
48dB/Oct Butrwrth
48dB/Oct Bessel
48dB/Oct Linkwitz

Sets the roll-off slope and filter type for each 
octave.
The filter is bypassed when [Thru] is 
selected.

8 Frequency 20 Hz to 20 kHz Sets the HPF cutoff frequency.

9 Gc -6 dB to +6 dB Sets the cutoff frequency gain when the 
[Type] setting is [AdjustGc] (Adjustable Gc). 

Parameter Range Function

1 Delay ms: 0 to 500
Sample: the range 
depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends 
on the Frame value.
Beat: the range depends 
on the Beat value.

Sets the delay time.
Two edit boxes show milliseconds and the unit 
specified in the [Delay Scale] section.
Sets the output level for each band.

2 On ON/OFF Turns delay ON.

3 Delay Scale ms
Sample
Meter
Feet
Frame
Beat

Selects the delay time units. The selected button will 
light and the [Delay] edit box will change accordingly.
When [Beat] is selected the knobs can be used to 
adjust BPM.

Section Parameter Range Function

3

2

1

[Speaker Processor - Delay] editor window
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■ Parametric Equalizer
Click the Crossover Processor [PEQ] button to open the window. Parametric equalization is 
provided for each crossover band.

*1 APF: The APF (All Pass Filter) is a filter that passes all frequency bands while affecting only the phase. Used to match the phase of the 
crossover bands.
APF 1st shifts the phase from 0° to 180°, while APF 2nd shifts the phase from 0° to 360°. APF 2nd also allows Q adjustment.

*2 Horn EQ: CD (Constant Directivity) horn speakers exhibit a roll-off in high-frequency level.
Horn EQ is provided to compensate for this roll-off. For this reason the gain can only be set to higher than 0dB, and the frequency higher than 
500Hz.

Name Function

1 Crossover response (phase) Shows crossover phase response.

2 Crossover response (level) Shows crossover level response.

Parameter Range Function

3 Type PEQ
L.SHELF 6dB/Oct
L.SHELF 12dB/Oct
H.SHELF 6dB/Oct
H.SHELF 12dB/Oct
HPF
LPF
APF*1 1st
APF*1 2nd
Horn EQ*2

Select a filter type from the menu.

4 B/W 0.090 to 6.672 Sets the octave bandwidth for each band.

5 Q 0.1 to 16.0 Sets the Q for each band.

6 Frequency 20 Hz to 20 kHz Sets the frequency for each band.

7 Gain -18 dB to +18 dB Sets the gain for each band.

8 Bypass ON/OFF Bypasses the PEQ for each band.

9 PEQ On ON/OFF Turns PEQ ON.

9
3

5

4

6

1

2

7

8

[Speaker Processor - PEQ] edit window
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■ Limiter
Click the Speaker Processor [Limiter] button to open the window. Limiter settings are provided for 
each output channel.

Name Function

1 Limiter Curve A graphic representation of limiter response. The 
horizontal axis represents input level, and the vertical 
axis represents output level.

2 Gain Reduction Meter Displays the amount of gain reduction.

3 Output Meter Displays the output level.

Parameter Range Function

4 Threshold -54 dB to ±0 dB Sets the threshold level.

5 Attack Fast
Mid
Slow
Manual (0 to 120ms)

Sets the attack time.

6 Release Fast
Mid
Slow
Manual
(44.1kHz: 6ms to46s
48kHz: 5ms to 42.3s
88.2kHz: 3ms to 23s
96kHz: 3ms to 21.1s)

Sets the release time.
With the [Fast], [Mid], or [Slow] settings the optimum 
value is automatically set based on the longest 
wavelength audio signal received by the limiter. Three 
settings are available: [Fast], [Mid], and [Slow].

7 On ON/OFF Turns the limiter ON. The limiter is bypassed when the 
button is turned OFF.

1

4 5 6

23 7

[Speaker Processor - Limiter] Editor Window
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SPX
SPX is an effect component that supports many different effect applications, such as reverb, delay, 
and modulation effects, along with complex combinations of multiple effects. Although the SPX 
component is a single component, it encompasses 43 effect types. 
When you change the effect type, right-click the SPX component to display the context menu, click 
[Recall Component Library], then select the effect type from the [Effect Type] submenu. 

Double-click this component to display the component editor for it. 

Name Function

1 Input Meter Displays the input signal level. 

2 [Mix Balance] Control Adjusts the balance between the fundamental tone and the effect tone. 

3 [Bypass] button When turned ON, the input signal is output without change. 

4 Output Meter Displays the output signal level. 

5 Other Parameters Other parameters vary according to the effect type. 

SPX component editor
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Other effect parameters vary according to the selected effect type, as shown below. 

Effect Type Parameter Setting Range Function
Reverb Hall
Reverb Room
Reverb Stage
Reverb Plate
One input, two 
output hall, room, 
stage, and plate 
reverb simulations, 
all with gates.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Lo.Ratio 0.1 to 2.4 Low-frequency reverb time ratio

Diff. 0 to 10 Reverb diffusion (left-right reverb spread)

Density 0 to 100% Reverb density

E/R Dly 0.0 to 100.0 ms Delay between early reflections and reverb

E/R Bal. 0 to 100% Balance of early reflections and reverb (0% = all 
reverb, 100% = all early reflections)

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Gate Lvl OFF, -60 to 0 dB Level at which gate kicks in

Attack 0 to 120 ms Gate opening speed

Hold 44.1kHz: 0.02ms to 2.13s
48kHz: 0.02 ms to 1.96s
88.2kHz: 0.01ms to 1.06s
96kHz: 0.01ms to 981ms

Gate open time

Decay 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Gate closing speed

Early Ref.
One input, two 
output early 
reflections.

Type S-Hall, L-Hall, Random, Revers, 
Plate, Spring

Type of early reflection simulation

RoomSize 0.1 to 20.0 Reflection spacing

Liveness 0 to 10 Early reflections decay characteristics (0 = dead, 
10 = live)

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Diff. 0 to 10 Reflection diffusion (left-right reflection spread)

Density 0 to 100% Reflection density

ER Num. 1 to 19 Number of early reflections

FB.Gain -99 to +99% Feedback gain

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Gate Reverb
Reverse Gate
One input, two 
output early 
reflections with 
gate, and early 
reflections with 
reverse gate.

Type Type-A, Type-B Type of early reflection simulation

RoomSize 0.1 to 20.0 Reflection spacing

Liveness 0 to 10 Early reflections decay characteristics (0 = dead, 
10 = live)

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Diff. 0 to 10 Reflection diffusion (left-right reflection spread)

Density 0 to 100% Reflection density

ER Num. 1 to 19 Number of early reflections

FB.Gain -99 to +99% Feedback gain

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Mono Delay
One input, one 
output basic repeat 
delay.

Delay 0.0 to 2730.0 ms Delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
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Stereo Delay
Two input, two 
output basic stereo 
delay.

Delay L 0.0 to 1350.0 ms Left channel delay time

Delay R 0.0 to 1350.0 ms Right channel delay time

FB.Gain L -99 to +99% Left channel feedback (plus values for normal-
phase feedback, minus values for reverse-phase 
feedback)

FB.Gain R -99 to +99% Right channel feedback (plus values for normal-
phase feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Mod.Delay
One input, two 
output basic repeat 
delay with 
modulation.

Delay 0.0 to 2725.0 ms Delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Wave Sine, Tri Modulation waveform

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Delay LCR
One input, two 
output 3-tap delay 
(left, center, right).

Delay L 0.0 to 2730.0 ms Left channel delay time

Delay C 0.0 to 2730.0 ms Center channel delay time

Delay R 0.0 to 2730.0 ms Right channel delay time

Delay FB 0.0 to 2730.0 ms Feedback delay time

Level L -100 to +100% Left channel delay level

Level C -100 to +100% Center channel delay level

Level R -100 to +100% Right channel delay level

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Echo
Two input, two 
output stereo delay 
with crossed 
feedback loop.

Delay L 0.0 to 1350.0 ms Left channel delay time

Delay R 0.0 to 1350.0 ms Right channel delay time

FB.Dly L 0.0 to 1350.0 ms Left channel feedback delay time

FB.Dly R 0.0 to 1350.0 ms Right channel feedback delay time

FB.Gain L -99 to +99% Left channel feedback gain (plus values for normal-
phase feedback, minus values for reverse-phase 
feedback)

FB.Gain R -99 to +99% Right channel feedback gain (plus values for 
normal-phase feedback, minus values for reverse-
phase feedback)

L->R FBG -99 to +99% Left to right channel feedback gain (plus values for 
normal-phase feedback, minus values for reverse-
phase feedback)

R->L FBG -99 to +99% Right to left channel feedback gain (plus values for 
normal-phase feedback, minus values for reverse-
phase feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Chorus
Two input, two 
output chorus 
effect.

Freq. 0.05 to 40.00 Hz Modulation speed

AM.Depth 0 to 100% Amplitude modulation depth

PM.Depth 0 to 100% Pitch modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

EQ F 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain

Effect Type Parameter Setting Range Function
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Flange
Two input, two 
output flange effect.

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Wave Sine, Tri Modulation waveform

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

EQ F 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain

Symphonic
Two input, two 
output symphonic 
effect.

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

EQ F 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain

Phaser
Two input, two 
output 16-stage 
phaser.

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Offset 0 to 100 Lowest phase-shifted frequency offset

PHASE 0.00 to 354.38 degrees Left and right modulation phase balance

Stage 2, 4, 6, 8, 10, 12, 14, 16 Number of phase shift stages

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain

Auto Pan
Two input, two 
output autopanner.

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Direction L<->R, L->R, L<-R, Turn L, Turn 
R

Panning direction

Wave Sine, Tri, Square Modulation waveform

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

EQ F 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain

Tremolo
Two input, two 
output tremolo 
effect.

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Wave Sine, Tri, Square Modulation waveform

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

EQ F 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain
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HQ.Pitch
One input, two 
output high-quality 
pitch shifter.

Pitch -12 to +12 semitones Pitch shift

Fine -50 to +50 cents Pitch shift fine

Delay 0.0 to 1000.0 ms Delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Mode 1 to 10 Pitch shift precision

Dual Pitch
Two input, two 
output pitch shifter.

Pitch 1 -24 to +24 semitones Channel #1 pitch shift

Fine 1 -50 to +50 cents Channel #1 pitch shift fine

Pitch 2 -24 to +24 semitones Channel #2 pitch shift

Fine 2 -50 to +50 cents Channel #2 pitch shift fine

Level 1 -100 to +100% Channel #1 level (plus values for normal phase, 
minus values for reverse phase)

Pan 1 L63 to R63 Channel #1 pan

Level 2 -100 to +100% Channel #2 level (plus values for normal phase, 
minus values for reverse phase)

Pan 2 L63 to R63 Channel #2 pan

Delay 1 0.0 to 1000.0 ms Channel #1 delay time

FB.Gain 1 -99 to +99% Channel #1 feedback gain (plus values for normal-
phase feedback, minus values for reverse-phase 
feedback)

Delay 2 0.0 to 1000.0 ms Channel #2 delay time

FB.Gain 2 -99 to +99% Channel #2 feedback gain (plus values for normal-
phase feedback, minus values for reverse-phase 
feedback)

Mode 1 to 10 Pitch shift precision

Rotary
One input, two 
output rotary 
speaker simulator.

Rotate STOP, START Rotation stop, start

Speed SLOW, FAST Rotation speed (see SLOW and FAST parameters)

Slow 0.05 to 10.00 Hz SLOW rotation speed

Fast 0.05 to 10.00 Hz FAST rotation speed

Drive 0 to 100 Overdrive level

Accel 0 to 10 Acceleration at speed changes

Low 0 to 100 Low-frequency filter

High 0 to 100 High-frequency filter

Ring Mod.
Two input, two 
output ring 
modulator.

Source OSC, SELF Modulation source: oscillator or input signal

Osc.Freq. 0.0 to 5000.0 Hz Oscillator frequency

FM Freq. 0.05 to 40.00 Hz Oscillator frequency modulation speed

FM Depth 0 to 100% Oscillator frequency modulation depth

Mod.Filter
Two input, two 
output modulation 
filter.

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Phase 0.00 to 354.38 degrees Left-channel modulation and right-channel 
modulation phase difference

Type LPF, HPF, BPF Filter type: low pass, high pass, band pass

Offset 0 to 100 Filter frequency offset

Reso. 0 to 20 Filter resonance

Level 0 to 100 Output level

Distortion
One input, two 
output distortion 
effect.

DST.Type DST1, DST2, OVD1, OVD2, 
CRUNCH

Distortion type (DST = distortion, OVD = overdrive)

Drive 0 to 100 Distortion drive

Master 0 to 100 Master volume

Tone -10 to +10 Tone

N.Gate 0 to 20 Noise reduction
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Amp Simulate
One input, two 
output guitar amp 
simulator.

AMP.Type STK-M1, STK-M2, THRASH, 
MIDBST, CMB-PG, CMB-VR, 
CMB-DX, CMB-TW, MINI, FLAT

Guitar amp simulation type

DST.Type DST1, DST2, OVD1, OVD2, 
CRUNCH

Distortion type (DST = distortion, OVD = overdrive)

Drive 0 to 100 Distortion drive

Master 0 to 100 Master volume

Bass 0 to 100 Bass tone control

Middle 0 to 100 Middle tone control

Treble 0 to 100 High tone control

Cab Dep 0 to 100% Speaker cabinet simulation depth

EQ F 100 to 8.0 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

N.Gate 0 to 20 Noise reduction

Dyna.Filter
Two input, two 
output dynamically 
controlled filter.

Sense 0 to 100 Sensitivity

Direction UP, DOWN Upward or downward frequency change

Decay 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Filter frequency change decay speed

Type LPF, HPF, BPF Filter type

Offset 0 to 100 Filter frequency offset

Reso. 0 to 20 Filter resonance

Level 0 to 100 Output Level

Dyna.Flange
Two input, two 
output dynamically 
controlled flanger.

Sense 0 to 100 Sensitivity

Direction UP, DOWN Upward or downward frequency change

Decay 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Decay speed

Offset 0 to 100 Delay time offset

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

EQ F 100 Hz to 8.00 kHz EQ (peaking type) frequency

EQ G -12 to +12 dB EQ (peaking type) gain

EQ Q 10.0 to 0.10 EQ (peaking type) bandwidth

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain

Dyna.Phaser
Two input, two 
output dynamically 
controlled phaser.

Sense 0 to 100 Sensitivity

Direction UP, DOWN Upward or downward frequency change

Decay 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Decay speed

Offset 0 to 100 Lowest phase-shifted frequency offset

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Stage 2, 4, 6, 8, 10, 12, 14, 16 Number of phase shift stages

LSH F 21.2 Hz to 8.00 kHz Low shelving filter frequency

LSH G -12 to +12 dB Low shelving filter gain

HSH F 50.0 Hz to 16.0 kHz High shelving filter frequency

HSH G -12 to +12 dB High shelving filter gain
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Rev+Chorus
One input, two 
output reverb and 
chorus effects in 
parallel.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev/Cho 0 to 100% Reverb and chorus balance (0% = all reverb, 100% 
= all chorus)

Freq. 0.05 to 40.00 Hz Modulation speed

AM.Depth 0 to 100% Amplitude modulation depth

PM.Depth 0 to 100% Pitch modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

Rev->Chorus
One input, two 
output reverb and 
chorus effects in 
series.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev Bal. 0 to 100% Reverb and chorused reverb balance (0% = all 
chorused reverb, 100% = all reverb)

Freq. 0.05 to 40.00 Hz Modulation speed

AM.Depth 0 to 100% Amplitude modulation depth

PM.Depth 0 to 100% Pitch modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

Rev+Flange
One input, two 
output reverb and 
flanger effects in 
parallel.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev/Flg 0 to 100% Reverb and flange balance (0% = all reverb, 100% 
= all flange)

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Wave Sine, Tri Modulation waveform

Rev->Flange
One input, two 
output reverb and 
flanger effects in 
series.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev Bal. 0 to 100% Reverb and flanged reverb balance (0% = all 
flanged reverb, 100% = all reverb)

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Wave Sine, Tri Modulation waveform
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Rev+Sympho.
One input, two 
output reverb and 
symphonic effects 
in parallel.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev/Sym 0 to 100% Reverb and symphonic balance (0% = all reverb, 
100% = all symphonic)

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

Rev->Sympho.
One input, two 
output reverb and 
symphonic effects 
in series.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev Bal. 0 to 100% Reverb and symphonic reverb balance (0% = all 
symphonic reverb, 100% = all reverb)

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Mod.Dly 0.0 to 500.0 ms Modulation delay time

Wave Sine, Tri Modulation waveform

Rev->Pan
One input, two 
output reverb and 
autopan effects in 
parallel.

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Rev Bal. 0 to 100% Reverb and panned reverb balance (0% = all 
panned reverb, 100% = all reverb)

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Direction L<->R, L->R, L<-R, Turn L, Turn 
R

Panning direction

Wave Sine, Tri, Square Modulation waveform

Delay+ER.
One input, two 
output delay and 
early reflections 
effects in parallel.

Delay L 0.0 to 1000.0 ms Left channel delay time

Delay R 0.0 to 1000.0 ms Right channel delay time

FB.Dly 0.0 to 1000.0 ms Feedback delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Dly/ER 0 to 100% Delay and early reflections balance (0% = all delay, 
100% = all early reflections)

Type S-Hall, L-Hall, Random, Revers, 
Plate, Spring

Type of early reflection simulation

RoomSize 0.1 to 20.0 Reflection spacing

Liveness 0 to 10 Early reflections decay characteristics (0 = dead, 
10 = live)

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

ER Num. 1 to 19 Number of early reflections
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Delay->ER.
One input, two 
output delay and 
early reflections 
effects in series.

Delay L 0.0 to 1000.0 ms Left channel delay time

Delay R 0.0 to 1000.0 ms Right channel delay time

FB.Dly 0.0 to 1000.0 ms Feedback delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

DLY.BAL 0 to 100% Delay and early reflected delay balance (0% = all 
early reflected delay, 100% = all delay)

Type S-Hall, L-Hall, Random, Revers, 
Plate, Spring

Type of early reflection simulation

RoomSize 0.1 to 20.0 Reflection spacing

Liveness 0 to 10 Early reflections decay characteristics (0 = dead, 
10 = live)

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

ER Num. 1 to 19 Number of early reflections

Delay+Reverb
One input, two 
output delay and 
reverb effects in 
parallel.

Delay L 0.0 to 1000.0 ms Left channel delay time

Delay R 0.0 to 1000.0 ms Right channel delay time

FB.Dly 0.0 to 1000.0 ms Feedback delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Delay Hi 0.1 to 1.0 Delay high-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Dly/Rev 0 to 100% Delay and reverb balance (0% = all delay, 100% = 
all reverb)

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Rev Hi 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density

Delay->Reverb
One input, two 
output delay and 
reverb effects in 
series.

Delay L 0.0 to 1000.0 ms Left channel delay time

Delay R 0.0 to 1000.0 ms Right channel delay time

FB.Dly 0.0 to 1000.0 ms Feedback delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Delay Hi 0.1 to 1.0 Delay high-frequency feedback ratio

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency

Dly.Bal 0 to 100% Delay and delayed reverb balance (0% = all 
delayed reverb, 100% = all delay)

Rev Time 0.3 to 99.0 s Reverb time

Ini.Dly 0.0 to 500.0 ms Initial delay before reverb begins

Rev Hi 0.1 to 1.0 High-frequency reverb time ratio

Diff. 0 to 10 Spread

Density 0 to 100% Reverb density
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Dist->Delay
One input, two 
output distortion 
and delay effects in 
series.

DST.Type DST1, DST2, OVD1, OVD2, 
CRUNCH

Distortion type (DST = distortion, OVD = overdrive)

Drive 0 to 100 Distortion drive

Master 0 to 100 Master volume

Tone -10 to +10 Tone control

N.Gate 0 to 20 Noise reduction

Delay 0.0 to 2725.0 ms Delay time

FB.Gain -99 to +99% Feedback gain (plus values for normal-phase 
feedback, minus values for reverse-phase 
feedback)

Hi.Ratio 0.1 to 1.0 High-frequency feedback ratio

Freq. 0.05 to 40.00 Hz Modulation speed

Depth 0 to 100% Modulation depth

Dly.Bal 0 to 100% Distortion and delay balance (0% = all distortion, 
100% = all delayed distortion)

Multi.Filter
Two input, two 
output 3-band 
multi-filter (24 dB/
octave).

Type 1 HPF, LPF, BPF Filter 1 type: high pass, low pass, band pass

Type 2 HPF, LPF, BPF Filter 2 type: high pass, low pass, band pass

Type 3 HPF, LPF, BPF Filter 3 type: high pass, low pass, band pass

Freq. 1 28.0 Hz to 16.0 kHz Filter 1 frequency

Freq. 2 28.0 Hz to 16.0 kHz Filter 2 frequency

Freq. 3 28.0 Hz to 16.0 kHz Filter 3 frequency

Level 1 0 to 100 Filter 1 level

Level 2 0 to 100 Filter 2 level

Level 3 0 to 100 Filter 3 level

Reso. 1 0 to 20 Filter 1 resonance

Reso. 2 0 to 20 Filter 2 resonance

Reso. 3 0 to 20 Filter 3 resonance

Stereo Reverb
Two input, two 
output stereo 
reverb.

Rev Time 0.3 to 99.0 s Reverb time

Rev Type Hall, Room, Stage, Plate Reverb type

Ini.Dly 0.0 to 100.0 ms Initial delay before reverb begins

Hi.Ratio 0.1 to 1.0 High-frequency reverb time ratio

Lo.Ratio 0.1 to 2.4 Low-frequency reverb time ratio

Diff. 0 to 10 Reverb diffusion (left-right reverb spread)

Density 0 to 100% Reverb density

E/R Bal. 0 to 100% Balance of early reflections and reverb (0% = all 
reverb, 100% = all early reflections)

HPF THRU, 21.2 Hz to 8.00 kHz High-pass filter cutoff frequency

LPF 50.0 Hz to 16.0 kHz, THRU Low-pass filter cutoff frequency
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M.Band Dyna.
Two input, two 
output 3-band 
dynamics 
processor, with 
individual solo and 
gain reduction 
metering for each 
band.

Low Gain -96.0 to +12.0 dB Low band level

Mid Gain -96.0 to +12.0 dB Mid band level

Hi. Gain -96.0 to +12.0 dB High band level

Presence -10 to +10 For positive values, the threshold of the high band is 
lowered and the threshold of the low band is 
increased. For negative values, the opposite will 
occur. When set to 0, all three bands are affected 
the same.

Cmp.Thre -24.0 dB to 0.0 dB Compressor threshold

Cmp.Rat 1:1 to 20:1 Compressor ratio

Cmp.Atk 0 to 120 ms Compressor attack

Cmp.Rel 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Compressor release time

Cmp.Knee 0 to 5 Compressor knee

Lookup 0.0 to 100.0 ms Lookup delay

Cmp.Byp ON/OFF Compressor bypass

L-M XOver 21.2 Hz to 8.00 kHz Low/mid crossover frequency

M-H XOver 21.2 Hz to 8.00 kHz Mid/high crossover frequency

Slope -6 dB, -12 dB Filter slope

Ceiling -6.0 dB to 0.0 dB, OFF Specifies the maximum output level

Exp.Thre -54.0 dB to -24.0 dB Expander threshold

Exp.Rat 1:1 to ∞:1 Expander ratio

Exp.Rel 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Expander release time

Exp.Byp ON/OFF Expander bypass

Lim.Thre -12.0 dB to 0.0 dB Limiter threshold

Lim.Atk 0 to 120 ms Limiter attack

Lim.Rel 44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Limiter release time

Lim.Byp ON/OFF Limiter bypass

Lim.Knee 0 to 5 Limiter knee

Low ON/OFF Low band solo

Mid ON/OFF Mid band solo

High ON/OFF High band solo
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Slot
■ Slot In

The Slot In Component only has outputs. 4, 8, and 16 channel types are provided.

Right-click the component and select [Open Slot In Component] from the contextual menu to open the 
component editor. The component editor is the same for all types.

Name Function

1 Meter Shows the signal level for each channel.
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■ Slot Out
The Slot Out component has only an input. There are three types of Slot In components: four-
channel, eight-channel, and 16 channel types. 

The component editor can be displayed by right-clicking the component, then clicking [Open Slot 
Out Component Editor] on the displayed context menu. 

Parameter Setting Range Function

1 Phase ON/OFF Reverses the phase of the output signal for each 
channel. 

2 On ON/OFF Turns ON each channel's output. 

3 Delay 0 to 24 Samples Sets the delay time. 

4 Level -∞ to ±0 dB Sets the output level.

5 Dither Off
16
20
24

Sets the quantization bit rate for conversion. 

1

2

3

4

5

Slot Out component editor
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Cascade
■ Cascade In

The Cascade In Component only has outputs.
Only the DME64N has a Cascade In component, which can be displayed by checking [Show 
Cascade Port] in the DME Device Properties dialog box.

Right-click the component and select [Open Component Editor] from the contextual menu to open the 
component editor. The component editor is the same for all types.

Name Function

1 Meter Shows the signal level for each channel.
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■ Cascade Out
The Cascade Out Component only has inputs.

Right-click the component and select [Open Component Editor] from the contextual menu to open the 
component editor. The component editor is the same for all types.

Name Function

1 Meter Shows the signal level for each channel.
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Internal Head Amp

In the DME24 configuration window, there are [Unit Input] and [Unit Output] blocks. They are the 
Analog In and Analog Out DME24 I/O ports. 

■ Unit Input
Double-click [Unit Input] to display the component editor for it. 

■ Analog Out
Double-click [Unit Output] to display the component editor for it. The displayed parameters are the 
same as for Slot Out component editor. 

Parameter Setting Range Function

1 +48 ON/OFF Turns ON phantom power (+48V). 

2 Gain +10 to -60 dB Sets the head amp gain. 

1

2

Internal Head Amp component editor
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MY-Card
This shows the input and output for the card inserted into the DME expansion slot. The following 
components are available, depending on the card types: 

Input Format/Output Format
This is the I/O mode for high sample rate operation (88.2/96 kHz).
In the Double Channel Mode, high sampling rate data (88.2/96 kHz) is transmitted and received by 
two channels, each channel handling the digital audio data at half the sampling rate. For this reason 
the total number of available channels is halved, and even-numbered channels are unavailable.
In the Double Speed Mode digital audio data is transmitted and received at the current high sampling 
rate (88.2/96 kHz).
In the Single Mode digital audio data is transmitted and received at half the current high sampling rate 
(88.2/96 kHz).

Setting Examples

When the MY card word clock is used as the master word clock, Double FS determines whether the 
speed of that word clock is to be doubled and used as the DME clock. The Double Fs setting is only 
available the word clock from an MY Card is used.

Operation clock of related equipment The DME operation clock Input Format/Output Format

88.2/96 kHz (Double Channel) 88.2/96 kHz Double Channel

88.2/96 kHz (Double Speed) Double Speed

44.1k/48k Single
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■ MY-Others
Double-click the block to display the component editor for it.This editor can be used for generic MY 
card editing, but some parameters are not available. Use a card specific editor when available.

■ MY8-AE96S
Double-click the block to display the component editor for it. 

Parameter Setting Range Function

1 Input Format Double Channel
Double Speed
Single

Selects the format for 88.2/96 kHz. 

2 Double Fs ON/OFF When ON the speed of the word clock from the MY 
Card is doubled.

3 Output Format Double Channel
Double Speed
Single

Selects the format for 88.2/96 kHz. 

Parameter Setting Range Function

1 Input Format Double Channel
Double Speed

Selects the format for 88.2/96 kHz. 

2 Double Fs ON/OFF When ON the speed of the word clock from the MY 
Card is doubled.

3 Output Format Double Channel
Double Speed

Selects the format for 88.2/96 kHz. 

4 Sampling Rate 
Converter

ON/OFF Turns the sampling rate converter ON. 

1
3

2

1

3

4

2

MY8-AE96S component editor
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■ MY16-AE/MY8-AE96/MY8-AE/MY8-AT/MY8-TD/MY16-TD/MY16-AT
Double-click the block to display the component editor for it. 

Parameter Setting Range Function

1 Input Format Double Channel
Double Speed

Selects the format for 88.2/96 kHz. For MY8-AE96, the 
setting range is Double Channel/Double Speed. For 
other cards, it is Double Channel/Single. 

2 Double Fs ON/OFF When ON the speed of the word clock from the MY 
Card is doubled. Only for MY16-AE/MY8-AE96/MY16-
TD. When On is set for the MY8-AE96, the Input Format 
is Double Channel. When Off is set, the input format is 
Double Speed. 

3 Output Format Double Channel
Double Speed
Single

Selects the format for 88.2/96 kHz. For MY8-AE96, the 
setting range is Double Channel/Double Speed. For 
other cards, it is Double Channel/Single.

1
3

2

Example: MY16-AE component editor
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■ MY16-C
Double-click the block to display the component editor for it. 

Section Parameter Setting Range Function

1 Setting Priority Setting Priority Hardware/
Software

The MY16-C switch settings take priority when 
“Hardware” is selected, and the DME Designer 
settings take priority when “Software” is 
selected.

2 Bundle Number Input 0 to 65279 Sets the input bundle number.

Output 0 to 65279 Sets the output bundle number.

3 Serial Channel Rx OFF, 1 - 16 Sets the serial channel for the receive side. 

Tx OFF, 1 - 16 Sets the serial channel for the send side. 

4 Properties Bit Length Bit Off
16 bit
20 bit
24 bit

Sets the bit rate for output. Mutes the signal if 
[Bit Off] is set.

5 Latency 5.33 ms
2.67 ms
1.33 ms

Sets the delay.

NOTE

The parameters will not link immediately when Setting Priority is switched.
Please edit another parameter after switching Setting Priority.

MY16-C R | [ l g G f B ^ [

1

2

3

4

5

MY16-C component editor
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Remote Controlled Head Amp

There are AD824 and AD8HR components arranged in the zone window. 

■ AD824
Controls the Yamaha A/D converter AD824. The AD824 is an eight channel analog to digital 
converter. 

Double-click the component to display the component editor for it. 

NOTE

If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click 
(page 170).

Parameter Setting Range Function

1 +48 ON/OFF Turns ON phantom power (+48V). 

2 Gain +10 to -62 dBu Sets the head amp gain. 

3 Word Clock 48 kHz
44.1 kHz
BNC
Slot

Sets the operating frequency for the Word Clock. 

1

2
3

AD824 component editor
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■ AD8HR
Controls the Yamaha A/D converter AD8HR. The AD8HR is an eight channel analog to digital 
converter. 

Double-click this component to display the component editor for it. 

NOTE

If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click 
(page 170).

Section Parameter Setting Range Function

1 Gain +48 ON/OFF Turns ON phantom power (+48V). 

2 HPF ON/OFF Turns output ON. 

3 Frequency 20 to 600Hz Sets the cutoff frequency. 

4 Gain +10 to -62 dBu Sets the head amp gain. 

5 Word Clock Word Clock 96 kHz
88.2 kHz
48 kHz
44.1 kHz
Word Clock In
Digital Out A

Sets the operating frequency for the Word 
Clock. 

Double Speed
Double Channel

Selects the operation for 88.2/96 kHz. 

1
2

4

3
5

AD8HR component editor
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Component Glossary

Adjustable Gc (AdjustGc)
One type of filter characteristic. With this setting, you can adjust Gc (gain on the cutoff frequency) 
between -6 dB and +6 dB. If you set -3 dB it becomes a Butterworth filter. If you set -6 dB, it becomes 
Linkwitz-Riley filter.
Components: Crossover, Crossover Processor, Crossover Processor II, Programmable BPF, 
Programmable HPF, Programmable LPF, Speaker Processor

Attack (Attack Time)
In dynamic components, sets the time period for compressing or expanding the signal after the 
component operates. As the attack time is made faster, compression or expansion becomes more 
instantaneous. As it is made slower, the initial attack part of the sound will not be compressed or 
expanded. 
Components: Crossover Processor, Compander, Crossover Processor II, Compressor, De-
Esser, Ducking, Expander, Gate, Limiter, Speaker Processor

Bessel
One type of filter characteristic. For curves where phase characteristics are important, Bessel has 
gentler attenuation then Butterworth, and there is little distortion of the waveform when square waves 
are passed through.
Components: Crossover, Crossover Processor, Crossover Processor II, Programmable BPF, 
Programmable HPF, Programmable LPF, Speaker Processor

Butterworth (Butrwrth)
One type of filter characteristics. This filter has the most general characteristics. The pass band is flat 
and the gain for the cutoff frequency is -3 dB.
Components: Crossover, Crossover Processor, Crossover Processor II, Programmable BPF, 
Programmable HPF, Programmable LPF, Speaker Processor

Bypass
Passes the signal without changing it. When you turn this ON, bypassed sound (unchanged sound) is 
output. When you turn this OFF, the sound is output with effects applied.
Components: Crossover Processor, Crossover Processor II, GEQ, PEQ, BPF, HPF, LPF, Notch, 
Programmable BPF, Programmable HPF, Programmable LPF, Speaker Processor, SPX

Decay (Decay Time)
Sets the time period until gain returns to normal after a trigger signal level falls below the threshold 
value. 
Components: Ducking, Gate, Auto Mixer

Delay
Sets the time period by which a signal is delayed.
Components: Crossover Processor, Crossover Processor II, Delay Long, Delay Short, Delay 
Matrix, Speaker Processor, SPX, Slot Output, Unit Output
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Delay Scale
Sets the units used for specifying the delay time.
Components: Crossover Processor, Crossover Processor II, Delay Long, Delay Short, Speaker 
Processor

Divergence
Sets the ratio for sending the center signal to LR. When 100 percent is set, the signal will be sent to LR 
only. When zero percent is set, the signal is sent to center only. 
Components: LCR, Surround 3-1, Surround 5.1, Surround 6.1

Fade
Sets the action of the fader when there is a large change in its position during scene recall.
When you turn this ON, the fader moves gradually to the position after the jump. If you turn this OFF, it 
immediately jumps to the parameters saved in the recalled scene. 
Component: Fader

Frequency
Sets a frequency. In the de-esser, this sets the lowest frequency of the signal to be compressed when 
the component is operating. In the BPF, HPF, and LPF filters, this sets the cutoff frequency. In the 
graphic equalizer, it is also used as the frequency band button. 
Components: Crossover, Crossover Processor, Crossover Processor II, De-Esser, GEQ, PEQ, 
BPF, HPF, LPF, Notch, Programmable BPF, Programmable HPF, Programmable LPF, Oscillator, 
Speaker Processor, SPX, Remote HA

Gain
Sets the amplification factor for the entire signal level.
Components: Crossover Processor, Crossover Processor II, Compander, Compressor, 
De-Esser, Expander, GEQ, PEQ, Auto Mixer, Speaker Processor, Remote HA, DME24N HA-AD

Gain Correct
In the Auto-Mixer, automatically controls the output level for the number of open channels. In 
situations, where multiple microphones are used, feedback may occur because many channels are 
open at the same time. Feedback can be avoided by using gain correct. 
Component: Auto Mixer

Hold (Hold Time)
Sets how long the gate stays open or the ducking remains active once the trigger signal has fallen 
below the threshold level.
Components: Ducking, Gate, Auto Mixer, SPX

KeyIn
Turns an input signal connected to a component's KeyIn port into a trigger that activates the 
component. You can select the trigger source in components that have KeyIn ports. 
Components: Compander, Compressor, Ducking, Expander, Gate, Limiter
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Knee
In compressors, de-essers, and expanders, sets the way in which compression or expansion will be 
applied after the signal exceeds the threshold. The following range of settings is available: HARD, 1, 
2, 3, 4, 5.
If Hard is set, the signal level changes to a straight line following the specified slope when the trigger 
signal exceeds the threshold. 
If a value between 1 and 5 (5 = softest) is specified, the curve gradually changes when the threshold 
is exceeded, producing a more natural sound. 
Components: Compander, Compressor, Ducking, Expander, Gate, Limiter

LFE (Sub Woofer Speaker)
This is a special speaker for playing back low frequency sounds. 
Component: Surround 5.1, Surround 6.1

Linkwitz-Riley (Linkwitz)
One type of filter characteristics. As second-order filters, the sum of the output voltages for LPF and 
HPF have a gain of 0bB across the entire band. The pass band is flat, but the cutoff frequency gain is 
-6 dB. 
Components: Crossover, Crossover Processor, Crossover Processor II, Programmable BPF, 
Programmable HPF, Programmable LPF, Speaker Processor

Pan
Sets the distribution ratio of the input signal between right and left.
Components: LCR, LR, SPX

Pan Nominal Position
Sets the 0 dB reference for pan. There are two selections available, [Center] and [LR] (LR Nominal).
Center nominal uses the center volume as a reference. The means the center volume is 0 dB, and the 
LR speakers are -3 dB.
LR nominal uses the LR speaker volume as the reference. The means the LR speaker volume is 0 dB, 
and the center is +3 dB.
Components: LCR, Surround 3-1, Surround 5.1, Surround 6.1

Phase
Reverses the phase of the signal. If you turn this ON, signal is inverted. If you turn this OFF, the signal 
is not inverted.
Components: Crossover, Crossover Processor, GEQ, PEQ, BPF, HPF, LPF, Notch, 
Programmable BPF, Programmable HPF, Programmable LPF, Fader, Auto Mixer, Delay Matrix, 
Matrix Mixer, Slot Output, Unit Output

Q
Sets the frequency bandwidth that will change the sound. As the value gets larger, the width gets 
narrower and the curve becomes steeper. 
In the parametric equalizer, this sets the frequency width where the gain will be cut or boosted. When 
Q is widened, the gain is boosted or cut along a wide range centering on the frequency set by the 
frequency setting, resulting in a large change in the tone quality. When Q is narrowed, only a specific 
frequency is boosted or cut. 
Components: Crossover Processor, Crossover Processor II, GEQ, PEQ, BPF, Notch, Speaker 
Processor, SPX
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Range
Set for Ducking and Gate. Sets the amount by which the level is reduced when signal is ducked/
gated. It can be set within the range of -70 to 0 dB. At -70 dB the entire signal above the threshold 
value is cut. At 0 dB, there is no effect. 
Components: Ducking, Gate

Ratio
Sets the ratio of change in the output signal level with respect to the input signal level. 
At 1:1, there is no compression.
At 2:1, when a trigger signal level that exceeds the threshold changes by 10 dB, the output level will 
change by 5 dB. 
Components: Crossover Processor, Crossover Processor II, Compander, Compressor, 
De-Esser, Expander, SPX

Release (Release Time)
Sets the time period until gain returns to normal after a trigger signal level falls below the threshold 
value and operation of a component ceases. 
If the release time is short, the sound will seem like it is jumping (the ear will notice the change) 
because the gain suddenly returns to normal. If the release is set too long, compression might not be 
applied properly because the next high level signal will be input before the gain returns to normal from 
the previous high. It’s a good ideal to try an initial release time setting in the range of 0.11 to 0.5 
milliseconds. 
Components: Crossover Processor, Crossover Processor II, Compander, Compressor, 
De-Esser, Expander, Limiter, Speaker Processor, SPX

Slope
In a high pass filter (HPF) or low pass filter (LPF), this sets the attenuation amount for each octave. 
A large value results in rapid attenuation. Clicking the [Slope] button displays a menu. 
You can select [6 dB/Oct] or [12 dB/Oct] in the HPF or LPF. 
In the crossover that is part of the crossover processor, in the stand-alone crossover, the 
programmable BPF, the programmable LPF, and the programmable HPF, you can select from [6 dB/
Oct], [12 dB/Oct], [18 dB/Oct], [24 dB/Oct], [36 dB/Oct], and [48 dB/Oct]. 
Component: HPF, LPF

Threshold
Sets the signal level that causes the component to operate. 
Components: Crossover, Crossover Processor, Crossover Processor II, Compander, 
Compressor, De-Esser, Ducking, Expander, Gate, Limiter, Auto Mixer, Speaker Processor, SPX

Width
Sets how much lower the level must be than the threshold level for the expansion effect to begin. 
When the trigger signal level changes by 2 dB with the expansion ratio of the expander set at 5:1, the 
output level will change by 10 dB. 
In the compander, if the width is set at 90 dB, the expander effect will be essentially be turned OFF. 
Component: Compander
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Troubleshooting

For the latest information about DME Designer, visit the Yamaha pro audio site at 
http://www.yamahaproaudio.com.

Symptom Possible Causes Corrective Actions

A compile error occurs during 
synchronization.

DSP total resource consumption has 
exceeded the upper limit. 

Delete unneeded components. The 
Resource Meter window must read 100% 
or less.

The wiring between components is 
connected from multiple output terminals 
to a single input. 

Change the connections so that a single 
output is connected to a single input 
terminal. Using a matrix mixer or similar 
component, gather multiple outputs into 
one signal. 

Cannot place component. Cannot place 
wiring.

You are in online status. Execute [Go Off-line] on the 
synchronization screen to go into offline 
status. 

The Designer window in not in edit mode. Place a checkmark next to [Edit] on the 
[Tool] menu. 

The currently logged on user is restricted 
from editing.

Logoff, then log in again as a new user, 
or as the Administrator. If edit restrictions 
are required for a user, place a check in 
the [Security] → [Edit] checkbox

A user module is not displayed on the 
list. 

The [File] menu → [Preference] → 
[ContentsFolder] has been changed, or 
the “User Module” folder has been 
moved.

Check that there are user module files 
(.umf) in the “ContentsFolder” and “User 
Module” folders.

Cannot switch configurations in the 
Navigator Window. 

While online, you cannot not switch to a 
configuration different from the current 
scene. 

If you can switch between scenes, you 
will be able to switch configurations.

The user module window does not open, 
even when a user module is double-
clicked. 

This is a user module saved by selecting 
[Open] → [User Module Design 
Window]. 

Open the save dialog, select [Open] → 
[User Module Editor], and resave the 
user module. 

No editor displays after right-clicking on 
a card component, and selecting [Open] 
from the context menu. 

Some cards do not have editors. No special corrective action. 

The message “Reset Config…” is 
displayed for a long time in the message 
area of the “Synchronization” dialog box. 

This is not abnormal. If many scenes are 
entered into the DME, processing takes 
time. 

Wait until processing finishes. 

Cannot set the monitor output. This is because channels connected with 
wiring cannot be used as monitor output.

Select an unconnected channel. 

The MIDI Setup toolbar will not be 
displayed.

Stored in the minimized task tray. Right-click the MIDI Setup icon in the 
task tray then click [Show].

http://www.yamahaproaudio.com
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